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Recommended Hardware Specifications
for Livestream Studio

Below are the recommended hardware specifications for running Livestream Studio, including

example workflows that each system type can handle.

Please note that many of these scenarios involve using Livestream Studio's hardware encoding feature.
This is when the encoding is done either by a supported graphics card or in a processor that has

integrated graphics.
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Desktop Computer with Hardware Encoding Enabled

Hardware Component Recommended Minimum Desktop (with
Hardware Encoding)

Processor with Integrated Graphics Quad Core Intel® i5 (6th Generation) or i7 (4th
Generation) Processor or better

Graphics Quick Sync-enabled CPU or NVIDIA NVENC-
enabled GPU
Memory 8 GB or better
Storage 128GB SSD + 512GB HDD or better
Motherboard Intel compatible motherboard
Example of a supported workflow « Camera sources: Multiple HD inputs &
outputs

» Streaming: Up to 1080p multi-bitrate
streaming profiles

» Graphics: Intermediate graphics templates
and layering with picture-in-picture, chroma
key, and image overlays

12
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Desktop Computer without Hardware Encoding

Hardware Component

Processor

Graphics
Memory
Storage
Motherboard

Example of a supported workflow

Recommended Specifications (no hardware
encoding)

6 (Hexa) Core Intel® i7 5th Generation Extreme
Edition or better

NVIDIA GeForce 600 Series or better
16GB or better

2TB SSD

Intel compatible motherboard

» Sources: Multiple HD Inputs/Outputs

» Streaming: Up to 720p multi-bitrate streaming
or single-bitrate 1080p streaming

» Graphics: Intermediate graphics templates
and layering with picture-in-picture, chroma
key, and image overlays

13



Advanced Desktop Computer with Hardware Encoding

Hardware Component

Processor

Graphics

Memory
Storage
Motherboard

Example of a supported workflow

14

Recommended Desktop Specification

6 (Hexa) Core Intel i7 6th Generation Extreme
Edition or better

NVENC enabled NVIDIA GPU (Such as Nvidia
Geforce GT 730)

32-64GB DDR4 Memory
2TB SSD
Intel compatible motherboard

« Sources: Multiple 4K / HD Inputs and Outputs

« Streaming: 4K / 1080p multi-bitrate streaming

» Graphics: Advanced graphics templates and
layering with picture-in-picture, chroma key,
and animated graphic overlays
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Minimum Laptop with Hardware Encoding

Hardware Component

Processor with integrated graphics
Memory

Graphics

Storage

Example of a supported workflow

Minimum Laptop Specification (with Hardware
Encoding)

4 (Quad) Core Intel i5 - 6th Generation or better
8GB or better

Quick Sync enabled CPU or NVIDIA NVENC
enabled GPU

500GB HDD (SSD preferred) or better

e Sources: USB Webcams, USB 3.0 Capture
devices and Remote Cameras over LAN/
WLAN

« Streaming: Up to 720p multi-bitrate streaming

« Graphics: Simple grahpics templates with
picture-in-picture and static overlays (no
chroma key, no animated graphics)

15



Advanced Laptop with Hardware Encoding

Hardware Component

Processor with integrated graphics

Graphics

Memory
Storage

Example of a supported workflow

Additional Notes

Advanced Laptop specification (with hardware
encoding)

4 (Quad) Core Intel i7 - 6th Generation or better

Quick Sync enabled CPU or NVIDIA NVENC
enabled GPU

16 GB DDR4 Memory or better
500 GB SSD or better

» Sources: USB Webcams and USB 3.0 Capture
devices

» Streaming: Up to 1080p Multi-bitrate
streaming profiles..

» Graphics: Intermediate Graphics templates
and layering w/ PiP, Chroma Key, and image
overlays.

e Livestream Studio is not compatible with Windows 32-bit systems.

* macOS must be on High Sierra or later in order to run Studio.

» If you intend to use USB 3.0 capture devices for any video input or output, we recommend your

motherboard have an Intel X99 chipset, as X79 chipsets do not support these USB 3.0 devices. Please
see Blackmagic's notice regarding USB 3.0 device support.

16
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Supported Capture Devices for Livestream
Studio

Here is a full list of supported capture devices:

PCle

- **Blackmagic Decklink SDI

- Blackmagic DeckLink SDI 4K

- **Blackmagic DeckLink Duo

- Blackmagic DeckLink Duo 2

- **Blackmagic DeckLink Quad

- Blackmagic DeckLink Quad 2

- **Blackmagic DeckLink Optical Fiber
- **Blackmagic DeckLink Studio

- Blackmagic DeckLink Studio 4K

- **Blackmagic DecklLink HD Extreme 3D

17



- Blackmagic DeckLink 4K Extreme

- Blackmagic DeckLink 4K Extreme 12G - Quad SDI

- Blackmagic DeckLink 4K Pro

- Blackmagic DeckLink Mini Recorder (capture only)

- Blackmagic DeckLink Mini Monitor (playback only)

- Blackmagic Intensity Pro 4K

- Blackmagic DeckLink Mini Recorder 4K (capture only)

- Blackmagic DeckLink Mini Monitor 4K (playback only)

- Blackmagic DeckLink SDI Micro

- Blackmagic DeckLink Micro Recorder (capture only)

- *Magewell Pro Capture AIO

- *Magewell Pro Capture HDMI

- *Magewell Pro Capture Quad HDMI

- *Magewell Pro Capture SDI

18
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- *Magewell Pro Capture Quad SDI

- *Magewell Pro Capture Mini HDMI

- *Magewell Pro Capture

- *Magewell Eco Capture Dual HDMI M.2

- *Magewell Eco Capture Dual SDI M.2

- *Magewell Eco Capture 4K M.2

- *Magewell Eco Capture SDI M.2

*Drivers for Magewell Pro cards can be downloaded here; Magewell Eco drivers can be downloaded
here.

**Indicates this product has been discontinued. However, it is still compatible with our software if you
already own it.

Thunderbolt

- Blackmagic UltraStudio Mini Recorder (capture only)

- Blackmagic UltraStudio Mini Monitor (playback only)

- **Blackmagic UltraStudio 3D

19
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- Blackmagic UltraStudio 4K

- Blackmagic UltraStudio 4K Extreme

- Blackmagic UltraStudio 4K Extreme 3

- **Blackmagic UltraStudio Express

- Blackmagic Intensity Shuttle for Thunderbolt

- **Blackmagic Intensity Extreme

**Indicates this product has been discontinued. However, it is still compatible with our software if you
already own it.

@ Please make sure you are plugging Thunderbolt capture devices into a ports that have a
Thunderbolt logo; oftentimes, these can be confused with display ports.

USB 3.0

- Blackmagic Intensity Shuttle for USB 3.0

- **Blackmagic UltraStudio Pro

- **Blackmagic ATEM 1 M/E Production Switcher

20
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- **Blackmagic ATEM 2 M/E Production Switcher
- Magewell USB Capture HDMI

- Magewell USB Capture SDI

**Indicates this product has been discontinued. However, it is still compatible with our software if you

already own it.

@ The Blackmagic UltraStudio SDI is not supported.

A Blackmagic USB 3.0 encoding devices are not supported on all machines. In particular,
motherboards with an Intel X79 chipset do not support Blackmagic USB 3.0 devices. Please

see Blackmagic Design's notes about USB 3.0 system requirements.

€@ Studio does not utilize the individual inputs on the ATEM production switchers. Studio can
ingest the output from these production switchers via USB 3.0.

USB Webcam Adapters

These devices will allow your computer to recognize your camera similarly to how it would recognize a
webcam. Studio generally recognizes most webcams. We have tested the following:

- Blackmagic Web Presenter

- Elgato Cam Link

21
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« The following formats did not work: 720p 30, 720p 29.97, 720p 25 and 1080p/720p 23.98, all
interlaced formats

- Elgato Cam Link 4K

« The following formats did not work: 720p 30, 720p 29.97, 720p 25 and 4k/1080p/720p 23.98

If you are using an Elgato device, please check their website for supported cameras.

The following Blackmagic Design products do not work with Livestream Studio:

- H.264 Pro Recorder

- ATEM Television Studio

- ATEM Production Studio 4K

- ATEM 1 M/E Production Studio 4K
- ATEM 2 M/E Production Studio 4K

- ATEM 2 M/E Broadcast Studio 4K

If you would like to connect one of the ATEM 4K switchers to Studio, it is recommended to utilize one of
their video outputs (HDMI, SDI, etc.) into a Blackmagic Capture device that Studio does support.

Once you have a capture card(s) connected to your computer, be sure to install the Blackmagic drivers.

22
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Installing or Updating Blackmagic Design
Desktop Video Drivers

Blackmagic Design Desktop Video is the driver that is required in order for Livestream Producer and
Livestream Studio software to recognize video inputs coming in through a Blackmagic Design
capture device. If you are having an issue seeing your camera source, it could be an issue with the
current version of the drivers you have installed.

@ [fyou currently have another version, you should first uninstall that version and then install the
recommended Desktop Video version.

We generally recommend using the most recent version of Desktop Video. However, if you are on
Windows 10 Pro version 1709, we recommend downloading Desktop Video 10.9.5.

Go to http://www.blackmagicdesign.com/support. Under Select a Product Family, choose Capture and
Playback.

ATEM Live Production ATEM Camera &
Switchers Studio Converters

Disk Recorders Capture and Playback

%.}_

Test Equipment Routing & Distribution Streaming and Encoding

Video & Audio
Monitaring

23
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Below on the left side is a column called Latest Downloads. Find the desired version of Desktop Video,
and select the operating system you are using (Mac or Windows).

You will be prompted to register. This step is optional. You may skip it by clicking 'Download Only' in the

bottom left corner.

Your Details:

First Name*

Last Name*

Company

Email*

Phone*

Country* United States

City*

State*

wnl nl

Product Information™

Select your product v

Serial Number

Tell us how you use this Bla

Which features should we a

When the download is complete, open the .zip folder and run the installer.

Blackmagic_Deskto...zip

Follow the on-screen steps, then restart your computer to complete the installation.

24
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What Cameras Work with Livestream
Studio?

Livestream Studio is compatible with USB webcams, consumer HDMI camcorders, and higher end
HD-SDI cameras. Older cameras can also connect via component, composite, and S-Video
provided you have the proper video capture cards to connect them to your PC.

USB Webcams are ideal for very localized use, as most webcams' cables do not extend beyond six feet.

HDMI cameras range in size and cost and work best for shorter distances. While longer HDMI cables are
available, we recommending staying below 20 feet to retain optimal video quality.

HD-SDI cameras are much pricier but can be worth the cost if your production requires long cable runs.
SDI cables can transmit audio & video over hundreds of feet without losing video quality.

Livestream Studio does support 4K camera inputs, provided that you install a 4K compatible capture
card. Please be advised that not all providers support streaming in 4K at this time.

A Note Regarding PTZ Cameras

If you wish to use a PTZ camera with Livestream Studio, it must either include a video output interface
(e.g. SDI) or be NDI compatible. If your PTZ camera does not include either of these specifications, then
it will not work with Livestream Studio.

360 Cameras

Livestream Studio does not support 360 cameras and video formats at this time.

25
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Power Requirements for Livestream Studio
Hardware Products

The power required to run Livestream Studio will be dependent on the type of system you are running
the software on.
The HD51, HD510, and HD550 have the following power requirements:

« 230/ 110 Volts
« Approximately 500 watts running at full capacity

26
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Forcing Windows PC to Run Maximum
Amount of Cores

To optimize your computer's performance when using Livestream Studio, we recommend forcing
your system to use its maximum amount of cores (usually four or six; the below example has eight).

@ Thisdoes not apply to macOS systems.
Open the Windows start menu and type "Run,” then open the Run desktop app.
B

Best match

Search suggestions

Settings

Type msconfig into the text field, then click OK.

27



Type the name of a program, folder

respurce, and Windows wall open it for you

Cancel Browse..

Serwies  Stortup  Tools

Load al deve drive

Dhagrostic startup

Aces and pervices only

Click Advanced options...
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= | Lystern Conf igaratacn

General Bool  Servees Startup  Tooh

Advanced opbond...

Bool aplions

[ 5afe boot

| Make al boot settrgs

permmanen

Check Number of processors to enable the dropdown menu.

| BOOT Advanced ﬂpllc-ﬂ. X
|: :-‘vl..ni:m' af processone: | |Mnu-u'nrmlr
[CrcyLeck
[[]oetug
| Gobal debug setings
4 Lwn Kirfa g ]
COM L 115200
L= ] E L 1
_‘ -
| LSS Carget name: L]

e = |

Select the highest number of processors your system has (in this case, 8). Then click OK.
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Apply the settings, then click OK.

(=] Sytem l.'nnhr_;urﬂ.n:-n

General Bool  Servces  Startup

Do 6L boot

[(ecotieg

[ease viceo

| 16% baot nfarmaben ] Make al boot setirgs
:u,-ll—ullv'h!

You will be advised that you may need to restart your computer to apply your settings. We recommend
doing so before launching Studio to ensure the settings have taken effect.
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Systern Configuration

Yo may need 1o restart your computer to apdly these changes.

Before restartng, avve any open files and dose ol programs.,

[T oon't show the message agan.

Restart
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Recommended Power Settings For
Running Studio on a Windows Laptop

[here are some settings in Windows to help optimize Studio’s performance when activating
hardware encoding.

@ Thisdoes not apply to macOS systems.

Go to the Start Menu and navigate to Power Options. (This can also be found within the Control Panel.)

Progeams and Festures

Perwer Oplasns

System

D Manager
Metwork Connectiors
Drsk Managersn
Computer Mansgement
Cemnmand Prampl

Command Promipt {Adman]

Tack Manager

Control Panel

File Explorer

Search

Ruii

Click the dropdown arrow next to Show additional plans.
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i Power Opticns - [n] =
I ‘ # Congrol Fanel » Hardwsme and Soend » Powsr Optionu w Seanch Coniml Pengd ¥
|
Corgeol Panel Hi
N i Choose or customize a power plan

C S Wil Bt [iiveet Baithan A povest plan 5 a collection of hardwai and fyvtem wftings Jiks dapliy brightner, ileep, #c.) Bt marage
hw-youl EOMpuUber LRs power. Tell me meee abaut s glany

el
Create 2 prser plan Prefeined plas
&) ';.::c:re.-\-e'\-lotwnoﬂml @ Balanced (recommended) Changs plan settngs
Ll pefamesnoe Ry CORSUMPENN N LIRS e
" Austamatically ibalasoes pera with ke P
Changs when She computer
Heeps ) Power caver Changs plan seftngs

Saves enegy by neducing your comgute’s perdoimance where possisle.

@

Show pdstioral pleg

High performance will appear as an option. Click the corresponding radio button to select it. After doing

so, click Change plan settings.

Choose or customize a power plan
A power plan is a collection of hardware and system settings (like display brightness, sleep, etc.] that rmanages
how your computer uses power, Tell me more about power plans

Preferred plans
anced (recommended) Cha wttings
tematically balances perfarmance with energy consurmption on capable hardwar

Power saver Change fian sethings

Saves energy by reducing your computer's performance where possible,

Hid® sddstionsl plans
(@ High performance Change plan settings

Favars performance, but may use more energy.

Under Turn off the display, select Never.
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@ + Control Penel + Hesdwere and Sound + Power Options » Edit Plan Settings

Change settings for the plan: High performance
Chocss the sleip ard digplay settegs thal you want yousr comguter o use.

i Tum off the display:

W Ful the computer o dheep:

Change advancid povwis tettings

Under Put the computer to sleep, select Never.

i + Control Panel » Hardware and Sound » Power Options »  Edit Plan Settings

Click Save changes.

Change settings for the plan: High performance

15 minute:

1 minute
2 minubes
1 minibEs
S minubes
0 mirates
15 mirwtes
20 riratas
25 mirstes
A et
45 mirmies
1 hour

2 hiours:

3 hours

4 hosirs

3 hemiri

Save changes

Choese the slesp and display settings that you want your computer to use.

) Turn aff the display:

W Put the computer to sleep:

2 hours

Change scvanced power settings

1 minute
 minates
3 minubes
5 minute:
10 minutes
15 minutes
20 minutes
2% manutes
30 inutes
45 minutes
1 hgur

2 hours

3 hours

4 hgurs

3 hogurs
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Change settings for the plan: High performance

Choose the sleep and display settmgs that you want your comguter to use.

E‘ Turm off the display: e w

W Put the computente seep: | Never i

Chamge advanced pover settings
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Fix Font Sizing Issues in Windows 10

Scaling Windows font to 100% will make it easier to use Studio with Windows 10.

Navigate to Windows Settings.

Maost used

i Livestream Studio Launcher

Event Viewer

Snipping Tool

Control Panel

VLC media player skinned

MNotepad

30D Builder

=) Alarms & Clock

| P

Select System.
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Settings = [m] *x

Windows Settings

€ i

Devices Metwork & Internet Personalization
ispla 5, APRS, Bluetooth, printess, mouse Wi-Fi, sirplane mode, VPN Background, lock screer
colors
(‘\ -
Ll g N
AT I
-
Accounts Time & language Ease of Access Privacy
Your acoounts, email, sync Speech, region, date Marrator, magnifier, high Location, camera
work, family contrast

'
K_/
Update & security

Windows Update, recoveny
backup

Select Display, and drag the scale all the way to the left so it reads 100%. Then click Apply to save the
settings, which will then take effect immediately.




& Home Customize your display
| Find a setting |
System
O Display
i Apps & features
= Default apps Identify Detect
C‘ Motifications & actions Some apps won't respond to scaling changes until you sign out.
Sian out now
@ Power & sleep 100% (Recommended)
Change the size of text, apps, and other items: 125%
= Storage
Orientation
¢ Offline maps
Landscape o |
CH  Tablet mode
Apply Cancel
O Multitasking ‘\
Advanced display settings
=1 Projecting to this PC
O
@ Home Customize your display
| Find a setting
Sustem
| L Dusplay
I Apps & features
= Default apps
[J Motifications & actions identity Detect
) Power & sleep Change the size of text, apps, and other items: 100% [Recommended)
= Storage
Omentation
02 Offline maps Landscape
L8 Tablet mode
Apply Cancel
I Multitasking

&) Projecting to this PC

38

Advanced display ssttings




vimeo - livestream

Prevent Automatic Windows Updates

The last thing you want right before or during an event is to be forced to update Windows, which
could postpone your setup or interrupt your stream. While there is no way to turn off updates
entirely, you can configure Windows settings to run updates only at certain times.

(1) Since macOS does not automatically restart or force updates, this article only applies to
Windows systems.

Open the Start menu and click the gearwheel to open Settings.

30 Buillder
Alarms & Clock

Blackmagic Design

- [ , a

Select Update & security.
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Windows Settings

setting

Q@

Network & Internet
Wi-Fi, airplane mode, VPN

-

Privacy

Location, camera

w4

Personalization
Background, lock screen,

colors

Update & security
Windows Update, recovery

backup

Under the Windows Update tab, click Change active hours.

R

Accounts
Your accounts, email, sync
work, family
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Update & security
I > Windows Update

% Windows Defender

T Backup
O Recovery
Activation

It For developers

Py Windows Insider Program

Check for updates

Update history

Good news! The Windows 10 Creators Uj

Yes, show me how

Update settings

Available updates will be downloaded ar
apply).

Change active hours

Restart options

Advanced options

Looking for info on the latest updates?

Learn more

You can choose a 12-hour time range during which Windows will not automatically update. If an update
becomes available during that time frame, a notification will appear letting you know that your computer

will restart outside of active hours.
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Active hours

Active hours lets us know when you usually use this device. When a restart is necessary to finish
installing an update, we won't automatically restart your device during active hours.

Note: We'll check to see if you're using this device before attempting to restart.

Start time

End time

If you do see the notification and feel your event is going to run longer, you can select Restart Options

and tell Windows when to restart your computer to install updates.

Ak
-y

il

[

~n
L

Windows Update

Windows Defender

Backup

Recovery

Activation

For developers

Windows Insider Program

Check for updates

Update history

Good news! The Windows 10 Creators Uj

Yes, show me how

Update settings

Available updates will be downloaded ar
apply).

Change active hours

Restart options

Advanced options

Looking for info on the latest updates?

Learn more

42



vimeo - livestream

s Restart options

Schedule a time

We'll restart to finish installing updates when you tell us to. Just turn this on and pick a time.

.:- :J {
Pick a time:
s | 40 | M
Pick a day:
loday
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Prevent Windows Update Sharing

Included with Windows 10 is the ability to send and receive software updates from other nearby
PC's automatically. While this may be convenient in other use-cases, it can take up bandwidth and
CPU resources that you would rather preserve for Livestream Studio, so we recommend disabling
this feature while using Studio.

@ Thisdoes not apply to macOS systems.

Open the Start menu and type in Windows Update settings. When this option appears in the menu,

select it.

0 fis] Filters ~~

Best match

/N Windows Update settings
E R~ System settings

Settings

7 Check for updates

Can | help?

7 windows update settings

Search suggestions

2 windows update settings - See web results
2 windows update settings powershell
2 windows update settings page

2 windows update settings windows 10
P windows update settings registry

- 2 windows update settings 8.1

2 windows update settings|

Under the Update settings section, select Advanced options.
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Windows Update

Update status

@ Your device is up to date. Last checked: Yesterday, 2:12 PM

Check for updates

Update history

Update settings

We'll automatically download and install updates, except on metered connections (where charges
may apply). In that case, we'll automatically download only those updates required to keep
Windows running smoothly.

Change active hours

Restart options

Advanced options

Looking for info on the latest updates?

Learn more

Have a question?
Get help

Scroll down to the bottom of the window to the Pause Updates section and select Choose how updates
are delivered.

Pause Updates

Tempaorarily pause updates from being installed on this device for up to 35 days, When updates resume, this device will
need to get the latest updates before it can be paused again.

@ off

Pausing now will pause updates until 10/4/2017

I Choose how updates are delivered I

Mote: Windows Update might update itself automatically first when checking for other updates.

Privacy settings

Have a question?
Get help

Toggle the switch to Off.
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Updates from more than one place

Download Windows updates and apps from other PCs in addition
to Microsoft. This can help speed up app and update downloads.
Learn more

When this is turned on, your PC may also send parts of previously
downloaded Windows updates and apps to PCs on your local
network, or PCs on the Internet, depending on what's selected
below.

@ orf

Get updates from Microsoft, and get updates from and send
updates to

PCs on my local network

PCs on my local network, and PCs on the Internet

Have a question?
Get help
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MacOS Mojave Permission Requirements
for Studio

If you are using Livestream Studio on macOS Mojave, we recommend checking your Security &
Privacy settings to ensure that Studio can run and all your video and audio sources are properly

recognized.

In System Preferences, navigate to Security & Privacy. Select the Privacy tab in the window that opens.

There are three permissions you will need to ensure has Livestream Studio enabled: Camera,
Microphone, and Accessibility. Highlight each of these and make sure Livestream Studio is checked.

These permission settings do not apply to earlier versions of macOS.

Security & Privacy
General  FileVault  Firewall  Privacy

=" Location Ser 5 Allow the apps below to access your camera.

] ~
§ Contacts

i ' Livestream Studio
T .
m Calendars
) ' Livestream Studio Beta

¥ 'EM Livestream Producer

v q Google Chrome

l I Camera
n Microphone
@ A bility

- Full Disk Acc
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Location Services

Contac

Calendars

Reminde

Microphone

ity

Full Disk Access

w
B
ol
n
@.
e

Contacts

Calendars

Reminders

Camera

ophone

Accessibility

Full Disk Acce

9000 ®ME

Security & Privacy

General FileVault Firewall Privacy

Allow the apps below to access your microphone.

Livestream Studio Remote Camera
Livestream Studio
2am Studio Beta

Livestream Producer

Security & Privacy
General FileVault  Firewall Privacy

Allow the apps below to control your computer.

6 Google Drive File Stream

." ~ Google Software Update

v 'B Livestream Studio

| =+ . - .
v Livestream Studio Beta

+_
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Can | Run Anti-Virus Software on my Studio
Computer?

Running anti-virus software that includes real-time protection while using Livestream Studio can use up
CPU resources and possibly even interrupt your stream’s connection.

As a best practice, anti-virus software, Windows Firewall, and similar real-time protections should be
disabled while you are running Livestream Studio, and if possible, your system should be dedicated to
just using Studio. Do not download files from sources you do not trust onto your Studio computer.
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What is Livestream Studio?

Livestream Studio is a live production switcher that incorporates many elements of a professional
live multi-camera production into one desktop software. Think of it as a live production truck or a
TV station's master control room on your computer.

Its most basic features include:

« Connect multiple camera inputs: Plug in your cameras directly into your PC to get as many angles as
you need.

» Live video outputs: Output your video to projectors or monitors; ideal for auditoriums, conferences,
and houses of worship.

« Three graphics overlay tracks: Build graphics (GFX) overlays to countdown to your event start, identify
people, loop tweets using your event hashtag, or display a scoreboard.

» Media playback modules: Bring in pre-recorded video clips to incorporate into your production, such
as sponsored content or montages.

« Built-in audio mixer and audio filters: Embed audio from your cameras or connect a USB mixer or
microphone and control all the audio for your event directly from Studio.

» Capture up to four high-resolution isolated (ISO) recordings: Record your event or individual camera
angles in broadcast quality for post-production editing or replay.

« Basic replay: Playback an ISO recording as your broadcast is happening, giving viewers a different
angle of your event (e.g. a goal score).

e Chroma key: Eliminate a colored background to incorporate different background images into your
event (e.g. a weather map, virtual studio)

» Stream to Vimeo and other providers: Go live to Vimeo, Livestream, Facebook, YouTube, Periscope,
Twitch, and more. Choose one or stream to multiple simultaneously.

Studio supports up to three (3) GFX tracks, eight (8) audio-only sources, and one (1) interview. All other
sources (local inputs, remote cameras, media bins, RTMP inputs, etc.) are flexible, and all inputs may
total up to 50.

What Equipment Do | Need In Order to Use Livestream
Studio?
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First and foremost, you need cameras. Studio is compatible with most SDI, HDMI, component,
composite, S-video, and USB web cameras that output broadcast standard formats. If you do not own
any cameras and need some suggestions, we have some here. Keep in mind you will also need the
proper cables to output these cameras’ video signals into Studio (HD-SDI camera = HD-SDI cable, etc))

Next, you need to be able to connect these cameras to the computer that is running Studio. This is
done using a capture device. These can connect to your computer via PCle, USB 3.0, or Thunderbolt,
and convert your camera'’s video into a signal your PC can read. Read more about what a capture device

is and which capture devices Livestream Studio supports.

With few exceptions, you will need one capture device per camera. Webcams do not require a capture

device.

Finally, you need a PC running Windows 64-bit version 7 or later or macOS High Sierra or later.

Studio requires a robust computer in order to run with all of its features successfully. We have a

comprehensive guide of recommended hardware specifications depending on your workflow needs.

If you have already purchased a Livestream Studio hardware product (e.g. HD31, HD51,
HD550), capture devices are already built into your machine. There is no need to purchase

additional capture devices or an additional PC.

How Do | Get Livestream Studio?

Get started with a demo or learn how to access Studio.
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How To Access Livestream Studio

Full access to two (2) licenses of Livestream Studio is available with a Vimeo Premium membership

or a paid Livestream account.

Download Livestream Studio on your Windows or Mac computer. Follow the on-screen steps to install

the software, after which it will automatically launch.

Studio will prompt you to log into either a Livestream or Vimeo account. If you do not have an account,
you can sign up for either by clicking the desired provider at the bottom of the prompt.

Welcome to Studio

‘l LOG IN WITH LIVESTREAM

v LOG IN WITH VIMED

A i

Don't have an accountt Sign up for Livestream or Vimeo

Once your account is created and paid for, you may then log into Studio using your account credentials.
Studio will indicate that your full access has been unlocked.

A few things to note:

» Because Studio needs to authenticate your login, you will need an internet connection to access the
software. If you lose your internet connection, you can continue to use Studio offline for up to 24

hours before being required to reconnect.
» While Livestream Studio has the ability to stream to various providers, a paid Livestream account does
not allow you to stream to Vimeo, and a Vimeo Premium account does not include the ability to

stream to Livestream.
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If you purchased a Livestream Enterprise account, you will have a phone support PIN for the length

of your membership. Phone support is not available with Vimeo Premium.


https://help.livestream.com/hc/en-us/articles/360002051248-where-is-my-phone-support-pin
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Demo Livestream Studio Before Buying

There is a short demo option with Livestream Studio that allows you to try the software prior to
purchasing.

Download and install Livestream Studio. When the installation is complete, the software will launch and

you will see the following screen.

Welcome to Studio

"I LOG IN WITH LIVESTREAM

v LOG IN WITH VIMEO

Don't have an account? Sign up for Livestream or Vimeo

A demo of Studio is available by signing up for Vimeo. Signing up for Vimeo gives you access to a
10-minute live demo. This means you have full access to Livestream Studio and may broadcast for a
total of 10 minutes before the demo expires.

A countdown of your demo time remaining will appear when you navigate to the Stream tab and hover
the cursor over the Vimeo icon at the bottom of the interface.

All video recordings and outputs will include a watermark during this demo period.

Your demo will expire after you have streamed for a total of 10 minutes.
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Audio Mixer

Select Event

Create new

¥ \imeo
Share W

Anyol  00:10:00 demo time remaining

Create new

v [:

To continue using Livestream Studio when your demo expires, you will need to purchase a subscription.
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How to Install Livestream Studio

Livestream Studio software can be downloaded onto a Windows or Mac computer from
livestream.com/studio by clicking on the Download to Get Started and selecting the operating system

you are using: Windows or Mac.

@ [fyouare using Windows, you must be logged in as an Admin user in order to install and run
Livestream Studio. You will also need an Internet connection for this entire process.

€@ !f you purchased a Livestream Studio hardware product (HD31, HD51, HD550, etc)),
Livestream Studio software is already pre-installed on your unit.

Installing on Windows

The download will begin automatically. Open the .exe file.

'".b LivestreamStudiolau...exe

It will bring you to the installation wizard for the Livestream Studio Launcher.
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o7 Livestream Studio Launcher Setup ﬂ

livestream Welcome to the Livestream
Studio Launcher Setup Wizard

The Setup Wizard will install Livestream Studio Launcher on
your computer. Click Next™ to continue or "Cancel” to exit
the Setup Wizard.

Mext = Cancel

Agree to the license terms and follow the on-screen steps to complete the installation process, then
click Finish in the wizard.
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[ Livestream Studio Launcher Setup ES

livestream Completing the Livestream
Studio Launcher Setup Wizard

Click the "Finish" button to exit the Setup Wizard.

Finish

The Livestream Studio Launcher will open, download the Studio software, and prompt you to install the
software via another installation wizard.
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5 Livestream Studio Setup n

livestream Welcome to the Livestream
Studio Setup Wizard

The Setup Wizard will install Livestream Studio on your
computer. Click Next” to continue or "Cancel” to exit the
Setup Wizard.

Mext = Cancel

When the installation is finished, the most recent version of Livestream Studio will launch on your
system.

Installing on Mac

After the .pkg file downloads, click it to open it. The install wizard will open. Follow the on-screen steps
to complete the installation. Upon completion, Livestream Studio will launch automatically.
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@ Introduction
[ Destination Select
Installation Type
Installation

Summary

‘e Install

Welcome to the Installer

You will be guided through the steps necessary to install this

software.

Continue
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Using the Livestream Studio USB Dongle

If you made a one-time purchase of Livestream Studio for your own Windows computer, you will
receive a USB dongle which will give you access to your full Studio license.

You should first download and install the Studio software onto your PC.

By plugging this dongle into a USB 2.0 port, you'll be able to access all of the paid features of Livestream
Studio without the need for a paid Livestream or Vimeo Premium account.

The dongle must be connected to your PC at all times while using Livestream Studio in order to use the
software. If you have multiple computers that require full access to Livestream Studio simultaneously,
then you will need one dongle per system.

Additional Notes about Using the Dongle

» The Studio Dongle is not compatible with MacOS systems; you must use it with a Windows
computer.

» The Studio Dongle does not include the ability to stream to the Livestream Platform; if you wish to
use Livestream as your streaming destination, you will need to purchase a Livestream subscription.

« Livestream Studio hardware units (HD31, HD51, HD550, etc.) do not require an additional software
dongle. The license will already be unlocked when you launch Livestream Studio on those systems.

» We urge you to keep your Studio dongle in a safe place. If you are building a custom computer to
run Studio, consider building it so that the dongle is on the inside of the unit.
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« We do not support plugging the USB dongle into the USB 3.0 port due to inconsistent results. If you
have done this and were able to load Studio successfully, please let us know by contacting us and
providing your system's hardware specifications.
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What Happens If | Lose My Studio Dongle?

Per Livestream Studio terms, if your Studio USB dongle is lost or stolen, you are responsible for reporting
the loss and may be charged a replacement fee.

We urge you to keep your Studio dongle in a safe place. If you are building a custom computer to run
Studio, consider building it so that the dongle is on the inside of the unit.
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Log Into Livestream Studio via a
Subscription

If you have already purchased a Livestream or Vimeo Live subscription, you also have full, unlimited
access to two (2) Livestream Studio licenses. This means you can run Livestream Studio on two

separate systems using your account login.

After you have installed and launched the Livestream Studio software, a welcome window will pop up

prompting you to log in via Livestream or Vimeo. Select the provider you are using to log in.

Welcome to Studio

‘l LOG IN WITH LIVESTREAM

v LOG IN WITH VIMEO

Don't have an account? Sign up for Livestream or Vimeo

If you select Livestream, enter your email and password in the next window, then select Log In With
Email. If you select Vimeo, a browser window will open. If you are already logged into a Premium
account, you will then be logged into Studio. Otherwise, enter your account credentials to log in.

Please be advised that subscription access to Livestream Studio will require an internet
connection in order to log in. Offline access is available for up to 24 hours after you log in

before you are prompted to reauthenticate.
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Arranging & Simplifying the Livestream
Studio Interface

While Livestream Studio maintains a generally consistent layout, there are a few ways you can
customize the interface to best fit your needs.

Select Your Interface Mode

When you first log into Livestream Studio, you will be given the option to Choose a Mode, as shown
below.

Choose a Mode

Simple

for those new to broadcasting
and have a simple setup

Advanced

for broadcasting professionals
with multiple cameras

CREATE NEW PROJECT

Simple is ideal for beginners and producers with smaller workflows (1-2 cameras, few graphics, some
video playback). This will display one Output window and a multiview where you will click each source
to select what is shown in the Output. By default, this mode displays a single column of producer tool
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tabs (e.g. Audio Mixer, Graphics, Media, etc.). Selecting Simple will quickly remove a lot of clutter from

the Studio interface that smaller scale productions may not need.

Advanced is best for producers with larger scale workflows (multiple camera inputs, multiple graphics
channels, picture-in-picture, etc.). This features the traditional Preview/Program monitor setup and
transition controls normally used in a multi-camera production, in addition to two columns of producer
tool tabs by default so you can see more on your screen.

Select one, then click Create New Project to start using Studio.

You can easily switch your project from one mode to the other by clicking the interface icon in the
upper right corner and choosing your interface mode.

4% CPU  2:09:25 PM =

Simple

Advanced

Most demonstrations will feature the interface in Advanced mode. Instructions on how elements specific
to Simple Mode work are available here.

Resize Three Main Sections

Studio’s interface consists of the Preview & Program or Output monitors on top, the multi-view in the
middle, and production element modules on the bottom third of the interface. This general layout
cannot change, but you do have the ability to adjust the sizing of these three main sections by dragging
and dropping the two section dividers up and down as you see fit.

In the example shown below, we raised the top divider to make the multiview section larger.

6/



Before:

CAMZ @

After:

Rearrange Lower Modules

68



vimeo - livestream

When you first open Studio and add your inputs, the lower-third portion of the interface includes all your
additional production elements (audio mixer, remote cameras, graphics, media, stream configuration,
etc.). These have a default arrangement, separated into two columns.

Example left column:

AUDID MEDIA 1 MEDIA 2

WEBCAM 1 FacaTime HD Camara (Buili-in]

GFX 1

GFX 2

GFX 3

MEDIA 1

ADD INFUT

Example right column:
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GFX 3 TRANSITIONS

Set Up Your Stream

Select a provider bel configure stream sattings

p i t

When using advanced mode, each column splits the screen evenly by default. If you prefer one to be
larger than the other, drag and drop the middle divider the desired location.
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¥ You can also collapse the entire right column by clicking the collapse button on the far right

side. Click it again to expand the column

TRANSITIONS

/1



In addition to adjusting the width of each column, you can also rearrange the modules by dragging and

dropping each tab between the two columns.

For example, if you need to monitor audio and media playback at the same time, drag the media bin
tab(s) to the right column so you can see both the audio mixer and the media player simultaneously.
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MEDIA 1 MEDIA 2

MEDIA 1

o) ) ) 4 | 4

AUDIO AUDIC AUDIO AUDIO AUDI

If you are using a limited number of additional elements or simply wish to not have two separate
columns, go to Settings: Project Format. Under the Tabs Configuration setting, select Flat.

Project Format
Quality and Format

Inputs
Definition

Outputs

Media Player Low Definition

Streaminc Project Video Format

HD 1080i 59.94
Web Control

User Interface

W Inputs Multivi

Dropbox

Tabs Configuration
® Flat

Multi-Screen

2 Columns

Ad Insertion
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Studio: First Steps

There are a variety of directions you can take when getting started with the software. Below are a few
starting points to help guide you:

Arranging & Simplifying the Livestream Studio Interface

Connect Cameras to Livestream Studio computer

Adding Camera Inputs in Studio

Creating & Saving Projects

Introduction to the Multi-View

Use a Mouse to Switch Sources

Use a Keyboard to Switch Sources

Add Audio Sources

Control the Audio Mixer

Monitoring Audio

Adding Graphic Overlay Modules

Mixing Graphic Overlays into Program
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Importing Videos into the Media Playback Module

Set up a High-Resolution Recording

Go Live to any provider such as Vimeo or Livestream

These only scratch the surface of Livestream Studio's capabilities. Look for more advanced walkthroughs
in the help center or download the Livestream Studio User Manual.
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Creating, Importing, and Exporting Projects

Livestream Studio has the ability to save, load, import, and export Livestream Project files, allowing
you to keep configurations saved on your system so you can use them whenever you need to,
without starting from scratch.

When you open Livestream Studio, by default you will be working on your previous project (or Untitled
Project if it is your first time launching Studio). Click on the title in the upper right corner to see more

options.

To rename your project, simply type the name into the text box. When you click out of the window, the

project will automatically be renamed.
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Now your project is renamed. As you configure it (e.g. add graphics templates, import media clips,
arrange inputs, etc.), it will save automatically. This occurs regardless of the project being renamed, but
now you can identify it.

You can create a new project at any time by clicking on your project title and selecting New.

A new untitled project will open with default configurations. As mentioned above, you can rename the
new project by clicking on the title.
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To go back to working on a previously saved project, click on the project title and click Open. A
dropdown list of your projects will appear. Click the project that you want to work on.

OPEN...

Hockey Game

Untitled project

The selected project will then open as it last appeared in Livestream Studio.

You may want to keep a Studio project configuration saved on your hard drive if you intend to use it
often or move it to another Studio system. For this case, we created the Import/Export feature. When
your Studio project is configured the way you like it, click the project title, then Export.
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DELETE

OPEN... IMPORT... EXPORT...

You will have the option to bundle or reference assets. Bundle is ideal if you need to move the file to a
different hard drive or system, but creates a larger file. Reference is a smaller file, but will not move any
associated assets (media clips, etc.) After selecting your preferred option, click Select.

A Please select ts for ex

® Bundle assets (larger files)

Reference assets (smaller files)

cance.  [SEEET

Choose where on your system you want to save the Livestream Project file (.Isproj). By default, your
operating system will open a newly created Livestream Studio Export Projects folder under Documents,
but you can save the file anywhere you want. Then, click Save.
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Your system will warn if you already have a .Isproj of the same name and give you the option of
replacing it. If you click No, you will have the option to rename it in your save location.

rcmﬁ-m Save As

h Hockey Game.lsproj already exists.
&85 Do you want to replace it?

= Loves [ Ne |

r

| Save | | Cancel

If you imported media files into your media bin, you will be asked whether to save the original video files

or their transcoded versions (i.e., the files created after they were brought into Studio).
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A Please select media files for export.

Transcoded

& Original

CANCEL w

When you are ready to use that particular project file, you can click on the project title and then on
Import.

DELETE

IMPORT... EXPORT...

Find your .Isproj file in Windows, select it, and click Open.
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This will create a new project in Livestream Studio with the proper configurations set. You can rename

this by clicking the project title if desired.

B Hockey

DELETE

OPEN.. IMPORT... EXPORI...

If you no longer intend to use the project you are working on, you can click the project title and then
Delete. This will not delete an exported file, but you will no longer be able to select it from the Open

menu.
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OPEN...

IMPORT...

DELETE

EXPORT...
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Importing & Exporting Projects via Dropbox

You have the option to save your Livestream Studio project files to a Dropbox folder rather than a
local folder if you wish. You can also import .Isproj files from Dropbox into any Livestream Studio
system using the same integration.

Q For the best experience, we recommend simplifying your Dropbox folder structure to no
more than 1 or 2 subfolders. Multiple subfolders can cause extended sync times with
Dropbox.

Connect Dropbox to Livestream Studio

To configure Dropbox, navigate to settings by clicking the gearwheel icon in the upper right corner of
Studio.

&% CPU 1:15:09 AM

PULL PULL PULL

Navigate to the Dropbox tab.
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Settings: Project Format CANCEL

Project Format
Broadcast Standard Ultra HD

Inputs ) e
High Definition mode

Outputs ow CPU Performance

Definition mode
Audio In

Project Video Format

Project Audio Format

Multi-View Deinterlacing

Method Blend Field

Ad Insertion

Click Connect Dropbox.

Settings: Dropbox CANCEL [ 'SAVE"

Project Format Please Connect Dropbox Account

Outputs

Audio In

tecording

A browser window will open. Log in to your Dropbox account to connect it with Livestream Studio.
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' .
Sign in to Dropbox to link with Livestream Studio

G Sign in with Google

or

Forgot your password? m

The browser will indicate that authorization was successful. Return to Livestream Studio.

' | Livestream Studio

o

Authorization Successful

Open your Livestream Studio. You may close this window.
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The Settings: Dropbox window will indicate that your account is connected. Click Select Folders to
choose which folder to use with Livestream Studio.

Settings: Dropbox CANCEL ["SAVE"

Project Format

Inputs A Select Folders

Outputs
SELECT FOLDERS
Audio In

Recording

Media Player

Choose a local folder, which will include copies of anything you save to Dropbox on the local hard drive

as well. By default, this will be set to Documents > Dropbox, but you can click BROWSE to choose a
different location.
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Select Folders

Local Folder

Remote Folder

CANCEL M

Next, choose the Dropbox folder you want to work out of. This can either be a generic "Dropbox” folder
(as selected above) or you can expand into any folders within your Dropbox account (e.g. "Projects,”

seen below).

When you are done selecting your folders, click Save.
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Select Folders

Local Folder

Remote Folder

Dropbox
Lower Thirds
Videos

Projects

CANCEL

T

Your Dropbox account will sync with Livestream Studio. Make sure Use Files from Dropbox is checked.

Then save your settings.
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Settings: Dropbox CANCEL

Project Format

Inputs Local Folder

Outputs

0.00 bytes/13.05 GB
Audio In
Remote Folder
Recording
Media Player CHAMGE FOLDERS
Streaming

% lU=e Files from Dropbox

Web Control

Save Project to Dropbox

When you want to save your project to Dropbox, click the project name from the upper right corner,
then click Export...

4% CPU 1 Bemiy © 3

Emiby DELETE

HEW IMPORT... EXPORT... GFX 3

PULL PULL PULL
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Select whether to bundle your assets into the project (e.g. graphics, media clips, etc.) or if the project
should simply reference their file paths.

CANCEL

Give your project a name and make sure your folder is selected. Then click Export.

Export Layer

Ch File Narne and

File Hame

Emity’s F'rnjeu:ﬂ

Location

CANCEL Ml

The .Isproj file will now be saved in your Dropbox folder as well as the local folder you selected in
settings.
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Import Project from Dropbox

To import your project into Livestream Studio, click the project name in the upper right corner, then click
Import...

% CPU B untitied project(1) | XX 2%

Untitlied project(1) DELETE

NEW IMPORT... EXPORT.. GFX 2

PULL PULL PULL

Click on your lsproj file from the Dropbox folder, then click Select. Your project will open up in Studio.

Select File

Emily's Project lsproj

CANCEL Ml
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Connect Cameras to Your Studio PC or
Mac

To connect your cameras to Livestream Studio, you must have a supported capture device (unless
you are using a webcam), a video cable that is compatible with your camera (HD-SDI cable, HDMI
cable, etc.), and any necessary cables to connect your capture device to your computer.

Webcams

Livestream Studio should recognize any USB webcam once its drivers are installed. Typically webcam
drivers will download and install automatically once you connect the camera to a USB port on the
computer.

Built-in webcams will also be recognized automatically.
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Audio Mixer

2 WEBCAM 1 FaceTime HD Camera (Bulll-in]

Camcorders & Video Cameras

For other cameras, you will need a Blackmagic Design in order for Livestream Studio to recognize the
input. Magewell devices are also compatible.
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Studio hardware products (HD31, HD51, HD550, etc.) all have capture devices and drivers pre-
installed. These driver installation steps should be executed by customers who are running
Studio on their own computer with their own Blackmagic Design devices.

GLOwW

PCle cards, Thunderbolt products, and USB 3.0 devices are certified to work with Livestream Studio. See
our full list of compatible devices.

Please note that USB 2.0 capture devices are not compatible with Livestream Studio.

96


https://help.livestream.com/hc/en-us/articles/360002053168-Supported-Capture-Devices-for-Livestream-Studio

vimeo - livestream

o

HOMI It —

B S0 Input —— EE

PCl Express cards are cards installed directly into the motherboard inside the computer.

50! Input

‘I( 1\. o SO ng
UltraStudio ;
Mini Recorder

Thunderbolt™

HDMI Input

9/



... @
Elad-a"naglchﬂgnS
re AW A oUT oMV CUT REMOTE 55%"
U e
Refln HO/SD HDVSD  HOMI R5-422 Decg USE 3.0
500N 200 CQut Control

Connect the capture device to your computer if the device is not already installed. This example shows
a USB 3.0 device (Blackmagic Design UltraStudio SDI).

Go to Blackmagic Design's website. To install the devices drivers, click Capture and Playback on the right
side.
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Search by model Q

ATEM Camera &
Swudio Converters

=

Test Equipment Routing & Distribution Streaming and Encoding

Disk Recorders Capture and Playback

Below the product menu on the left side is the Latest Downloads menu. Desktop Video is the device
driver that you will need. Find the latest, then click the button that corresponds to your operating system
(Mac OSX or Windows) to start the download.

€@ [fyouare on Windows 10 Pro version 1709, we recommend downloading Desktop Video
10.9.5.
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Latest Downloads Latest Sup

Software Update 29 May 2017 Instruction M;
Desktop Video 10.9.3 Desktop Vid
This software update improves playback for custom This instruction
WAMC data such as closed caption when playing back installation and
from DeckLink Duo 2 and Decklink Quad 2 and fixes a video products
plug in installation bug for Photoshop CC 2017 for all Intensity model
DeckLink and Intensity products. It also includes new

Disk Speed Test 3.1, which provides improved support

for faster disks, as well as general performance
improvements. Read more

& Mac 05 X Information N
Configuring
Quad 2

Developer SDK 29 May 2017 This Informatio

Desktop Video 10.9.3 SDK configure Deckl

full duplex mod
This SDK provides developer support for Desktop Video P

10.9.3 that allows updating of hardware control and
software interfaces for Desktop Video products. — —

” -
& Macos X i BR Windows () Linux

Infarmatinmn N

You will be prompted to register your device, which is not required. If you wish to skip registration, click
Download Only in the bottom left corner.

Phone*

Which features should we add?

Ak

Country* United States

City*

State*

Imgrn_lqa_ﬂ_o_rrﬂl

100



vimeo - livestream

When the download completes, open the file and follow the simple on-screen steps to install. Once the
installation is complete, restart your computer.

|, Blackmagic_Desktop....zip

Now that the drivers are installed, turn on your cameras and connect them to your Blackmagic devices.

¥

s b e L= SO I FLIRAL AT

101



To check that your system is receiving a video in through the device, open Blackmagic Media Express
before launching Livestream Studio. This program was installed with the Desktop Video driver.
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Livestream
Studio

Click on the Log and Capture tab underneath the player.

Log and Capture

Select the device you want to check on the Devices menu.
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File Edit [Device | Mark View Help
DeckLink Mini Monitor
DeckLink Mini Recorder
DeckLink Mini Recorder

DeckLink Mini Recorder

Next, go to Edit and select the Preferences menu.

Uit - vecia e

File | Edit | Device Mark View Help

Paste Ctrl+V

elete

Select All Ctrl+A

Preferences Ctrl+,

Under Project Video Format, select the format your camera is outputting, then click OK at the bottom of
the window.
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Project Video Format: [HD 10801 59.94 v
\PAL
NTSC Progressive

PAL Progressive
HD 1080p 23.98
|HD 1080p 24
HD 1080p 25
When capturing DPX files, use |HD 1080p 29.97
|HD 1080p 30 =
Capture audio and video 55 |10 10001 29,94
HD 1080i 50
HD 720p 50
HD 720p 59.94
Capture still frames to: |HD 720p 60

For all still frame captures only

Q If you noticed your video signal come in before selecting Edit > Preferences, simply take note

of the currently configured project video format. You will need to know this in order to see
your cameras in Livestream Studio.

Your video signal should now appear in the Media Express player, confirming that you have a video
signal coming into your system. Be sure to close Media Express before launching Studio.
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Setting Your Project Format

To configure your Studio Project Format, click on the gear wheel in the upper right corner of Livestream
Studio.

The first tab is Project Format. This menu is where you set your project video quality and format as well
as adjust some interface configurations. The video formats that are available to choose from are based
on which Definition you select.

« Streaming Optimized (previously referred to as Low CPU Performance) includes 720p project
formats, which are ideal for streaming particularly on laptops and lower end CPUs.

» Ultra HD includes 4K formats, which should only be used if you have 4K-compatible cameras and
capture cards.

» HD has the most options for video formats, including 1080i, 1080p, 720p, NTSC, and PAL formats.

» Low Definition has 480p, 432p, 360p, NTSC, and PAL formats and will auto-downscale any HD inputs
to the selected format.
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Settings: Project Format CANCEL m

Project Format
Quality and Format

Inputs

Definition

Audio In

Q Either a 1080p or 720p format will produce the best quality stream, as they eliminate the
need to de-interlace. All formats will be true broadcast quality when recording and outputting
the video.

After choosing your Definition, choose your specific Project Video Format.

Q Check each camera’s settings to ensure that they all match each other as well as your project
format. This will keep your CPU consumption low.
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Quality and Format

Definition

Ultra HD
& HD
Low Definition

Project Video Format

HD 1

Be sure to save your settings. Next, connect your cameras if you haven't done so already, then configure
your inputs.
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Using 4K Project Formats

You can use 4K video capture cards to bring 4K video signals into Livestream Studio

@ mportant: While you can record and output in 4K, you can only stream in 4K if you are able
to enable hardware encoding.

In settings, under the Project Format menu, there is a Definition section.

Settings: Project Format CANCEL

Project Format
Quality and Format

Inputs
Definition
Outputs ® Streaming Optimized

Uitra HD

Audio In
HD

Recordi ng Low Definition

Media Player Project Video Format

T20p 30

Streaming

Selecting Ultra HD will allow you to choose a 4K format as your Project Format. This means that you can
use 4K cameras with supported 4K capture cards to bring in 4K video signals.
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Settings: Project Format

Project Format
Quality and Format

Inputs
Definition

Outputs Streaming Optimized
& Litra HD

HD

Recording Low Definition

Media Player Project Video Format
UHD 4k 29.87
Streaming UHD 4k 29.97

Weab Control

CANCEL

SAVE

Any camera sources that are not in 4K can be converted under the Input Settings tab. Please note that

using the converter may increase your CPU consumption.

Audio Mixer Remote Cam 1

Converter

CONVERT
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Using Standard Definition-only Formats

Producers who use Livestream Studio on low-performance computers can now help preserve their
CPU by using Low Definition and Streaming Optimized project formats.

In settings, under the Project Format menu, there are various options for Quality and Format. Alongside
High Definition mode, Studio offers Streaming Optimized (previously known as Low CPU Performance)

Ultra HD, and Low Definition modes.

Settings: Project Format

Project Format
Quality and Format

Inputs
Definition
Outputs & Streaming Optimized
Ulttra HD
Audio In
HD

Recording Low Definition

Streaming Optimized includes 720p formats only; Low Definition mode includes 480p formats and
lower. These should be selected when using low-performance computers and laptops.
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Settings: Project Format

Project Format
Quality and Format

Inputs
Definition
0 &) Streaming Optimized
Ultra HD
Audio In
HD

Recording Low Definition

Media Player Project Video Format

720p 30

Streaming 720p 30

Quality and Format
Definition
Streaming Optimized
Ultra HD
HD

Low Definition

Project Video Format
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Q Studio supports hardware encoding and decoding via NVIDIA NVENC/NVDEC or Intel Quick
Sync, which also greatly reduces CPU usage on low-performance computers

Any HD input sources will convert to the selected project format automatically.

Audio Mixer Remole Cam 1

Converter

= CONVERT

480p 29.97

When using Low Definition mode, you will only be able to stream in a resolution equal to your selected
Project Format regardless of which streaming provider you use. This is to preserve the CPU.

Media 1 Media 2

480p (1628 kbps) ~
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Adding Input Sources

To add inputs and other sources (e.g. remote cameras, media player, etc.), navigate to the Inputs tab in
the lower left quadrant of the Studio interface. Some inputs will have already been added automatically
such as graphics, two media players, and any detected cameras.

Audio Mixer

= OWEBCAM 1 FaceTima HD Camera (Builtin)

[a] GFX 4

[sa] GFX2

[Za] GFX 3

=¢ MEDIAA Ho media quesad

ADD INPUT

To add more inputs such as a remote camera, select Add Input.

MEDIA 1

ADD INPUT

A menu will open up with a variety of options:

e Local Camera: Any cameras that are physically connected to your computer, including webcams and
screens for screen capturing.
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» Remote: Sources that can communicate with Studio via the local network, such as Mevo,
Broadcasters, iOS and Android devices, Mac and Windows desktops, and NDI inputs. Any devices
already on the network and waiting for Studio will be listed here automatically.

 Live Interview: Invite guests from different locations to be a part of your production via their webcam

and browser. Studio only supports one interview.
e Stream: Bring in other streams, such as RTMP and RTSP playback, RTMP Ingest, or other events on

Livestream.
» Media: Add media bins to playback pre-recorded videos such as highlights or montages.
» GFX: Up to 3 graphics overlay channels can be individual sources such as picture-in-picture graphics

or fullscreen scoreboards.
e Audio Only: Bring in audio via USB or the direct inputs on the HD550 or Studio One hardware units.

You may add up to eight (8) Audio Only inputs.

Unless otherwise specified (i.e. Live Interview, GFX, and Audio Only), Studio allows for up to 50 total
sources to be added (e.g. 25 local cameras and 25 remote cameras, but no additional inputs).

Audio Mixer

Local Camera
FaceTime HD G
Remote
Live Interview
Stream

Media

GFX

Audio Only

ADD INPUT

Each source you add will appear in a list in the inputs menu. You can re-order your inputs dragging and
dropping them up and down via the drag handle on the left side; this will also change the order they

appear in the multi-view.
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2 WEBCAM 1

| GFX1

| GFX 2
a] GFX 3
W :» MEDIA 1

ADD INPUT

Each source will be given a default name, but you can edit this by hovering the cursor over it and
selecting the pencil icon that appears.

WEBCAM 1 FaceTime

GFX 1

For local cameras, use the Device drop-down menu to choose which capture device and input (e.g. SDI
or HDMI) should be used for each source.
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MEDIA 1

WEBCAM 1

DeckLink Mini Recorder [5]/ SDI
DreckLink Mini Recorder [5]/ HDMI

To configure settings for any source, select the corresponding gearwheel to enter its settings menu.

ALIDID MIEDIA 1

o WEBCAM 1

M CANT

Along the left side of the menu are menu options such as your audio source for that input, along with
additional settings.
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INPUT S ALDID
L CAM1

L Ganeral

General

!I-: Audsa

D_. Crop

MEDA 2

Under General is where you can choose the audio source tied to the select video source. Many camera
sources and capture devices, such as the Blackmagic DecklLink Quad or DeckLink Mini Recorder, will
only support embedded audio through their SDI and HDMI inputs. Other Blackmagic cards, such as
DeckLink Studio, will support embedded, analog, or AES/EBU audio via the provided Blackmagic

breakout cable.

@ Blackmagic analog audio inputs MUST be accompanied by a video input source to be active.
If a video signal is not coming into the card, audio will not come through either.

CAM1 ~

$ General
151 Audio
B crop
£ p1Z

Delay

O colo

MEDA 1 MEDIA 2
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Learn more about input settings.

If this is a source you will need to quickly access often, you can pin it so that a tab to it becomes
available alongside your other production elements. Select the pin icon to do this.

IHPUTS AL BEDIA 1

General

To return to the general Inputs menu, click the back button in the upper left corner.

INPUTS AUDIO MEDIA 1 MEDIA 2

< CAM1 ~

3 General
General

1t Audio

|1 Crop

£ pz

Status

If you have a Studio Surface or Surface Go connected to your system, you can assign the tracks under
the Surface slot column. If you do not have a Studio Surface product, this menu will not be present.
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AUDIO MEDIA 1

COLOR 1

WEBCAM 1

== MEDIA1

ALIDI MEDIA 1 MEDLA 2

CAM 2
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Screen Capturing with Livestream Studio

When adding your inputs in Livestream Studio, one source you can include is your computer's screen(s).

Navigate to Add Input > Local Camera. You can select a local screen from the menu that opens up.

Screen 1: Color LCD
Screen 2: DELL 2405FPW
Local Camera Colors / Bars
Remote
Live Interview
Stream
Media

GFX

Audio Only ? FaceTime HD Camera (Built-in)

ADD INPUT

¥ This feature is ideal for systems with multiple monitors connected (e.g. Livestream Studio on
one monitor, and a slideshow on another monitor). Please note that local screen capturing

will increase CPU

Once you select a screen, it will be available in your multi-view. You can transition it into Program just as

you can with any other input.

If you want to change out a screen (i.e. you chose one by mistake), you can open the Device drop-
down menu in the Inputs module and choose a different one.
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L DESKTOP 1

Screen 2: DELL 2405FPW N
ADD INPUT RS

There are a few settings you can configure when capturing a local desktop. Select the corresponding
gearwheel in the Inputs menu to adjust these.

MEDIA 1 MEDIA 2

":" Webl;'.-aﬂ‘l 1 FacaTime HD Camera (Bulll-in)

L1 Desktop 1 Screan 2: DELL 2405FPW

Under General settings, you can check your audio source; if you want to hear audio coming from your
computer, make sure LivestreamDesktopAudioCapture is selected. You can also choose whether you
want your mouse cursor to be displayed; this is disabled by default.
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INPUTS MEDIA 1

Desktop1 ~

{3 General

General

Audio
Audio source
Conwvert
LivestreamDeskitopAudioCapture
T crop
: Capture mouse cu

~

+ PTZ Status

Connected

Delay

{) Color

If you need to bring in local audio from your desktop, make sure to go into your system's Sound settings

and ensure that LivestreamDesktopAudioCapture is the selected output or playback device, rather than
your system'’s speakers or headphones.

® < Sound

Sound Effects Relliicliigy Input
Select a device for sound output:

Mamea Type

Internal Speakers Built-in
LivestreamDesktopAudioCapture

AFT

AirPlay
Apple TV [VHX) AirPlay
Apple TV 4k AirPlay
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Using the DeckLink Studio 2 and Similar
Cards

Most Blackmagic Design capture devices can be used as either an input or output device. One
example of this is the DeckLink Studio 2 card, which came preinstalled on Livestream's first
generation of Studio hardware products (HD50, HD500).

Add this card as an input by going to Inputs, then navigate to Add Input > Local to add it with whichever
connection type you are using.

If you add this as an input, but then try to add it as an output by going to the Outputs tab, Studio will
notify you that it is already being used in Inputs.

Settings: Outputs CANCEL

Outputs

Number of AUX Mixes

Hone
kLink SDH Quad [1] (used in inputs)
uad [2] N inputs)
[ Cuad [3] (used n inputs)
kLink S0H Quad [4] (used in inputs)
Decklink Studio 2 - SDI (used in inpuls)
Decklink Studio 2 - HDWMI (used in inpuls)
Decklink Studio 2 - Component (used in inputs
site (used in inputs)

kLink Studio Video (used in inputs)

If you want to use any device as an output, be sure to remove it from Inputs by selecting the
corresponding trash icon on the right side. Then you can go back to the Outputs tab and select it.
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Settings: Outputs CANCEL

Outputs

Number of AUX Mixes

] (used n inputs)
(used in inputs)
{used in inputs)
e Bnin rmr_l:._|
Decklink Studio 2 - S0
DeckLink Studio 2 - HOM|
DeckLi dio Component
omposie

When you select it as an output, you will notice that if you try to add it as an input again, it will not be
available.
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Using the DeckLink Mini Recorder

The Livestream Studio HD51 and HD550 are each equipped with five Blackmagic DeckLink Mini
Recorders; the HD31 has three cards installed.

Each card has one SDI input and one HDMI input.

The 4K editions of the HD51 and HD550 have 4K versions of these cards installed.

Each card can only handle one source at a time. You cannot use both the SDI and HDMI input on the
same card. For example, if you use the HDMI input on Mini Recorder 1, you cannot also use the SDI
input on Mini Recorder 1 and would thus have to use an SDI input on one of the other four Mini
Recorder cards.
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Configuring Input Settings

Every input in Livestream Studio has individual settings you can configure directly from the Inputs
module, including audio settings, conversion, cropping, audio/video sync correction, tally lights,
captions, and color correction.

To open the input settings module for a given source, navigate to the Inputs tab in the lower left
quadrant. To the right of each input is a gearwheel; selecting this will open input settings for that source.

ALDID MEDIA 1 MEDIA 2

'-:-‘ WE Ec;.ﬁ.l.ﬂ 1 FacaTime HD Cameara (Built-in)

Ea] GFX 1

Eal GFX 2

¥ You can also access an input's settings menu by clicking the gearwheel icon next to the
source’s display name in the multi-view or in the audio mixer by clicking the source name and
selecting Input Settings

General: This is the first tab that will open and will include any settings specific to that input source. For
example, direct camera inputs (e.g. webcams, HDMI/SDI cameras) will have the option to choose the
audio source for that camera (e.g. "built-in microphone,” "embedded,” etc.)

Mevo will allow you to configure all the basic settings for your Mevo directly from Studio.

Remote desktops (Windows and Mac) will show the options to change your video source, audio source,

and whether you want to capture the cursor from that desktop.
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INFUTS MEDIA 1

REMOTE1 ~
{} General Video source
T Audio
Conveart Monitor

DELL 2405FFW
‘L Crop

Mevo Overview

Audio source
Dalay

LivestreamDe

W Caplune mouse Cumsor

Status

You can learn more about the general settings available for:

» iOS and Android devices

o Localscreens

» Broadcasters

» NDI inputs

» Live interviews

» RTMP Server and other streams
» Media bins

» (Graphics overlays

o Audio-only inputs

Audio: Incoming audio channels are displayed for the selected source. In stereo mode, use the "L" and
"R" buttons along the bottom of the module to assign left and right audio channels to the input source
fader.

In mono mode, click the corresponding speaker icon to assign input channels to the source fader. Each
input channel has an individual level meter with gain control.

Stereo:
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Converter: Allows for video inputs to be converted to your project video format in real-time. This allows
producers to use different types of camera sources and formats. The video converter also has an auto-
detect function that will recognize different formats instantly.

Converter

WEBCAM1 Format

Parto (1280

Project Format

HD 1080i 59.94
ﬂ' Show Tips

If the converter does not automatically detect the source format of the camera, select the converter tab
to pick the format from a full range of format options and convert it into the format that the current
project is set to.

Crop: Allows you to crop your input's picture.

PTZ: If this input is a PTZ camera, you can connect and control it from here.

Delay: If you notice a discrepancy in synchronization between direct camera inputs and remote
cameras, you can delay an individual input's video and audio by up to two seconds to help keep your
sources in sync.
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https://help.livestream.com/hc/en-us/articles/360009338493-using-ptz-cameras-with-livestream-studio

Delay

Video Delay (milliseconds)

Audio Delay (milliseconds)

100 100 10

Color: If the coloring or white balance of your input source seems off, open this menu to correct it.

Tally: Activate and control a Tally Light system through Livestream Studio. After connecting a Metasetz
tally system via USB, click the Tally icon shown here and select and available tally port to assign to that

camera. Repeat this step for each camera source.

If you do not see this option, go to Settings: Advanced and make sure Tally is checked. Also please note
that these only work with local inputs and not remote sources.

Tally Light

Select Tally Output

MNone

0 Show Tips
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Closed Captions: Livestream Studio can receive a closed captioning signal from a closed captioning
encoder via SDI, and output to Livestream's live player. This is where you control which channel of

closed captions come through.

If you do not see this option, go to Settings: Advanced and make sure Closed Captioning is enabled.

@ This feature only works on players that support CEA-608 captions.

Closed Captions
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Using PTZ Cameras with Livestream Studio

You can connect and control a pan-tilt-zoom (PTZ) camera to Livestream Studio via VISCA or NDI

protocols.

Connect the PTZ Camera to Studio

First, connect your PTZ camera to the same network to which your Studio system is connected.

You can then connect the camera to Studio via SDI, HDMI, NDI, RTSP, etc. Go to the Inputs tab and
select Add Input. Depending on how you are connecting your camera, your PTZ will appear either under
Local Camera (e.g. SDI, HDMI), Remote (NDI), or Stream (RTSP, RTMP).

€@ Please note that in order for Studio to receive an NDI camera’s signal, you may need to install
the NDI|HX Driver from NewTek.

At this point, will see your camera’'s output appear in the Studio multi-view but you will not have control

access yet.

To the right of the PTZ source in Inputs, select the gearwheel. This will bring you to the camera’s general
settings. Select the PTZ tab on the left side.
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PTZ Camera

{} General

Connect with VISCA

1L .
ti Audio IP Address

Convart
0 Crop
PFTZ

Adapler indax

1

CONNECT

Connect with NDI

If you are connecting to your camera using VISCA, enter the camera’s IP address.

Port 5678 is standard but you may change it if you've configured your camera to communicate over a
different port (1-65536). Adapter index is useful if you have more than one PTZ camera.

Once you've configured your settings, select Connect.

Alternatively, if your camera is communicating via NDI, navigate to the bottom of the menu where it says
Connect with NDI. If an NDI signal is being received from this source, the Connect button will be
enabled. Click it to activate the PTZ controls.
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Connect with VISCA
IP Address

i+ Audio

Convert

Crop

[ 4

Adapter index

"

CONNECT

Connect with NDI

CONNECT

Control the PTZ Camera Inside Studio

After clicking either Connect button, your source will appear in the menu along side a set of controls
along the left side of the pane.
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To pan and tilt your camera, click and drag the virtual joystick in the direction you wish to move the

camera.

Below the virtual joystick is the zoom option; click and drag the zoom control right or left to zoom in or
zoom out.

Below the zoom control is the focus control. By default, the AF button is highlighted, which is Auto
Focus. To control the focus manually, disable the auto focus and click and drag the focus control left or
right to adjust it.
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Under the focus control is the white balance control, which is set to Auto by default.

White Balance

Auto

Auto

Indoor
Cutdoor

Connected with NDI

DISCONNECT

At the bottom, you can select Disconnect to disconnect Studio from your camera’'s PTZ controls.

Configure Preset Shots

You can configure up to five preset shots if you know you need the camera to move from one shot to
another frequently. First, use the manual controls described above to get the shot you need, then click
Save Preset.
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Zoom

SAVE PRESET

White Balance

Auto

All the numbered buttons will turn green. Select the one you wish to use for this shot (in this example,
we clicked 3).

(D121 ) (<) [s)| DEErEE

That number will turn yellow, indicating that you are currently on the number 3 preset shot. Now
whenever you need that shot, click the assigned number and the camera will move to that shot.
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SAVE PRESET

Open Controller in a New Window

In the bottom right corner of the PTZ controller module, click the new window button.

SAVE PRESET

White Balance

The PTZ menu will now be open in another window, which you can put next to Studio or in another
monitor to control your camera outside of the main Studio interface.
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Converting Input Sources of Different
Formats

Livestream Studio works best when all video input sources match the same video format. However,
with certain sources such as laptops and webcams, it may not be possible to match them all
together. This is where the built-in any-to-any converter comes in.

Go to the Inputs tab and select gearwheel corresponding to the source you need to convert. Then
select the Convert tab on the left side of the interface.

ALUDID MEDIA 1 MEDIA 2

2 Webcam 1

In most cases, Livestream Studio will automatically convert your source. Otherwise, choose your input

source's format from the drop-down menu.
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INPUTS MEDIA 1

Webcam1 v

{3} General

it Audio Converter -

= Convert

Weabcam 1 Format
|l Crop Auto (1280x720p 29.97fps 16:9)

A

v P12 Project Format

Delay HD 1UBUD 29.97
¢ Color @ Show Tips

Once the correct format is selected, the converter will turn on and you will see your video source.

Using the converter will reduce the quality of your video signal and increase your CPU usage,

so only use it when necessary

Bringing a Laptop into Livestream Studio

When bringing in a laptop, you will almost certainly use the converter. Many laptops come with an HDMI
output port that can directly connect to a Blackmagic capture device via an HDMI cable. For those that
do not have an HDMI output, we recommend using the Blackmagic DVI Extender.

Another option for bringing a laptop into Livestream Studio as a source is to install the Remote Camera
Client for Windows and Mac over your local network.

143


https://help.livestream.com/hc/en-us/articles/212721587-Using-the-Remote-Desktop-Client-for-macOS

Advanced Input Source Cropping

You can create multiple virtual camera shots for each input source. This works best with 4K inputs
and Mevo.

Navigate to the Inputs tab. Find the desired input you wish to crop and click the gearwheel that
corresponds to it to enter its settings.

MEDIA 1 MEDIA 2

LY WEBCAM 1 FacaTima HD Camara (Buill-in]

Eal GFX1

Select the Crop tab on the left side.

INPUTS ALDID MEDIA 1 MEDIA 2

CAM1 ~
'ﬁ General
i Audio

1 crep

€= PTZ

Dalay

) Color

Advanced mode
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You can do a basic crop by clicking and dragging the corner of the image, and dragging and dropping
the cropped frame. You can also scroll on your mouse or trackpad to crop. The crop will be locked to
the aspect ratio of your project format (16:9 in most cases).

INPUTS ALUDID MEDIA 1 MEDLA 2

CAM1 ~
{3} General

I Audic

1 crep

fs PTZ
Dalay

) Color

Advanced mode

Click Advanced Mode to reveal more cropping options.

If you are using Mevo, you will only see Advanced mode for cropping. Learn more about
controlling Mevo via Studio.

Advanced mode

To the right of your source are numbers 1-4 in different colors, each with a corresponding Take and Edit
button.
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TAKE EDIT

TAKE EDNT

Trarsfion Durathon

cr RS

Clicking Edit on any shot will allow you to adjust that particular shot without affecting the output. Click
and drag the corners to crop the shot. Notice the border of your shot matches the color of the
corresponding number, and the source in the multi-view is not yet reflecting the crop.

AUDIDY MEDIA 1

TAKE EDIT

TAKE EDIT
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¥ You can also scroll on your mouse (i.e. with a scroll wheel or if it's a touch-sensitive mouse)

to crop your shot.

Before clicking the glowing Take button, check the Transition Duration setting below.

Transition Duration

cuT L

Under Transition Duration, you can choose how you fast you want to move between shots. Cut will be
an immediate switch. The following timer buttons indicate a virtual camera movement (i.e., a virtual tilt

or pan) in order of increasing time (fast, medium, slow).

Once your Transition Duration is set, click the glowing Take button.
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Transiion Duration

cr RN

The Take button will turn red and you will notice your input will transition to the cropped area in your
multi-view.
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AUDID MEDIA 2

You can build up to four different cropped areas per input using the corresponding Edit buttons. Switch
between each using their corresponding Take buttons.

EDIT |
TAKE EDIT

TAKE EDIT

TAKE EDIT
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Color Correction in Livestream Studio

As of version 6, you can adjust the light levels and coloring in all of your camera sources whether
they are local (directly connected) or remote. You can adjust the shot's Hue, Saturation, Brightness,
Contrast, Lift, Gamma, and Gain with aid from three different color monitors

Color correction settings are available for each camera input except Mevo, as Mevo includes its own
image adjustments setting built-in, which is also accessible in Studio once a Mevo is connected. Color
correction settings cannot be applied to GFX or Media sources.

Navigate to the Inputs tab in the lower left corner of the interface. Select the corresponding gearwheel
to the input you wish to adjust.

ALUDIO

2 ‘Webcam 1 FacaTime HD Camera (Built-in)

Za| GFX1

Along the left side of the panel is the Color tab; selecting this opens the Color Correction menu.
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INFUTS ALUDID MEDIA 1

£ Webcam1 ~

{} General
Color Correction COLOR MONITORS

1§ Audio
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Hue ]

Convert

h Saturation
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& PTZ Brightness

Delay Cantrast

i) Color

Gamma

|+

Color Monitors

A helpful tool when color correcting is the Color Monitors window. There are three monitors you can

use when making adjustments to your image.

INPUTS MEDIA 1 MEDIA 2

Remote1 +~

{3} General

Color Correction COLOR MONITORS
Hue ‘J

15 Audio

By default, you will see the Waveform monitor. This monitor helps measure the blacks and whites in
your image from left to right. In this graph, you want to make sure all of the data (the green waves and

lines) are within this monitor (between 0 and 100 on the left side).
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If something is too dark, it will "crush” to the bottom, resulting in image loss to black; if something is too
light, the waves will crush to the top and result in overexposure. When you work with the Brightness,
Contrast, Lift, Gamma, and Gain settings (discussed below), you will see the impact in this graph.
(Although this chart is green, it's measuring all the white, gray, and black in the entire shot, not just the
green channel.)

[ e

Open the dropdown in the upper left corner of the window to see two more options: RGB Waveform
Parade and Vectorscope.

RGB Waveform Parade will show waveforms for each of the three video channels (red, green, blue),
informing you of the overall color balance in your shot. The closer all three match, the more balanced
your video will look in terms of color and temperature. In the below example, red is higher than green,
and blue is the lowest; this is because the shot has more red tones in it as it was taken during sunset; if
we balance these waveforms, it will look more like midday.

Similar to the Waveform, you want to make sure your colors aren't crushing all the way to the top or
bottom (unless you're going for a specific look).
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7 Color Monibars (Remaie 1)

To adjust these, open the color channel settings that are available with each light adjustment setting
(Brightness, Contrast, Lift, Gamma, Gain).

Brightness

Contrast

Lift

Gamma

Gain

By pushing up the blue and reducing the red, we now have a more color balanced shot.

Vectorscope measures hue and saturation. In other words, it tells you what colors are most prominent
and by how much. If you lower your saturation, the pixels in the middle will reduce and your image will
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look more black and white, whereas a saturated image will show the pixels more spread out towards the

edge of the scope.

Note that each color has a pair of squares, one closer to the center than the other; the more-center
square represents the pure color while the square farther to the edge is a super pure color (e.g. Yellow
and Super Yellow; these are both seen if you use HD SMPTE color bars).

17 Caoler Mositens (s 1)

Color Correction Settings and What They Mean

Best practice is to adjust your settings while the color monitors window is open. Each setting has a slider
that starts at a neutral position with a reset button next to it. Here is what each setting changes:

Hue: The actual colors that you see. Hue is a 360-degree measurement that reflects where on the color
wheel the colors in your shot fall. You can adjust it down to -180 degrees or up to 180 degrees; you will
notice these two extremes will be nearly identical in color but opposite of the neutral position. If you
have the vectorscope open when you adjust this setting, you will notice the pixel pattern will spin like a

wheel as you adjust the slider.

Zero degrees:

154



vimeo - livestream

180 degrees:

Saturation: The amount of color. If you reduce saturation to the lowest setting, your shot will be nearly
black and white. Slide it to the right to increase the color in your shot to be closer to pure color. Keep
your vectorscope open to ensure you don't over-saturate your image (i.e. pixels should not surpass the

squares).
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7 color Monitors [Remens 1)

Saturation increased, giving this shot more color, especially in the yellow/orange regions.

B7 Cokr Menitors (Ramets 1)

Brightness: Adjusts all of the lightness and darkness in your image symmetrically. In other words, your
white and blacks will move up and down the same amount, causing an extreme white when adjusted all
the way up and an extreme black when completely reduced. Keep an eye on your waveform monitor
while adjusting this, and consider using Lift, Gamma, and Gain before adjusting Brightness.
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7 Calor Wonions Renoe 1

When Brightness is increased, the entire waveform stays in the exact same shape but moves higher in

the graph. This is what we mean when we say it adjusts the light in the shot 'symmetrically.

Contrast: The difference in brightness between the darkest and lightest areas of your image. This is
another setting where your waveform graph will be helpful. Unlike Brightness, your blacks and whites
will move the same amount, but in opposite directions. An image with low contrast will show the
waveform more condensed to the middle and appear very gray and flat, whereas an image with high
contrast will be more spread out from top to bottom. This is another setting you should consider waiting
on changing until you adjust Lift, Gamma, and Gain first.
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7 Color Moniars (Romooe 1)

Increasing Contrast will show the waveform spreading apart evenly, with lights getting lighter just as the
darks get darker.

Lift: This controls the level of black in your shot without modifying the white. The waveform will show
the bottom half of the graph move the most when adjusting this setting. You will get all white when
raising the lift all the way up.
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E‘a-.l_ll:“l::l 90 LvE ERTORD - I Caky Wonhors (Romone 1)

Gamma: This controls the range of gray tones (or mid-tones) without modifying true black or true white.

Studio  souwe o b 7 Colr Wonhizrs (Renooe 1)
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Gamma has been raised, with the most movement happening in the middle of the waveform.

Gain: This controls the white levels in your shot without modifying the black. In other words, this is the
opposite of Lift. If you push this all the way down, your shot will be entirely black.

07 Cokyr Moniors (Ramooe 1)

Gain has been increased, dramatically increasing the lighter tones in this image and the darker tones
barely adjusting.
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¥ While Lift, Gamma, and Gain all focus on different areas of light in your image, adjusting them
will still impact the appearance of the entire shot. Consider using those three settings to

adjust the lighting balance in your image first, and then use Brightness or Contrast to help
boost those adjustments as you see fit

Comparing Two or More Inputs

If you have two (or more) cameras pointing at the same shot and you want to compare them, the
easiest way to to do this is to select the pin icon to add the input as its own tab for easy access.

MEDIA 1 MEDIA 2

Color Correction COLOR MONITORS

Hue )

Then go back to the Inputs tab and open the settings for another input. Pin as many cameras as you
need to compare.

You can then open the color monitors for each input, then compare and adjust accordingly. The name

of the input will be at the top of the window so you know which one you're adjusting. You can alway un-
pin and re-pin inputs as you need.
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Reset Settings to Default

If you've overdone it on a color correction setting, you can click the arrow button next to that setting to

reset it to the default position.

If you've adjusted multiple settings and want to start from scratch, click the Reset button at the bottom
of the Color Correction menu to reset all settings back to their defaults.
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163



Using the Color Source Generator

In addition to cameras, graphics and media sources, you can include color sources in your
Livestream Studio production.

To add a color source as an input source, navigate to the Inputs tab in the main Studio interface, then
click Add Input in the bottom left corner. Hover the cursor over Local Camera, which will open a menu
that includes Colors / Bars.

Screen 1: Color LCD
Local Camera Colors / Bars
Remote

Live Interview

Stream FaceTime HD Camera (Built-in)

Media
GFX

Audio Only

ADD INPUT

The color source will appear in your list of inputs. Click the gearwheel on the right side to access its
settings.

|

O COLOR1

You can use either a solid color or traditional color bars. If you select Solid Color, you can either type in
the hex code or click on the # button to select a color.
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You can also choose whether or not to include a test tone as your audio source by checking the box
next to Test Tone. You can also adjust the pitch of the tone below (default is 1000 Hz; a lower number
will be a lower pitch, a higher number creates a higher pitch). Uncheck the box if you do not want any
audio coming through your color source.

COLOR1 v

{3} General

Video Source Audio Source

Solid Color & Test Tone

1000

& Color Bars
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Using Livestream Studio’s Simple Interface

The Simplified Interface in Livestream Studio is a good option for customers with smaller
production setups looking for minimal clutter.

When you first launch Studio or create a new project, you will be prompted to choose your interface
mode: Simple or Advanced, allow you to arrange Studio in the Simple interface from the start.

If you have an existing project in Advanced mode, you can easily switch to Simple mode by clicking the
interface icon in the upper right corner and selecting Simple.

F_F1 B untitiell project(29) XX A"

Simple

Advanced

The most noticeable change can be seen in the upper portion of the interface. The Preview/Program
monitors are replaced by a single Output monitor; whichever source is in this monitor is what your
viewers are seeing. You will also notice the mixing panel that includes transition, graphics overlay, advert,
and fade-to-black controls is also gone.
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The Tabs containing your various production elements (graphics, media, etc.) will default to the Flat
setting, meaning the lower portion of the Studio interface will be grouped into one column rather than
have a divider splitting them into two interchangeable columns.

TRARSITIONG

mw EFEX A

S MEDIA

= DESKTOP 1

ALD WEUT

Your default production elements will also reduce to one GFX channel and one Media bin in
addition to any detected cameras. You can still add to your setup by going the Inputs tab and
selecting Add Input.

To switch between your video sources in this mode, use your mouse and left-click on the desired source
in your multi-view. The source will transition into the Output monitor.
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CUTPUT

DESKTOP 1

Using Graphics in Simple Mode

To overlay graphics in this mode, navigate to the GFX tab. Add a graphic by browsing the Graphics Store
or by clicking + Create Custom Graphic to build your own.
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| studio Graphics Store

-
Categories o [ -4
All Graphics ?J

Full Screen
Facebook: Comments

A

Animated

-

+ CREATE CUSTOM GRAPHIC T l‘ 1

L‘ B
o
- f‘.’

-

You will see your graphics preview and settings on the left side with the ability to add and edit data fields
on the right side.
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INPUTS STREAM AUDIO

& Name
PULL

Your name
PUSH
+ J Another Name
Auto-Loop

START AUTO-LOODP

Auto-Loop Settings

10 second interval between new items

w Start from beginning once end is reached

CHANGE LAYOUT rd + rROW <+ COLUMN

The main difference with graphics overlays in simplified mode versus advanced mode is how you
transition graphics overlays into the Output. Since the mixing panel is not present in Simple Mode, you
will see PUSH and PULL options here, with the layer's auto-loop settings underneath.

To adjust the design of the graphic, double-click the preview to open the GFX Designer. A more in-depth
explanation on building and using graphics overlays in Studio is covered in another section.

When you are ready to show your graphic, click the flashing PUSH button. The graphic will transition
into the Output; to remove it from Program, click the red PULL button.
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Auto-Loop

START AUTO-LOOP

Auto-Loop Settings

10 gecond interval between new items

Transitions in Simple Mode

By default, the GFX transitions will be a 45-frame long edge wipe, whereas transitions between different
video sources will be a cut.

You can change this by navigating to the Transitions module. Be sure the to select the correct tab on the
far left side when choosing your transitions; Main is your main video mix, followed by each graphics
overlay track. You can then select among different transition types
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Introduction to Multi-View & Preview/
Program Switching

The Advanced interface mode of Livestream Studio is designed for traditional Preview/Program
switching, with controls available via mouse, defined keyboard shortcuts, and assigned controls on
the Livestream Studio Surface or Surface Go.

The software includes a multi-view that allows you to see all of your video sources and graphics overlays
in one display.

If you are not seeing your full multi-view, go to the Multi-Screen tab in settings, and check Enable
Primary Screen Multi-View, then click Save.
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Settings: Multi-Screen CANCEL

This feature allows you to extend your multiview on multiple external

computer screens. To activate, mak ure that a secondary display is
connected and recognized by Windo n addition, ple

that in Windows >> Control Panel >> Appearanc

Display >> Screen Resolution >> Multiple displs

(tend these displays™ and not "Duplicate these display

v

Multi-5creen

At the top of this multi-view are two larger monitors, which are called Preview (left) and Program (right).

Preview is where you would typically review any video source or graphics overlay prior to transitioning it

to your recording and/or stream.

Program is the content that is currently showing in your recording and/or stream; it is what your viewers

are currently watching.

Below Preview and Program is an arrangement of smaller monitors with every camera input, graphics

overlay channel, media bin, remote camera, and color source that you are using.

175



EOMTITY

A standard multi-camera production typically involves putting a source into Preview, then using a
transition control to switch it into Program.
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Using a Mouse to Switch Preview and
Program

Advanced Mode includes Preview and Program monitors as well as a mixing panel with transition
controls, giving you more options for switching between your video sources using your mouse.

¥ If you are using the Simple Interface mode, see switching instructions here.

To put any of your sources into Preview, hover over the source in the multi-view with your mouse, and
simply click it.

That source will now be in the Preview monitor, and you should notice a green border around it in the
multi-view.
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If you want to put a source directly into Program without previewing it, hover your mouse over it in the
multi-view and right-click it.

That source will now be in Program and will have a red border surrounding it in the multi-view.
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You can also double-click on the Preview monitor, which will automatically transition that source into
Program.

To adjust how sources are put into Preview and Program using your mouse, navigate to the Mouse /
Touch tab in settings. Select the desired actions, then click Save.
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Settings: Mouse / Touch

Left dick on multiview 8

Right diick on multiview

Double dick on Preview

RESET TO DEFAULY

Livestream Studio’s transition controls can be found in the upper right corner of the software
interface. Cut switches Preview and Program immediately with no overlap occurring between them.
Clicking the Cut button activates this transition.

180



vimeo - livestream

Another commonly used transition is Dissolve, which is an overlapping crossfade between the changing
sources.

Finally, a Wipe is an animated transition where the Preview source overlays the Program source during
the switch.

In Livestream Studio, you can configure fades and wipes under the Transitions tab in the lower right
corner.
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STREAM

Framas

Resal Traraition Sattings

Notice on the left side that you can choose to set a transition for both your main mix (i.e., any source in
Preview) and each individual graphics overlay channel.

STREAM

Fade is the first option in the menu, which is the dissolve transition. When you select it, you can set the
amount of time you want an automatic transition between sources to last.
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Stream

Fade

Transition Duration

Frames

You can also double-click the duration time under the transition controls to change the speed of any
automatic transition quickly.

<k 4k
PU J

LL PUL

The next transition option is Dip to color, which is similar to a fade but instead of cross-fading the two
sources in Preview and Program, Program will fade, or "dip,” into a selected color which then, in turn,
fades into the source coming in from Preview.

When selecting Dip to color, you can choose the duration of the transition in frames and the color the
transition uses to the right of the transition menu. If you don't like your settings, click Reset Transition
Settings to go back to the default settings.
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A dip to color transition looks similar to this:

PROGRAM

The next transition is referred to as a stinger, which is a video or image sequence that animates in
Program while your sources cut in the background. This is common in live sports broadcasts switching
to and from replays or news broadcasts switching to different reporters.
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You can use a short .mov file by clicking Add Video or a PNG image sequence by clicking Add Image
Sequence. When selecting an image sequence, go to the folder your image sequence is saved in and
select the first file in the sequence; this will import all of them.

Stingers cannot exceed five (5) seconds. If you are using a video, we recommend you use an .mov file
that matches your project format in Studio to prevent upscaling or downscaling.

A PNG sequence should not exceed 1920x1080. If your project format is 30 FPS, your sequence should
not exceed 150 images; if the project is 60 FPS, the sequence can have a maximum of 300 images.

= m B usa swim animation & ] | o}
Previous 30 Days Previous 30 Days
__ MACOSX . B (1 to output_00000.png
usa swim animation > 01 to output_00001 .png

01 to output_00002.png
01 to output_00003.png
01 to output_00004.png
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01 to output_00006.png
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01 to output_00008.png

= 01 to output_00009.png

_% 01 to output_00010.png 01 to output_000(
& 01 to output_00011.png

2 01 to output_0001 2.png PNG imac
= 01 to output_0001 3.png Created 2{22}'19,1-
= 01 to output_00014.png Modified 2f22/19,1
= 01 to output_00015.png ast opened --

= 01 to output_00016.png Jimensions 1920 =10
= 01 to output_00017.png Add Tags

At sk AN D e

E

cancer | (TN

After importing your stinger into Studio, use the slider below to determine at what point during the
stinger the Preview and Program should switch. This should ideally be when the stinger overlays the
entire screen so that viewers don't see the cut behind it.
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Users/emily...r_test_1.mov

00:02:03

Transition at

After setting the stinger, click Auto to transition it in realtime.

PROGRAM (Media 2)

The remaining options in this menu are different kinds of wipes. Selecting one will show additional
settings on the right.
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Left Center Box Wipe

Reverse Direction will push the wipe in the opposite direction that it moves by default.

1=

Flip Flop will alternate the wipe between the default direction and the reverse direction.
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Feathering allows you to determine how hard or soft the edge of the wipe animation will be, in pixels.
The more pixels you cover, the more faded the line will be.

0 px 100 px

Some wipes also have options for adjusting their positions and appearance on the screen when they are
used.

To activate an automatic transition, click Auto in the upper right corner. The sources will then switch
based on the duration you set for that transition.
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You can always employ a manual transition by clicking and dragging the virtual T Bar below the
transition buttons. This allows you to control the speed of that transition.

189



Configuring a Keyboard to Use with
Livestream Studio

You can create custom keyboard shortcuts in Livestream Studio by assigning hotkeys.

Open the settings menu and click the Hotkeys tab.

This will reveal a list of controls. Each control has a default hotkey assigned to it.

Settings: Hotkeys cancer  [TSAVEN

Program Source 2 F:

Q The images below show the Livestream Studio Keyboard, which is simply a standard keyboard
that is designed to reflect the default hotkey settings. However, you can use hotkeys in

Livestream Studio with any keyboard.

Some common default keyboard commands include:
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The 1 key will put your first input source into Preview

F2 will put the second source into Program, F3 the third source, and so forth.
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€@ Mac Users: In order to use the F1, F2, etc. hotkeys, you must either hold down the fn key

when pressing them or go to System Preferences > Keyboard and make sure Use F1, F2, etc.
keys as standard function keys is checked.

Pressing Enter will cut between Preview and Program sources, while pressing the spacebar will
activate an auto-transition between those sources.

You can customize these hotkeys to better fit your workflow if you wish.

€@ The keyboard that Livestream provides with all Studio Hardware units (as well as for separate
purchase in our Store) is designed to fit the default hotkey settings when you are producing a

live event. It will operate like a normal keyboard when typing into text fields and when using
with other applications.
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Using External Multi-Screen with Livestream
Studio

If you have a second monitor connected to your system, you have the option of displaying all or
part of your multi-view by using your system'’s graphics card. The software can support up to a
Quad GPU setup out of a graphics card which can output to up to 4 displays.

Q For best results, we recommend connecting the secondary display to the available HDMI port
on the graphics card connected to your Livestream Studio system (It will also work with DVI

and VGA connections).

First, check your computer’s display settings in Control Panel. In Screen Resolution, go to the Multiple

Displays menu and select Extend these displays.

Change the appearance of your displays
(B
@

Display: 2.DELLU23LIH |
Resolution: [15211 = 1080 (recommended) v]
Onentation: ’ Landscape - |

Multiple displays: | Extend these displays v]|

In Livestream Studio, go to settings and click on the Multi-Screen tab. With the second monitor

connected, you will notice it looks different from before.
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Settings: Multi-Screen cancer  [PERVED

You should see your display listed in the Connected Display drop-down menu. Select the display and
click Identify.

Settings: Multi-Screen cance [FEAVER

1. intzi(R) HD Graphics 4600 (Screen 2 DELL P2T14T)

Select the resolution and frame rate at which you want Livestream Studio’s multi-view to output.
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1 el HN Granhes AR00 (Sefesn 2 TFLLD POT14T)

Next, determine which layout you want to see in your external monitor.

PROGR M

Below the layout selection, use your mouse to drag and drop each video source you want to see into
the appropriate box below.
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VIEWER 1

In addition to video sources, you can include a logo, time of day, viewer count, and stream status.

If you drag a logo into your external multi-view, click on it to be given the option to upload a logo
image.
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VIEWER 3

SCreen Uveriays

Show Warning Overiays Alow Mouse on Mullk-'View

Underneath the multi-view preview, you will see options for showing or hiding specific overlays on the
multi-view and for whether you want to allow your mouse onto that display.

v Show Audio Levels Overays f Show Screen Overlays

W Show Warmng Overiays W clow Mouse on Myl \View

When you have set your multi-view to your desired preferences, click Save. You will see the multi-view
appear on your external monitor.
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HD1920x1080 29, amfps

Frama: 110

);208

livestream

4:50:57 PM
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Audio Workflow
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Adding Audio Sources

Livestream Studio’s built-in audio mixer can be found in the lower left corner of the interface under the

Audio tab.

INPUTS MEDIA 1

COLOR 1 WEBCAM 1 MEDIA 1

RECORD OU!

[o] & ) . ) : |T| . <) ) |

AUDIO | AUDIO AUDID AUDID AUDIO

Each input source will have a corresponding audio source that you can monitor and adjust.

STREAM OUT "

You may have a separate audio mixer or a microphone can connect to your system directly via USB or

line-in (the HD550 also has two 1/4-inch XLR combo inputs built in).

¥ We have successfully tested Onyx and M-Audio mixers with Livestream Studio. Generally
speaking, any device your operating system--Windows or Mac--supports will work with

Livestream Studio, although we recommend using audio devices that do not require drivers

to be installed.

To add these sources, navigate to Inputs > Add Input > Audio Only. Choose your source from the menu

that pops open. You can add up to eight (8) Audio Only sources.
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MEDIA 1

Local Camera

Remote

FaceTime HD Camera (Built-in)

Live Interview

Stream

Media LivestreamDesktopAudioCapture
GFX WH-CH700M

Audio Only ZoomAudioDevice

ADD INPUT

If your device is not recognized, check to see if it needs to have drivers installed.

Livestream Studio will automatically label the source (e.g., AUDIO1). Hover your cursor over the name
and then select the pencil icon that appears to edit it if you wish.

AUDIO 1 X WH-CHT70ON

ADD INPUT

This source can also be assigned to a track on Studio Surface if you have one connected.
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AUDID MEDIA 1

MEDIA 1

GFX 1

& AUDIO 1

ADD INPUT

You should now see your audio source included with your other sources in the Audio Mixer.

MEDIA 1

STREAM QUT -
RECORD OUT

GFX 2 AUDIC 1
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Monitoring Audio in Livestream Studio

In order to mix your audio effectively, you need to be able to hear it. Start by plugging headphones or
speakers into the headphone jack on your system.

You may not hear any audio right away, even if you see audio levels. If this is the case, there are settings
on your system to check.

Windows

Go to your Windows Control Panel and navigate to your Sound settings. Under the Playback tab settings,
look for Speakers - RealTek High Definition Audio. Select that source, click Set as Default, then click OK.
You may need to disable some other audio devices first for this to take effect.
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Select a playback device below to modify its settings:

NVIDIA HDMI Output [Port 0)
MVIDIA High Definition Audio
Mot plugged in

MNVIDIA HDMI Qutput (Port 1)
NVIDIA High Definition Audio
Mot plugged in

Speakers
Realtek High Definition Audio
Default Device

Realtek Digital Output{Optical)
Realtek High Definition Audio
Ready

apeakers
USE PnP Sound Device
Default Communications Desice

FeFan

Mac

Go to System Preferences > Sound. In the Output screen, make sure Headphones is highlighted.
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Sound C
Sound Effects | Output | Input
Select a device for sound output:
Name Type
Headphones Headphaone port
LivestreamDesktopAudioCapture
Settings for the selected device:
Balance:
laft right

Output volume: of Z'::I Mute

Show volume in menu bar

After confirming the above system settings, navigate to Livestream Studio. Check the headphone

volume meter in the upper right corner and adjust the level to the desired volume. You can also adjust
your Windows volume as you would when using any other program.

This does not affect audio levels of the inputs, Preview, or Program.
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You will know which sources you are hearing in your headphones by checking the Audio Mixer. The
bottom of each source has a headphone button.

STREAM OUT .
RECORD OUT

Any headphone button with a white border is currently being heard in your headphones. You can
monitor as many sources at any given time as you need. Click on the headphone button to stop
monitoring the corresponding source; you will notice the white border will disappear from the button.
This also applies when monitoring Program audio, which is typically represented by Stream Out / Record
Out.

This only impacts your local headphone output and does not stop the audio from outputting
to your stream and/or recording.

While monitoring your audio, keep an eye on your levels both in the audio mixer and in the multi-view.
Each sources audio is seen on the left side of each monitor. You can also further adjust any input's audio
by implementing audio filters.

Clicking the lock icon below the levels indicator will enable Peak Hold for that source, which will provide
a permanent visual as to where your audio is peaking so you may adjust accordingly. Keeping this icon
unlocked (default) will still show the indicator but it will follow your levels as they go down.
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Controlling the Audio Mixer

For each audio source in the Audio Mixer, you can see that source’s levels, as well as a corresponding
fader, speaker button, and Audio button.

¥ While this mixer controls the basic levels and mix of all your audio sources, you can refine
each individual input's audio using audio filters.

INPUTS

COLOR 1

When switching sources, you may notice the different Audio buttons turning yellow as you make the
transitions. This indicates that the audio source is heard in Program because its corresponding video
input is in Program. It is not heard when the video input is not in Program.

You may also notice the sources in the switcher highlighted red or green. This is simply indicating what
is also shown in the multiview; the source highlighted in red is in Program, the source highlighted in
green is in Preview.
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If there is a particular audio source you want outputting to Program at all times, click the Audio button; it
will turn red.
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INPUTS

COLOR1

This locks that input source’s audio into Program. Even if you continue switching video sources, you will
still hear that audio source in addition to any other active audio source.
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INPUTS

COLOR 1

Click the Audio button again to disable the locking. What you hear will revert to the default setting of

following the video source into and out of Program.

If there is a particular source’s audio that you do not want to hear at any point, click on the
corresponding speaker button. The button should go from white to black, and the levels will fade from
green/yellow to gray. This indicates that the source is muted. You can turn off muting for any source by

clicking its speaker button again.
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INPUTS

COLOR1

¥ Muted sources can still be monitored through headphones as long as the headphone button
is activated

You can also link audio sources to each other. For example, if you have all audio coming in from CAML,
you may want to link other cameras to that source for seamless transitions.

Click on the name of the source at the top of the audio module. You will notice you have the option to
link to any other input source.
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CAM 2
Settings
Link to COLOR 1
Link to CAM 1

Link to Media 2

| ) | | < |

AUDIO AUDIO

Linking an input will cause the linked source to override the audio that had been coming in originally.

The mixer will indicate which source’s audio is being heard.

In this example, CAM1 has been linked to CAM2, so viewers will hear CAM1's audio when either CAM1 or
CAM2 are in Program. Notice in the image below how the levels are identical and both Audio buttons
are yellow (the red bar above the CAMZ2 label indicates that CAM2 is in Program).
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INPUTS

COLOR 1

You can link multiple inputs to one audio source for smooth transitions.
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INPUTS

COLOR 1

By default, Record Out and Stream Out together for consistent Program audio across all output sources.
Those two outputs may be unlinked if desired, but they cannot be linked to any other source.
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STREAM OUT .
RECORD OUT

Output settings

Unlink RECORD OUT

To adjust the levels of any audio source, click and drag the corresponding fader for that source. A good
rule of thumb is to ensure your audio peaks at around -4dB.
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If audio levels are too high (i.e. they reach or exceed 0dB, the mixer's OVR meter for any over-
modulating source will blink red. Activating an input source'’s audio filters can help prevent this.
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INPUTS

COLOR 1

You can also adjust the gain of each source by clicking and dragging the small gain meter above that
source’s level meter.
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INPUTS

COLOR 1 e
Gain: 3.8 dB

%
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Multi-Language Audio

Livestream Studio can accept multiple audio tracks with different languages via SDI and/or a multi-
channel audio interface and send them out to either a single player (via UDP or Zixi only), or
simulcast multiple streams, each with a different language selected.

Requirements

To bring multiple languages into Studio, they must come in through a single input with multiple channels
of audio (e.g. English in channels 1 and 2, Spanish in channels 3 and 4, and so on. You could also
configure one language per channel with each one outputting to L and R). This can typically be achieved
using an external audio mixer going into a camera, which then outputs SDI into your Studio system.
We've also tested the Behringer UMC404HD interface successfully.

If you wish to have a single stream where viewers can choose which language they hear in the
destination player, your streaming provider will need to include a server that can accept MPEG-TS
output. Currently, neither Vimeo nor Livestream support this workflow, but you can learn more about
how to set it up with Wowza here.

The alternative is to simulcast from Studio to multiple destinations (e.g. three separate Vimeo events).
You can choose which language each event should output in the Stream tab; this is described in further
detail below.

If neither setup works for you, we'd love to hear your feedback.

Language configuration

221


https://www.behringer.com//Categories/Behringer/Computer-Audio/Interfaces/UMC404HD/p/P0BK1#googtrans(en%7Cen)
https://www.wowza.com/docs/how-to-use-alternative-audio-or-video-tracks-with-apple-hls-streams
https://forms.gle/KviZD5DBFJ92WJCJ6

To setup multiple languages in Studio, navigate to Settings: Multi-language Events and check Enable
Multi-language Events.

Settings: Multi-language Events CANCEL | SAVE

& Enable Multi-language Events ow to set up multi-language events
Audio source

Audio 1

Audio tracks

Name Language

English ang

PROVIDE FEEDBACK

Multi-language Events

Select the input that the multiple audio channels with the different languages are coming in.
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Settings: Multi-language Events CANCEL [ SAVE

Enable Multi-language E 5 0 set up multi=languag
guag p quag

Audio 1

Audio tracks

Name Language

English ang

FROVIDE FEEDBACK

Multi-language Events

You can add up to 16 languages. Use the + / - buttons to add and remove language tracks, then use the
drop-down menu on the right side to select the desired language. The abbreviations here are based on
international language standards; a reference of language codes is available here.

& Enable Multi-languaga Events How to set up multi-language events
Audio source
Audio 1

Audio tracks

MName Language

English ang

Spanish spa
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Be sure to add languages in the same order in which they are coming into Studio. For example, if English
is coming in via channel 1, add English first. This is so Studio can map them to the correct channel

properly (although you can adjust it manually if needed). Save your settings when you're done.

Navigate to the Inputs tab and select the gearwheel of the input with the languages coming in. Select
the Audio tab. In addition to Filters, you should see a separate tab for each language you added. This is
where you can check and adjust the channels that each language is using in Studio.

If you adjust filters, they will be applied to all available languages. There is currently no way to

adjust filters for each language individually

English INPUT 1 INPUT 2

Spanish

Filters
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English INPUT 1

Spanish

Filters

To monitor the languages coming in, navigate to the Audio tab. A drop-down menu with the various
languages will appear under the input you selected in the Settings: Multi-language Events menu. You can
use this menu to select which language you monitor locally. This does not impact your stream, but
rather gives you a chance to confirm that the correct language is coming through the correct channels.

MEDIAA MEDIA 2

Media 1 Media 2 Audio 1

English
Spanish

English

| <) | : | <) | <)

AUDIO AUDIO AUDIO
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¥ If you want to listen to audio channels while manually mapping them to languages, try having
the audio mixer and the input audio settings open in opposite columns so you can navigate

between them seamlessly.

MEDIA 2 ALDIO

Audio 1

INPUT 1 INPUT 2

English

o | [ o

ALIDIO

Streaming via UDP or Zixi to a single player

Navigate to the Stream tab and select either UDP or Zixi as your streaming destination. Enter your
destination URL into the URL field.

Below this, you can find the Video PID (packet identifier) and each language’s audio PID. Studio
generates these automatically but you can edit them to be any value between 32-8190. You will need
these when creating .stream and SMIL files for Wowza.

Each language will be checked by default, but if for any reason you don't want a language included in a
stream, uncheck it and it won't output to Program.
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Select Go Live when you're ready to start your stream.

TRAN, .. IONS

Set Up Your Stream

Select a provider below to configure stream settings

A 1 f _RTMP

> v

TRAM...IONS

LIDF URL

Video PID

Audio racks

w* Englsh

& Spanish

Streaming to multiple destinations with different audio
tracks
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For all other providers available in Studio, you can achieve a multi-language event by adding multiple
streaming destinations. For example, Vimeo Premium allows for up to three simultaneous live events,
which would let you broadcast three streams with identical video but different audio at the same time all

within one provider,

When you have multi-language events enabled and your languages configured (as described above), you
will see a Select Language drop-down menu, allowing you to choose which language will output to that
destination. Select a different language for each stream.

¥ Consider including the language in the name of each event (i.e. Vimeo events, Livestream
events, Facebook schedule posts) so that your viewers know which one to watch and also so
you can easily choose which language to configure for each stream.

TRAN...JIONS

AUDIO

Selact Evant

Game 1 [Spanish)

Share Wilh

Argona

anguage

Make sure each destination is activated (i.e. is checked at the top of the panel or when you hover over its
bottom tab). Select Go Live when you're ready to start streaming; each destination will go live

simultaneously.
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Fold Audio Channels Into Mono

In Livestream Studio, your audio setup can be set to either mono or stereo.

To fold all of your audio channels into mono. Go to Settings: Advanced. In the Project Audio Format

drop-down menu, select 48kHz Mono.

Settings: Advanced

Project Format

Projects Location
Inputs

Crossfade Audio on Cut

Outputs

. Project Audio Format
Audio In

Mu ti-View Neintarlarinn

Method

Media Player Graphic Overlay Tracks

Streaming Startup

CANCEL SAVE

BROWSE

Frames

48kHz Stereo

48kHz Mono
48kHz Stereo

FX Tracks

Launch on startup

Now all of your audio inputs will be in mono. You can see this by going to the Inputs tab, then select the

gearwheel that corresponds to the desired input, then select Audio.

AUDIO

& COLOR 1

2 CAMA FeceTime HD Camera (Built-in)

MEDIA 2
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INPUTS MEDIA 2

CAM1 ~

General INPUT 1 INPUT 2
i Audio

Convrt

Crop

PTZ

Dalay

t] Color

|+
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Audio Filters

As of version 6, Studio’s input settings now includes audio filters, allowing you to adjust and define
the sound coming from each camera or audio source. Filters included are a Limiter, Compressor,
Equalizer, and Noise Gate.

To adjust an input's audio, navigate to the Inputs tab in the lower left corner. Select the gearwheel that
corresponds to the source you wish to adjust.

AUDIO MEDIA 1 MEDIA 2

FacaTime HD Camara (Buill-in)

Select the Audio tab on the left side. Be sure to check the General tab to adjust your overall input audio
levels first; a good rule of thumb is to set this so your audio peaks at around -4 decibels (dB), which you
can do either by adjusting the gain above the audio input.

You should also check the channels to which your audio source is outputting. For example, if you only
have audio coming in through Input 1 (channel 1), be sure both the L and R buttons are selected so your
viewers on headphones hear audio in both ears rather than one. This common with Studio One units.
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Webcam1 ~

{3} General General INPUT 1

INPUT 2

Audio Filters q
Convert

Crop

PTZ

Delay

To adjust your audio further, select the Filters tab.
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INPUTS AUDID MEDILA 1 MEDIA 2

Webcam 1 ~

{3} General General @ Limiter
ar

1t Audio Filters

Threshold
Convert

Crop
PTZ

Threshold
Dalay

Ratio
Color
Attack
Rolease 2000 ms

Knee radius

Makeup gain

Natection

One thing to note is that the default settings for each (i.e. if you enable all filters but don't adjust the
settings any further) are best suited for speech audio, such as interviews, panel discussions, public
meetings, etc. If you're in a noisier or more dynamic audio environment (e.g. concerts, recitals), you may
want to adjust these further to get the desired sound. While we can provide guidelines for what each
setting adjusts, best practice is always to test, listen, and adjust accordingly.

There are four areas in which you can adjust your input's audio. Generally, it's best to start from the
bottom, which deals with lower audio levels, and work your way up.

Noise Gate

The Noise Gate at the bottom of the menu deals with the quieter end of your audio. It's disabled by
default so be sure to select the checkmark if you want to activate it.
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This is useful if you're in an environment that may have a lot of undesired background noise, such as an
HVAC system. The default threshold is set to -40dB. When you go above this threshold, all sound will

come through. However, when your main incoming audio drops below this, your background noise will
be filtered out.

For example, if a band is playing a song, presumably their audio would be well above -40dB, and so the
Noise Gate would allow all sound to come through. When the band finishes their song, audio may drop
below this threshold, and thus any faint background noise would also cut out.

& Moise gate

Threshold

Equalizer

Above the Noise Gate is the Equalizer, which balances out different pitches and determines what pitches
(or frequencies) should be louder than others. If you want to apply the Equalizer to your audio input, be
sure to select the corresponding checkmark.

Before adjusting the Preamp setting, take a look at the frequencies below it. Each slider represents a
different sound frequency, with the lowest pitches being on the left and the highest on the right. By
default, these are all balanced at 0 dB. If, for example, you notice that a deeper voice is coming in louder
than a higher pitched voice when they should be equal, this is where you can fix that.
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& Equalizer

Preamp

+12 dB

+6 dB

UL RN — BN — B — B — B — B — B — B — B — B —

-5 dB

-12 dB

If, after adjusting your frequencies, you notice that your overall sound is particularly loud or soft, this is
where the Preamp comes into play. It defaults to O dB, but you can increase or decrease the average
audio level the source outputs using this setting, allowing you to keep your frequencies balanced as
desired, but ensuring this source still gets heard at the appropriate volume.

Here are a few guidelines for what each frequency represents:

e 32 -sub-bass (a subwoofer's low vibration during a deep space scene)

e 64 - bass (kick drum)

e 125 - bass (bass guitar)

e 250 - upper bass (lower vocals, lower notes of a piano)

» 500 - lower midrange (cello)

« 1k - midrange (adjusting this setting will likely have the most obvious impact on your sound)
e 2k - upper midrange (pop of a snare drum, trumpet; also very obvious to human ears)

« 4k - presence/sibilance (the traditional "treble” setting in home stereos)

» 8k - brilliance (cymbals, bells)

« 16k - open air (nearly the limit to which the human ear can hear)
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Compressor

The next setting up is the Compressor, which is not activated by default. If you wish to compress your

louder audio, be sure to select the checkmark to enable it.

In short, the Compressor takes louder audio levels and reduces them to more normalized levels. This is
primarily determined by the Threshold setting, which should be set to a lower decibel level than the
threshold from the Limiter (discussed below). The Compressor's threshold establishes a dynamic range
of audio, keeping most of your audio within a certain level.

Any audio that comes in below this threshold will not be impacted by the Compressor (in other words,
however it comes through the input is exactly how it will output). Sounds above this decibel level will be

‘compressed,” or reduced to output at a lower level compared to how it comes in.

The rest of the settings in this filter determine how the Compressor behaves.

» Compressor

Threshold
Ratio
Attack
Release

Knee radius +18 dB

Makeup gain

Detection
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Ratio: There is some math involved in this setting, but generally speaking this determines how
dramatically audio above the threshold will be compressed, with the default setting set to a 5:1 ratio. For
example, if an audio signal comes in 5dB above the threshold, then the Compressor will output that
audio at 1dB above the configured threshold. If you imagine a straight, diagonal line graph, the threshold
tells Studio at what point the line should bend, and the ratio will determine how far it bends down.

Attack: How long (in milliseconds) the audio signal should be above the threshold before Studio applies
the compression. If you set a longer attack time, then shorter spikes in audio will not be compressed.
This is set to 4 ms by default.

Release: Essentially the opposite of attack; this setting determines how long Studio should wait before
uncompressing audio when it returns below the threshold. This is also set to 200ms by default, but note
that the maximum release time available is higher than the attack setting.

Knee radius: This measures how gradual the transition from uncompressed to compressed audio will be
once your audio level goes past the threshold. A lower setting will make the transition more abrupt,
whereas a higher setting will create a more smooth, gradual transition.

Makeup gain: This is also sometimes referred to as "output gain.” Oftentimes when compressing audio, it
could end up compressing sound so much that it actually goes below the threshold and cause louder
sounds to be quieter than their quieter counterparts. The makeup gain will bring that louder audio back

up to where it should be in terms of volume.

Detection: This determines how the Compressor detects audio peaks. Peak will recognize absolute
peaks and be more responsive to short spikes in audio that go above the threshold. RMS (Root Mean
Square) determines the average peak audio rather than brief spikes and thus is less responsive to short
peaks.

Limiter
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Finally at the top is the Limiter, which is enabled by default and is almost the opposite of the Noise Gate.
The lone setting in this filter is the Threshold, which is typically set to a very high dB level, with the
default setting being -1 dB.

This helps prevent your audio from overmodulating should an extremely loud sound come through. Any
audio that surpasses the threshold configured here will be filtered out, including any audio that is
decreased through the Compressor but still reaches above this limit. If you are in a very quiet
environment, you may consider lowering this beyond the default setting.

»| Limiter

Threshold

If you adjust your audio so much that to the point where you want to start from scratch, each filter has a
Reset button that places everything within that filter back to default settings.
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Using HD550 Direct Audio Inputs

HD550 users have the ability to plug in an XLR or ¥4" audio input directly into their unit without the
need for a USB adapter.

Please note that these inputs support mic level audio signals only. If your audio equipment is
line level, see here for a workaround

When you plug in your audio source, be sure to add it as an audio input by navigating to the Inputs tab.
Select Add Input > Audio Only. These inputs are the USB PnP Sound Devices.
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AUDND MEDIA 1

m« Cam5 DeckLink Mini

Line In (2- Blackmagic DeckLink Mini Recorder Audio)

Line In (3- Blackmagic DeckLink Minl Recorder Audio)
Line In {4- Blackmagic DeckLink Mini Recorder Audio)
Line In

Line In (Blackmagic DeckLink Mini Recorder Audio)
Microphone (2- USB PnP Sound Device)

Microphone (1 PnP Sound Device)

ADD INPUT

You may notice a very low level of sound coming in. This low level of audio may appear regardless if
your source is connected or not.

AUMO

AUDID

240



vimeo - livestream

This white noise should not exceed -48dB on either input. It is characteristic of all USB-based PC audio
devices and is virtually inaudible.

241



Using the Studio One Audio Inputs and
Outputs

All editions of the Studio One hardware includes two 1/4" audio inputs and two 1/4" audio outputs.

These can all be found labeled on the back of the unit.
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HDMI / SDI OUT

To ensure your Studio One audio setup is configured correctly, go to Control Panel and open the Sound
settings. You will want to ensure the following:

» Under the Playback tab, set Speakers: Realtek High Definition Audio as the Default Device. This will
allow for the headphone jack in the front of the unit to work so that you can monitor audio from
Studio.

« Also under the Playback tab, set U24XL with SPDIF I/O as the Default Communication Device to
allow the 4" output jacks of the Studio One unit to playback the Program Output of the Studio
program at all times.

« Under the Recording tab, set Line: U24XL with SPDIF I/O as the default device to bring your ¥4" audio
inputs into Studio.
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Select a playback device below to modify its settings:

D' Speakers
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SPDIF Interface

Configure Set Default |v Properties
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? Sound *
Playback Recordng Sounds Communications
Select a recording device below to modify its settings:
N
Audio 2
o 20
a l.mr
m Sterw I‘\‘le
a I.ln:
SPDIF Interfal:e
L
5et Default Properties
o] cne

The 1/4" Out plugs will output Program audio (i.e. audio coming through Stream Out/Record Out in
Studio’s audio mixer). Keep in mind these outputs are stereo by design, so you will hear Channel 1
through the L output and Channel 2 through the R output.

Plug in your audio source to the inputs (bottom ports). After you launch Studio, go to the Inputs tab in
the lower right corner. Select Add Input > Audio Only. Select the 1/4" Input(s).

n ': LI

Audio Only 2 Stereo Mix (Realtek High Definition Audio

ADD INPUT
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Troubleshooting: Not Seeing 1/4" Input in Studio Settings?

First, make sure you are running Studio version 5.2 or later, as this version resolves an issue with
detecting the drivers for the card.

If Studio still does not detect your audio inputs after updating, you may need to rollback the audio
device's drivers to the Windows default driver.

To do this, navigate to Control Panel > Uninstall a program, and uninstall ESI U 24 XL USB Driver version
v2.6.0.0. You will need to restart your system after doing this.

Uninstall or change a program

To uninstall a program, select it from the list and then click Uninstall, Change,

Organize =+  Uninstall

Mame ? Publisher
Eﬂlickmagll: Design Desitop Video Blackmagic Design
W Bonjour Apple Inc.

"0 ESI U24 XL USB Driver versig=--2 &80 “5l-Audictechnik
€ Google Chiome Uninstall aoogle Inc.

[ Google Drive File Stream Google, Inc.

L BT LT S S ——— - R P -

Open Control Panel > Device Manager, open the Sound, video and game controllers option and find
U24XL with SPDIF I/O. Right-click it and select Properties.
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M Device Manager
File Action View Help
o MmO HEHm B kX

i Mice and other pointing devices
B Monitors

& Network adapters

= Print queues

[ Processors

[fdeviges
~ i Sound, video and game controllers
Co Lapiure L'ual .

iy 00 Eco Capture Dual HDMI M.
Blackmagic Audio
Blackmagic DeckLink Mini Menitor
Blackmagic DeckLink WDM Streaming
Intel(R) Display Audic
MewTek NDI Audio
MNewTek WDM Eemel Streaming Driver
Realtek High Definition Audio
ﬂ U24X1L with SPDIF 1/} I

S Storage controllel Update driver

3 System devices Disable device
v @ Universal Serial By
§ Generic USB -
Intel(R) USE 3. Scan for hardware changes
USE Compos N
UsB Composl Froperties I
USE Root Hub (USB 3.0)

F -y vy ¥y

Uninstall device

L=

Select the Drivers tab. If the Driver Provider says "ESI" and the Driver Version says "2.6.0," then select Roll
Back Driver. This will remove the ESI driver in favor of the Microsoft driver version 10.0.17134.1.
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U24XL with SPDIF /O Properties X
General Diver Details Events

r:) U24XL with SPDIF 11O

| Oriver Provider:  Esi |

Driver Diate 21872016
Driver Version:  2.6.0.0
Digtal Signer: ESI Audictechnik GmbH

View details about the nstaled dver fies
Update Driver Update the driver for this device.

I the device fails after updating the dmver, rol

Rt  back ko the previously inetalled diiver
Desable Device Disable the device
Uninstal Device Uningtall the device from the system (Advanced).

0K Cancel

Restart your system again. When you launch Studio, create a new project to start with a fresh audio
configuration.

If the issue persists, you can try going back to the Driver window (shown above) and this time select
Disable Device and restart your system. When Windows relaunches, go back to Device Manager, find
U24XL with SPDIF I/O, right click it and re-enable the device. You will need to restart again and we
recommend creating a new Studio project.

If disabling the device does not resolve the issue still, you may again go back to the Driver window and
select Uninstall Device. When you restart your machine, the device will reinstall. Relaunch Studio and

create a new project.

If the issue still persists, please contact us.

The source will automatically be labeled Audio 1 and appear in both the Inputs list and the Audio Mixer.
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STREAN OUT
REECORT T

MEDEAZ REMMITET ALDCA

You can adjust the channel input into Studio by navigating to the Inputs tab, selecting the gearwheel that
corresponds to Audio 1, and then selecting Audio on the left side.

You will see both audio channels; Input 1 is the Left (L) input, Input 2 is the Right (R) input. Each input can
be configured to send audio out to either one channel or both channels.

For example, if your audio source is only plugged into the R input on the Studio One unit, you may want
to configure Input 2 to send audio to both the L and R channels so that your viewers will hear audio
from both sides rather than only one channel.

INPUT 2

Both channels will be reflected inside Studio’'s Audio Mixer.
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If you are using both 1/4" inputs, you can keep each input separate by selecting L under Input 1 and R
under Input 2, creating a stereo audio output to your stream.
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Using Line In Audio Sources with the
HD550

If you own an HD550 and wish to use a line in audio input rather than a mic in audio input, you will
need to add an additional accessory to your setup.

The HD550 XLR inputs support mic level inputs only, which ranges from -60dBV to -40dBV. Line level
audio on consumer products starts much higher at -10dBV.

If you add a Whirlwind IMPAD In-Line XLR Barrel Transformer to your workflow, this will allow you to
bring in a line level source into the XLR inputs on the HD550. These accessories reduce the decibel (dB)
level coming from your audio source so that Studio can support it.

These barrel transformers vary based on the amount of dB they remove from the source. For example,
the Whirlwind IMPAD40 removes 40dB from your source's audio. Also available are:

o Whirlwind IMPAD30 - removes 30dB
o Whirlwind IMPAD20 - removes 20dB
o Whirlwind IMPAD10- removes 10dB

Simply connect your audio source to the female end of the transformer, then connect the male end of
the transformer to your HD550. Then configure your audio as you normally would.

We cannot guarantee that other similar products will work with the HD550 as we have not
tested them. If you have success bringing in a line-in source using a different workflow, please
let us know!
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Outputting & Recording
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Setting Up a Video Output

Livestream Studio allows you to send up to 25 video signal separate to different sources such as
monitors, projectors, etc. This requires multiple Blackmagic Design video cards that can output a
video signhal.

¥ Trying to set up an NDI output? Learn more.

Navigate to the Outputs tab in Settings and click the + button to add an output source.

Settings: Outputs canceL [FSAVEY

Outputs

Number of AUX Mixes

Select which device will be used for the output (Studio hardware products such as the HD550 have the
DeckLink Mini Monitor pre-installed).
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If you are using a Livestream HD hardware product (HD31, HD51, HD550), make sure your
Project Format is notin Streaming Optimized mode. The DeckLink Mini Monitor cannot

output when using those project formats.

DeckiLink Mini Monitor

Next, select which source will be output through each device. You can output your Program feed or any
other input source (e.g.,, CAM1).

yram (Dt

Program (Dity)
Program (Clean)

CAM1

CAM2

CAM3

When you have finished setting your output(s), click Save. You will now see the selected source(s) being
sent to your monitor, projection system, etc.
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Configuring Auxiliary Outputs

Livestream Studio gives you the ability to choose up to four auxiliary output mixes. This can be
helpful for changing picture-in-picture and output sources (monitors, projectors, etc.).

Navigate to settings, and enter the Outputs menu. Under Number of AUX Mixes, select how many
auxiliary outputs you want to use.

Settings: Outputs

Project Format

Outputs
Inputs

Number of AUX Mies
Outputs
Audio In
Recording

Media Player

Streaming

You can set any output to use an auxiliary source, which is helpful if you intend to change the sources
shown to your onsite viewers.
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Settings: Outputs

Project Format

Outputs
Inputs

Humber of AUX Mixes
Outputs
Audio In

Device
Recerding DeckLink Mini Monitor - SDI
Media Player
Streaming
Web Control

RTMP Server

Dropbox

CANCEL

Program (Dirty )

Program (Dirty)
Proaram (Clean)
AUX 1

AUX 2

AUX 3

LA

CAM2

CAM3

CAaM4

CAMS

When you set your auxiliary outputs, you should see an AUX tab appear in the lower left section. Each

auxiliary output includes all camera inputs, media bins, remote cameras, RTMP inputs, and NDI inputs.

INPUTS

ALUDID

Liva Intarviaw

r

Live Interview

Madia 2

Live Interview

Madia 2 Calar 1

MEDIA 1 MEDIA 2

Deskitop 1

Wabeam 1

Deskiop 1

Wabcam 1 Deakiop 1
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To utilize this with your picture-in-picture graphics, go to a Graphics tab (e.g., GFX 1) and create a new
layer (Create Custom Graphic > New Layer).

STREAM GFX1

. Studio Granhics Store

Import Layer >

RSS ;N

Timer

LGSV over HTTP

New Layer

EREAI S Ua Wi SAr i

Click the Paintbrush button.

The GFX Designer will open. Click on the Video button to bring a video source into your graphics layer.
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Click on the drop-down menu to change any settings, including your video source. Note that AUX
SOuUrces are Now among your options.

When you have finished setting your video source in the graphics layer, close out of the GFX Designer

Navigate to the AUX Outputs tab of the AUX source you are using. Here you can select which of your

and make sure that layer is visible.

inputs you want to see in the AUX output. You can choose from camera inputs, media sources, remote
cameras, and NDI sources.
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Push the graphics channel to Program to allow you and your viewers to see it.

To change the source in your graphics overlay, go back to the AUX Outputs tab and click on the desired
source. That source will turn green, indicating that it is ready to be transitioned into the AUX output.

To switch sources, use either the Cut or Auto button to the left.
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¥ If you click on the transition type under Auto, you can choose both the type and speed of the
auto transition used for each AUX source.

Fade

Transition Duration

45 Framiss

Ressl Trangilicn Sattings

Click a transition control; the AUX tab will indicate that the new source is being pushed through that
auxiliary source by highlighting that source in red.

You will also see the change in your graphics overlay in Preview and Program.
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Set up High-Resolution & ISO Recordings
IN Livestream Studio

In Livestream Studio, click the gearwheel icon in the upper right-hand corner to access settings, then
select the Recording tab.

%

Are you looking to record a smaller-sized MP4 file of your program? Try the Stream to File
option instead.

Settings: Recording

cance. [NSAVEY

Default Record Location 8

Mote about 150 Recording:

This Livestream Studio license is limited to 4 simultancous
recordings. Enabling multiple IS0 recording requires high
performance hard drive. See our recommended options for
internal and external drives.

150 Recording W

Timecode

Record to Media Bin -~ B8 Weda 1

Default Record Location: Selects the location where the Livestream Studio recordings will be saved by

default--typically the "Videos" folder in Windows and the "Movies" folder in Mac. Click the Browse button
to select a different default record location.
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Settings: Recording CANCEL | SAVE

Default Record Location

Recordmng

ISO Recording: ISO is an abbreviation for "Isolated”. When referring to cameras in video production, this
term indicates that the individual camera video signals are being isolated and recorded independently of
each other and the final Program mix. These files can be used later for further editing offline or live
replay during or after an event.

ISO recordings are only available via this hi-resolution recording setting. Selecting Stream to
File in the Stream tab will not record ISOs.

Select how many hi-resolution recordings you want to produce (up to four), and which sources you
want to record. You can record Program (dirty), Program (clean), and any other source in your multi-
view. We have more recommendations regarding ISO recordings.

Along with the single cameras, you can also record the Program output in ‘Clean’ or ‘Dirty’ mode.

o Clean: Without graphic overlays
« Dirty:  With graphic overlays

By default, the selected option is Program (dirty).

Specify Record Location: As a best practice, choose different locations for each ISO recording. This can
help resolve any hard drive performance related issues when recording multiple 1SOs by spreading to
multiple HDDs.
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Recording

IS0 Recording

Timecode: You can select how you want timecode to be presented. This is meant for users who intend

on editing the recordings together and have a preference on which type of timecode to use when
matching up the sources.

Timecode

Recording Bitrate: Chooses the quality your recording will be in. Higher bitrates will be higher quality, but
also produce much larger files.

th'nrrlmq Batrate s (Mbps

25 (Mbps)
50 (Mbps)
75 (Mbps)
100 (Mbps)
120 (Mbps)

Record to Media Bin
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Record to Media Bin: When a recording begins, it will immediately be added to the selected media bin.
Both bins can be selected or deselected simultaneously. This is necessary in order to use the basic
replay feature.

Record to Media Bin B Media 1

Media 2

Click Save and you will be able to start recording.

Available recording time is dictated by available internal disk space. If necessary, external devices with
transfer speeds of at least 50MB/sec may be used for recording, though performance may vary. Make
sure your external device is connected and choose save to that location in the Recording settings.
Studio also lets you know how much space is remaining on your hard drive.

livestream

When you are ready to start recording, click Record in the upper right corner.

liuegtrearﬂ STREAM RECORD

© PREVIEW

l .
1
]

The Record button will turn red and change to Recording. You can also track your recording time and
hard drive space.
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livestrearn  STREAM

© PREVIEW

When you are ready to stop recording, press the Recording button at the top of the interface. All
recorded files will be located where you specified in the Recording settings.

Videos library

RN

a4 "

W10 180017 Adidtienal olips Lamiphe Videod Toanicodhing CAM S -
101 14.00.08 030147
14.09.08
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ISO Recording Best Practices

Below is information regarding internal and external hard drive recommendations for producers
who want to do multiple, simultaneous ISO recordings.

For owners of our series of Studio HD hardware units:

The HDD or SSD currently installed on your system have the following specs:

o HD31*:  2TB WD BLACK SERIES WD2003FZEX 7200 RPM / SATA 2.5" Internal HDD

» Studio One: 1 TB Western Digital Red 7200 RPM/ SATA 2.5" Internal HDD

« HD50*:  1TB /5400 RPM /SATA 3.5" Internal HDD

« HD51: 1TB/ Western Digital Red 7200 RPM / SATA 2.5" Internal HDD

e HD51 4K Edition: Samsung 850 EVO 2TB SSD

« HD500*: 500 GB/ 5400 RPM / SATA 2.5" Internal HDD

« HD510* 1TB/ Western Digital Red 7200 RPM / SATA 2.5" Internal Hard Drive

« HD550: 1TB/ Western Digital Red 7200 RPM/ SATA 2.5" Internal Hard Drive

« HD550 4K Edition: Samsung 850 EVO 2TB SSD

« HD900*: 2 TB /5400 RPM & 500 GB /5400 RPM SATA 2.5" Internal HDDs

« HD1700*: 2 TB /5400 RPM & 500 GB / 5400 RPM SATA 2.5" Internal HDDs

« HD1710*: Dual quick-time front removable (2) x WD Red 1TB / 7200 RM ISO recording drives, mid-
plane, access door, receiver mounting kits. 1 internal fix mounted WD Red 1TB / 7200 RM ISO hard
drive & 1 internal fix mounted 120GB SSD OS / application drive.

*indicates a discontinued product

Check out the full product technical specifications.
To avoid performance issues, we recommend using an external HDD via USB 3.0 as mentioned below

and/or spreading the recording across multiple drives by selecting the Specify Record Location option
within the Recording section of the Livestream Studio settings.
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IS0 Recording

What type of hard drive is recommended when recording
1ISOs?

We recommend recording to a separate HDD, either installed on the desktop system or an external
HDD connected via USB 3.0, that adheres to the following specification:

7200 RPM

64 MB Cache

Formatted NTFS (Full format)

2TB or larger (for longer broadcasts)

The Western Digital Red series hard drives have been tested and approved for recording 4 isolated

cameras. You can pair this with a USB 3.0 HDD enclosure such as this one from Macally.

Testing done using other brand hard drives with the recommended specification have
resulted in poor performance when recording 3-4 ISO cameras. Recording 2 ISO cameras

performed well in these cases

If a Western Digital Red series drive is not available, using more than one HDD and specifying different

record locations may help resolve any performance issues.
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Recording Options in Livestream Studio

Livestream Studio includes various ways to record your Program and ISO recordings. Recordings
are saved in a user-selected destination folder; by default, you can find the files in the Videos folder
on Windows and the Movies folder on Mac.

Encode Program as an MP4 File

If you are just looking to record an .mp4 of your event, you can do this via the Stream tab. Select Stream
to File as your destination.

Media 1 Transitions

Set Up Your Stream

Select a provider below to configure stream settings

Choose the quality you wish to encode at and choose where you want to save the recording (by default
it will save to the Videos folder on Windows or the Movies folder on macQOS). You can also add a title,
which the file will save as alongside the date in your hard drive.

When you are ready to start encoding, click Go Live.
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Media 1 Transitions

» Strear Lo File

Fila Location

BROWSE

The Studio Log will indicate the encoding has started. When you are ready to stop recording, click the
red Streaming button in the bottom right corner of the Stream module.

Your recording will be saved in the location you specified.

Siream X Media 1 Transitions

Recording

All providers

Metwork Dashboard

G

30,76 FPS 179.00 kbps
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Hi-Resolution (MJPEG AVI) Program and ISO Recording

If you are looking for a broadcast quality high-resolution Motion JPEG recording of either your Program
output or any of your isolated (ISO) video sources, navigate to Studio settings by clicking the gearwheel

button in the upper right corner of the interface.

74.52 PM

Navigate to the Recording tab on the left side of the menu. The default recording location is where your
recordings will be saved (by default, "Videos” for Windows computers and "Movies” for macOS). Click
Browse if you want all of your recordings to save somewhere else, such as an external hard drive.

The Default file format of your recording will be MJPEG by default. H.264 is covered in a section below.

Settings: Recording CANCEL = SAVE

Project Format

Default Record Location BROWSE

nputs

Default file format MJPEG

Audio In Mote about IS0 Recording:

This Livestream Studio license is limited to 4 simultaneous
recordings. Enabling multiple 150 recording requires high

Recording perfarmance hard drive. See our recommended options for internal
and external drives.

Media Player
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Farther down in the menu are your ISO Recording options. With MIPEG selected as the default file
format, you can run up to four recordings simultaneously. This is helpful if you wish to edit your sources
together in post-production or you intend to use the basic replay feature.

ISO Recording v

Program

Program
Program (clean)
WEBCAM 1
GFX1

MEDIA1
COLOR1
REMOTE

Each checkbox will activate a recording. Select which sources you wish to record.

Program (clean) is your Program recording without any graphics overlays. Choose this if, for
example, you need to repurpose your recording for different brands.

Below each source selection is the option to Specify Record Location. This allows you to save any of
your recordings in a location separate from the Default Record Location configured above.
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IS0 Recording v

Pragram

Specify Record Location

v WEBCAM 1

& Specify Record Location

BROWSE

Below your ISO recordings specifications are additional settings for your recordings, include how
timecode is recorded, your recording bitrate, and the ability to also save your recordings in either Media
bin. Record to Media Bin is essential if you intend to use the basic replay feature.

Timecode Relative to Start

® Time of the Day (Clock)

Recording Bitrate

Record to Media Bin & Media 1

Media 2

Once your recordings are configured, save your settings. To start recording, click Record in the upper
left corner of the Studio interface; click it again to stop recording. You can find your AVl in the specified
recording location(s).
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livestrearn GO LIVE RECORD @ G

© PREVIEW

Compressed (H.264 MP4) Program or ISO Recording

If you are operating on a system that supports hardware encoding, you can also record an .mp4 file of
either your Program or a single video source. Click the gearwheel button in the upper right corner of the

Studio interface to enter the Settings menu.

f your system only has NVIDIA NVENC for hardware encoding, this feature will not work if
your project is set to interlaced formats (e.g. 1080i59.94, 1080i60). Unless your PC or Mac

also uses Intel QuickSync, change your project format to a progressive format (e.g. 1080p30,
/20p30) or to use this feature or switch the Recording settings to MJPEG file format

24:52 PM

Select the Recording tab on the left side of the menu. You can change the Default file format to H.264
to create a compressed recording that consumes less hard drive space than the MPJEG recording.
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Settings: Recording CANCEL

Project Format
Default Record Location BROWSE

Inputs

Default file format MJPEG

MJPEG
H.264

Audio In Note about 150 Recording:

Qutputs

If you do not see this option, navigate to Settings: Streaming and make sure Hardware encoding is
enabled. If you do not see an option for Hardware encoding, then your system does not have the proper

hardware installed to support it.

Settings: Streaming

Project Format
Hardware encoding &* Enabled

Inputs
Antilag

Outputs

Audio In Antilag Duration 5000

Recording

Key Frame Interval seconds

Media Playe
nedia e Encoder Queue 5Stop streaming wh

Streaming 300 frames

This setting only allows you to create one ISO recording, as opposed to four hi-resolution recordings.

Choose which source you would like to record.
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Settings: Recording

Format

Default Record Location
Inputs
Default file format

Outputs

180 Recording

Recording
Media Player Timecode
Streaming

Recording Bitrate

Web Contro

Record to Media Bin

CANCEL

BROWSE

Program
Program (clean)
WEBCAM 1
GFX1

MEDIA1
COLORA1
REMOTE1

& Time of the Ds

& Media 1

Media 2

SAVE

You can specify a record location that is different from the default setting by checking Specify Recording

Location. In addition, you can configure which timecode your prefer, recording bitrate, and whether to

also record your source into the Media Bin (essential if you plan to use the Basic Replay function).
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Settings: Recording CANCEL | SAVE

Project Format

Default Record Location BROWSE

Default file format

1SO Recording

Recording Specify Record Location

Media Playe Timecode Relative to Start

Streaming ® Time of the Day (Clock)
Recording Bitrate

Record to Media Bin (¢ Madia 1

Media 2

Save your settings. When you are ready to start recording, click Record in the upper left corner of the

Studio interface. You can find the .mp4 file in your specified record location.

livestrearmn GO LIVE RECORD <

© PREVIEW

Backup Recording of a Live Broadcast

When you stream to any provider, Studio will by default save a backup .mp4 recording of your Program
to your hard drive. You can change these settings by clicking on the gearwheel button in the upper right

corner of the Studio interface.
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24.52 PM

Navigate to the Streaming tab. Towards the bottom, you will see settings for Local MP4 Recording and
MP4 Recording Location.

Settings: Streaming CANCEL | SAVE

Project Format
Hardware encoding W Enabled
Antilag @ On

off

Antilag Duration

ding
Key Frame Interval 2 seconds

Media Player
s Ao Encoder Queue Stop streaming when gueue is

Streaming 300 frames

b C Bitrate (@ Variable

Constant
RTMP

Local MP4 Recording Disablad

Dropbox All Qualities

® Highest Quality Only

Ad Insertion

MP4 Recording Location BROWSE
Hotkeys

Streaming Mode

Closed Captions Enabled

We recommend leaving Highest Quality Only selected, as this will record only the file of the highest
selected bitrate when you configure your stream. If you choose All Qualities and select a multi-bitrate
streaming quality, your system will record separate files of each quality, which can tax your CPU.

Unless you are also recording separately using the methods described above, we do not recommend
disabling the local recording.
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By default, the MP4 Recording Location will be either the Videos folders on Windows or the Movies
folder on macOS. You can click Browse to choose a different location, such as an external hard drive.

Be sure to save your settings.
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Choose a Streaming Quality in Livestream
Studio

Livestream Studio has more flexibility and streaming bitrate options than ever before. These include
the ability to stream in 1080p, 4k, and custom bitrates

In order to see the highest quality options, you must have hardware encoding enabled on your Studio
system by going to your Settings > Streaming.

This means your computer must have either an Intel Processor or NVIDIA card installed that supports
this feature. Computers that do not have these will not see the hardware encoding option and have a
more limited selection of streaming bitrates available to them.

Settings: Streaming CANCEL | SAVE

Hardware encoding ¥ Enabled

After saving your settings, navigate to the Stream tab in the lower portion of Studio.

After configuring your streaming providers, open the Stream Quality dropdown menu in the upper right
corner of the Stream module; the lower qualities will be listed first with higher, multi-bitrate qualities
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populating below. Each quality lists the resolution(s) being pushed out with the average total bitrate in
parenthesis.

360p (678 kbps) ~

428 kbps)

T20p + 480p + 360p + 240p (
T20p+ + 360p + 240p (4734 kbps)
720p+ + 540p + 240p (4952 kbps)
T20p+ + 480p + 360p +

+ 480p + 360p

p + 720p + 480p + 240p (8312 kbps)

Selecting Custom allows you to configure your own bitrate in case none of the presets suit your needs.
Click the corresponding gearwheel to open up the bitrate settings.

*The ability to use custom bitrates is available regardless if you have hardware encoding or not.
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Custo...

Choose a name for this particular quality (e.g. High), set the width, height, video bitrate, audio bitrate,
audio sample rate, and encoding profile. Once you have configured the settings, click Done.

Edit Quality CANCEL "o

OPEN FMLE XML
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Edit Quality CANCEL "o

Audio Bitrate

128

Audio Sample Rate

44100

H.264 Encoding Profile
Baseline
& Main

High

You can add up to four custom bitrates by clicking Add Quality. Each quality can be edited individually by

clicking the corresponding gearwheels.

Cusio...

You can remove a quality by going into its Edit Quality menu and selecting Delete Quality.
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Edit Quality DONE

What's the Best Quality for Me?

There are two factors to consider when choosing a streaming quality: Network Upload Speed and CPU.

Upload speed is easier to determine, especially if you are connected to a dedicated network via
Ethernet. Go to www.speedtest.net and start a speedtest. Pay attention to your upload speed results.

If you perform a speed test on a shared network, the results will display the upload and download
speeds available for the total network, not just your device, so the numbers will be less accurate. It's best
to remove other computers and devices from your network.

Our rule of thumb is to choose a quality whose total bitrate is half of your upload speed. This allows
room for network fluctuation. For example, if your upload speed is about 10Mbps, which equals about
10,000Kbps, then you can safely assume your network can push out 720p + 480p + 360 + 240p
(4862Kbps) and lower.

When choosing your hardware, be sure to review our recommended hardware specifications, which

includes expected performance benchmarks for different types of processors.
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Streaming to Vimeo via Livestream Studio

Livestream Studio supports streaming to Vimeo Live for all Vimeo Premium members.

If you are not logged in already, go to the Stream tab and select Vimeo.

Transitons

Set Up Your Stream

Select a provider below to configure stream settings

vimeo A I f =l WP

Z O O m=m [

The following window will pop up. Click Sign in to Vimeo.

A browser window will open; you may need to minimize Studio in order to see it. Studio will
automatically log into the account that your default browser is logged into. If you are not logged into a
Vimeo account, you will be prompted to.
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https://vimeo.com/features/livestreaming

Log in to Vimeo

Forgot your password?

or

[l Log in with Facebook

G Log in with Google

Don't have an account?

Once you are logged in, you can configure your stream. At the top of the module, give your stream a

title and select your streaming quality on the right side.

¥ Since Vimeo Live includes cloud transcoding, we recommend selecting a single bitrate

quality.

Media 1 Transitions

»  Vimeo

In the top right corner is a gearwheel icon. Selecting this will allow you to set your aspect ratio and
choose your default network to use for streaming. The default network will be used when streaming to
any provider you add to Studio unless you specify a different device for a specific provider (shown in a

later step).
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Media 1 Transitions

Aszpect Ratio

" 16:9 47 ] Custom

Select default network

Next, choose your stream goes under the Select Event menu. You can either create a new event by
selecting New Event or stream to a pre-created event. Learn more about streaming to a scheduled event
on Vimeo via Studio.

Media 1 Transitions

»  Vimeo

Select Event

Damo

Shara With

Anyone

If you have enabled multi-language events, you can choose which incoming language (or audio track)

will output to this particular stream by using the Select Language drop-down menu; if you are
simulcasting, this allows you to stream to the same provider but select a different language for each
stream instance. This menu does not appear if multi-language events are not enabled.
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Select Event

Game 1 (Spanish)

Share With

Anyone

Select Language

Spanish

Clicking Advanced Settings will give you the option to use a specific network device to stream to Vimeo;
Use default network will use the network device you selected earlier, but you may override that setting
here if you wish to use a different connection for Vimeo. This can be handy if you want to keep
simultaneous streams on separate networks as a failsafe.

Click Hide Advanced Settings to collapse this menu.

Share With

Anyone

Specify Network
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When you are ready to start your stream, click Go Live in the bottom right corner,

Transaitions

#  Vimeo

Sefect Event

Create new

Shars With

Anyone

Specify Metwork

v

Your Program output will appear in your chosen event on Vimeo.

-
m Manage videos ~  Walch+~  On Damand =

¥ For easy access to your stream, hover your cursor over the Vimeo icon; the URL to your

stream will appear there
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" \Vimeo

Perfect Streaming

30.00 FPS T768.02 kbps

Create new

Perfect Streaming

30.00 FPS T68.02 kbps

When your event is over, end the stream by clicking the red Streaming button in the lower right corner.

To log out of Vimeo, click your profile name below the stream title and click Log Out.

Log Out

Select Event

Create new
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Stream to a Scheduled Event on Vimeo via
Studio

In order to stream to a scheduled event on Vimeo from Studio, you need to follow the steps below
in order for the event to appear as an option in Studio.

First, in a browser, go to your Vimeo account and create a live event. Vimeo allows you to create either a
one-time event (only go live once) or a recurring event (which you can go live to repeatedly).

€@ You must have a Vimeo Premium membership in order to go live to Vimeo.

.
m Manage videos~ Watch~ On Demand ~

ome

Create live event

lﬁl Home

Recent videos
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Create live event *

Event title

‘ My Event ‘

Start date (optional) Time

Privacy

Anyone can see this event w ‘

After setting the title, time, and audience, you will be brought to the event setup page and your event is
available to select from in Studio. There is no need to click the "Next" button on this page, especially if
your event is more than 60 minutes away.
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Onsite Embed Social

Link

®» Chat ©®

Set privacy

Description (optional)

Launch Livestream Studio and navigate to the Stream tab. Select Vimeo and log into your Vimeo
account.

Media 1 Media 2 Tra...ons

Set Up Your Stream

Select a provider below to configure stream se

| f
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Under the Stream tab, open the Select Event menu. Your event should be listed here. The rest of
configuring your stream is the same as streaming to a new event.

When you are ready to start your stream, click Go Live in the bottom right corner.

Media 1 Madia 2 Tra...ons

¥ \imeo

Salect Evant

Gama 1

Share With

Anyona
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Streaming to Livestream with Livestream
Studio

Select the Stream tab in Livestream Studio. Here you will see a few providers to choose from. Select

Livestream.

Madia 1

Set Up Your Stream

Select a provider below to configure stream settings

'l A 1

Zz 0

Log in to your Livestream account.
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Log in to Livestream

At the top of the module is a text field labeled Enter a title for your stream... Type a stream title in here.

Choose an event from the Event Name drop-down menu (or click + New Event to create a new event).

By default, your Livestream followers will receive a notification when you go live. If you do not want to
send out a notification, uncheck Notify Followers.
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& Livestream

Event Name

Test Event

& Motify Followers

If you have enabled multi-language events, you can choose which incoming language (or audio track)
will output to this particular stream by using the Select Language drop-down menu; if you are

simulcasting, this allows you to stream to the same provider but select a different language for each
stream instance. This menu does not appear if multi-language events are not enabled.

Select Event
Game 1 (Spanish)

Shara With

Anyone

Select Language

Spanish

Click Advanced Settings if you want to send the stream over a bonded connection, send it as a backup

stream, or specify which network(s) to use for your stream.

299


https://help.livestream.com/hc/en-us/articles/360028025212-Multi-Language-Audio
https://help.livestream.com/hc/en-us/articles/360002053828-Stream-to-Multiple-Providers-Using-Livestream-Studio
https://help.livestream.com/hc/en-us/articles/212060188-Using-a-Bonded-Network-to-Stream
https://help.livestream.com/hc/en-us/articles/216571197-Create-a-Backup-Stream
https://help.livestream.com/hc/en-us/articles/216571197-Create-a-Backup-Stream

& Motify Followers

Iise Bonding Backup Stream

Specify Network

[went Name

Press the red Streaming button to end the stream. When a stream is terminated, the user will be
prompted to post the video-on-demand (VOD) to the event, save the clip as a draft on the event page,
or delete the cloud recording.
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Iransibons

Media 2

Stream Ended @ DONE

Oh Om 55s

Actions:

Emily Knoax

Save & Post

To change the Livestream account you stream to, click on your account name inside the Stream
module. From here, you can either open a browser to your Livestream Account Settings or Log Out of
your account in Studio.
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Gama 1

# Livestream

Ewent Name
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Streaming to Facebook Live via Livestream
Studio

You have the option to stream directly to your Facebook Profiles and Pages of which you are an
admin.

@ This article covers going live to Facebook via Livestream Studio. If you are trying to stream to
Facebook via the Livestream Platform Simulcast feature, see here.

Log in to Facebook.

Navigate to the Stream tab in the lower right corner of Studio, then select Facebook.

Set Up Your Stream

Seledt a provider below to configure stream settings

A 11 A\ f [ e | WP

Z O Q mm [

Click Sign in to Facebook. A browser window will open.
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f Facebook

Sign in to Facebook

Enter your Facebook credentials, and select whether you wish to stay persistently logged into Livestream
Studio. Then click Log In.

Log into Facebook

Keep me logged in to Livestream Studio

Livestream Studio will request several permissions, including your friend lists, events, ability to post, and
access to pages you manage. Be sure to allow these and continue.
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Q We recommend setting your default audience settings to Public, especially if you ever intend

to stream to an audience beyond your friends list. You can restrict your audience for each
broadcast within Livestream Studio before you go live.

7

Livestream Studio would like to post publicly to Facebook for you.
Who should be able to see these posts?

& Public

Click OK to finish permission settings.

Livestream Studio would like to manage your Pages, publish as
Pages you manage, show a list of the Pages you manage and access
the groups you manage.

[# Choose what you allow
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When authorization is complete, you can close your browser window if it does not close automatically.

Configure Facebook Settings

Across the top of the Stream module are a handful of add-ons for your stream, including the abilities to
tag your (1) location and (2) friends. You can also log out of your Facebook account, click the URL to
open the page where your stream will be hosted, or remove Facebook as a streaming destination.

GFX1 FX 2
Game 1 @ @

Medsa 1

» Facebook

Q You can also access these options by hovering your cursor over the Facebook icon at the
bottom of the module.

Aspect Ratio
& 159 4:3 1: Custom

» Facebook
Network

Emily Knox

Below these options are basic stream configuration settings.
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Post As

Emily Knox

Share With

Public

Continuous live @

f

1. Inthe Post As dropdown, you can choose between your personal profile, any pages you admin, or
any groups you admin.

2. Share with lets you choose which audience you would like to share your stream with.
Check Continuous Live if you wish to keep streaming beyond Facebook's eight-hour streaming limit
(note that this will not send out additional notifications or save any VOD from your stream onto

Facebook).

If you have enabled multi-language events, you can choose which incoming language (or audio track)
will output to this particular stream by using the Select Language drop-down menu; if you are
simulcasting, this allows you to stream to the same provider but select a different language for each
stream instance. This menu does not appear if multi-language events are not enabled.
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Select Event

Game 1 (Spanish)

Share With

Anyone

Select Language

Spanish

Below these basic configurations, click Advanced Settings to set a variety of options for customizing

your live video post on Facebook, such as adding tags for other pages on Facebook, and audience
targeting tools.

You can also provide other metadata for your stream, such as targeted countries and what language the
broadcast will be in.

At the bottom of this section, you can select which network to stream over, if you have multiple
available.
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Video Tags

Audience Targeting

13

Gender

All

Locations

Languages

Go Live to Facebook

At the top of the module, give your stream a name and select a streaming quality. For optimum
performance on Facebook, select a single bitrate (e.g. 720p+) rather than a multi-bitrate quality (e.g.
720p + 540p + 240p).

Media 1 Media 2

Game l|

Clicking the gearwheel allows you to select your preferred aspect ratio. Choosing 1:1 or 9:16 will display
a yellow Safe Area Display in Program and Preview demonstrating what your stream's output will look
like so you can set your shots accordingly. You also have the option to see the display is all multiview
sources, or to turn it off entirely.

Here, you can also choose your default streaming network. Unless you specified a different network in
the Advanced Settings section, your stream will broadcast over this network.
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Aspact Ratio

Select default nobwerk

Click Go Live to start your stream.

Transitions

& Facebook

Emily Knx

Share With

P

Comtinuous live

Once you are live, you can view your stream by hovering the mouse over the Facebook logo and
clicking the URL in the menu that pops up.
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~ Facebook

reaming

691.34 kbps 0 Viewers

Ernity Knox

Perfect Streamin

29.88 FPS  ©691.34 kbps 0 Viewers

The stream will appear in your Facebook timeline after about 10 seconds.

w--r.-ﬂl: & Oniy Me -
Heckey Game

When you want to end your stream, click the red Streaming button.
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Transitions

S 1.9% Mbps 0 Viewners

The broadcast will end promptly and the stream will save on your Facebook timeline for on-demand
playback.
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Stream to a Scheduled Live Post on
Facebook via Livestream Studio

While you can go live to your Facebook pages and groups at any time, many publishers on
Facebook prefer to use Facebook's Scheduling feature so that their followers have prior notice and
are more likely to watch their live event.

Schedule a Live Video on Facebook

In order to stream from Studio to a scheduled live video on Facebook, you will first need to create the
scheduled post on Facebook.

Facebook provides a comprehensive tutorial and best practices to scheduling a live video on Facebook.
A broader live overview for Publishers on Facebook is also available.

Once your live video is scheduled, you can configure Studio to stream to it.

Go Live to Your Scheduled Live Post

In Livestream Studio, navigate to the Stream tab, select Facebook and log in to the same account. Select
your Page under Post As, and then open the Stream To drop-down menu. Your scheduled live video
post will appear there.
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Test page for streaming

Stream To

Page

Page
Test page for streaming / Game 1/ Scheduled

Select that scheduled post. Configure the rest of your stream is the same as all streams to Facebook.

When you are ready to start broadcasting, click Go Live in the bottom right corner.

Siream Media 1 Media 2 Transitions
Game 1

» Facebook

Continuous live

When you edit your scheduled post on Facebook, you can see your stream come in and monitor it.
However it will not appear live on your timeline until the time you scheduled your post to go live.

If you want to go live sooner, click the Manual Start button at the bottom of the post editor in Facebook.
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Post Settings

Game 1

Title
Add a title for your live broadcast (optional)

Tags O

Add tags (ex: comedy, animals, make-up etc.)

Video Game @

Tag 2 game (ex: PUBG)

@ Edit Schedule

> B Manual Start m

Once you confirm you want to proceed and Facebook fetches your stream preview, click Go Live. Your
stream will be live on your Facebook timeline.
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Test page for streaming is live now.
Published by Emily Knox [?] - Just now - & - @y

Game 1

Alternatively, wait until your scheduled start time; the stream will appear on the timeline automatically.

When your event is over, you can simply click the red Streaming button in Studio to end your live event
on Facebook.
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Stream to a Facebook Group via Livestream
Studio

In order to go live to a Facebook Group from Livestream Studio, you must first be an Admin and
install the Livestream Studio Facebook App to your Group. Once you have done so, you will be able
to choose your Group as a streaming destination within Studio.

First, make sure you are an Admin of your Group. Only Admins can adjust Group settings and go live to
Groups. Also, ensure that you are using Livestream Studio version 5.1.25 or later.

On your Group's Discussion page, open the More menu and select Edit Group Settings.

' Notifications Mﬂ@

Add Members

| live
Moderate Group
;ol Edit Group Settings I
Archive Group
Fin to Shortcuts L
=4 ¥ |

Link Existing Group
Create New Linked Group

Create New Graup
liccararcnanoe TRE aroue ori

Scroll down to the Apps section and select Add Apps.
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Locations This can help people find your group more easily if they're looking for groups in your area.

Add Locations

aApps Tools and features offered by other businesses that admins can use in a group. Learn More

I Add Apps

Linked Pages Give your business, brand or organization a voice on Facebook and connect with the right peop!

Link Your Page Create New Linked Page

Find the Livestream Studio app in the list and select it. Once you've added the app to your Group, be
sure to scroll to the bottom of the settings screen and click Save.

In the Livestream Studio software, navigate to the Stream tab and select Facebook. Configure your
stream as you normally would; your Facebook Group should appear as an option in the Post As menu.
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Stream to Twitter & Periscope via
Livestream Studio

Livestream Studio integrates with and streams directly to Periscope.
Navigate to the Stream tab and select Periscope as your streaming provider.

GFX 2 Media 1 Media 2

Set Up Your Stream

Select a provider below to configure stream settings

N f

Click Sign in to Periscope.
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Sign in to Periscope

This will open your web browser to Periscope’s login page. If your browser does not automatically come
to the front of your screen, you may need to manually switch over to it. Do not exit Studio.

This will not work if Microsoft Edge is your default browser. Set Google Chrome or Mozilla

Firefox as your Windows default browser in order to log in.

Log in to Periscope and authorize Studio to access your Periscope account. This is necessary in order
for the two applications to communicate to each other.

Once authorized, you can close your browser and go back to Studio.

In the Stream module, give your stream a title and select your quality.

@ /20pisthe streaming quality profile that is recommended by Periscope. 1080p and above are
not supported.
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Stream

Game Preview

¥ Periscope

Click the gearwheel on the upper right side to set your aspect ratio and your default network to stream
with.

When you have configured these settings, click the gearwheel again to collapse this menu.

Game Preview

Aspect Ratio

16:9 4:3

Select default network

Below the stream name is a small Twitter bird icon. By default, it is blue, indicating that the stream to
Periscope will also be tweeted to the Twitter account connected to your Periscope account. If you do
not want your stream on Twitter, click the bird icon to disable it.

Clicking the gearwheel in the popup menu will allow you to choose which of your available network
connections you will send your stream though (this example only has one).

321



Stream

Game Preview

& Periscope

Specify Network

If you have enabled multi-language events, you can choose which incoming language (or audio track)
will output to this particular stream by using the Select Language drop-down menu; if you are

simulcasting, this allows you to stream to the same provider but select a different language for each
stream instance. This menu does not appear if multi-language events are not enabled.

Share With
Anyoneg

Select Language

Spanish

Below this, you can specify a network to use if you wish to stream using a network different from your
default set network. This is handy if you intend to add other providers and wish to use different

connection types for each stream.

" Periscope

Specify Network
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When you are ready to start streaming, click Go Live in the bottom right corner.

Stream Media 1 Transitions

Game Preview

» Periscope

Spachy Nebeork

When your event is over, click the red Streaming button to end the stream.

When you stream ends, you can see information about your viewers and for how long you streamed.
Choose to either save your video on demand or delete it.
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Streaming to YouTlube via Livestream Studio

You can stream to your YouTube channel directly from Livestream Studio. There are two ways
YouTube supports streaming: either their "Stream Now" option or the Live Events Dashboard.

To get started, go to the Stream tab and select YouTube as a provider.

Transitions

Set Up Your Stream

Select a provider below to configure stream settings

You will need to log in using your YouTube/Google credentials and allow Livestream Studio to access
your account. This will open a new browser window; if your browser does not come to the front of your
screen, navigate away from Studio to see it and log in. Do not close Studio.

If you are using Google apps (i.e. an Google account that is not a standard @gmail.com
address), you may need to authorize access to third-party applications in your Google
account or via an admin.

Once you are logged in and authorize Studio access to your Google account, you can close the
browser and navigate back to Studio.
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Give your stream a title and choose a streaming quality. Since YouTube provides cloud transcoding, we
recommend selecting a single-bitrate quality.

Stream Madia 1

Game Preview

| YouTube

Clicking on the gearwheel will allow you set your aspect ratio and choose your default network. This is
the network that will be used to stream with by default for any provider in Studio.

Once you have configured these settings, you can click the gearwheel icon again to collapse the menu.

Stream Media 1

Game Preview

Aspect Ratio

- 16:9 4:3 Custom

Select default network

You can select which YouTube event you want to stream to in the Event Name drop-down menu.
Selecting Stream Now will simply start a new stream to your channel rather than broadcasting to a
previously created event. The URL to your stream will be available below the menu.
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Game Preview

» YouTube

Ewvent Nama

Stream now

If you have enabled multi-language events, you can choose which incoming language (or audio track)
will output to this particular stream by using the Select Language drop-down menu; if you are

simulcasting, this allows you to stream to the same provider but select a different language for each
stream instance. This menu does not appear if multi-language events are not enabled.

Share With

Anyoneg

Select Language

Spanish

Clicking Advanced Settings will allow you to choose a different network rather than your default network
to stream with. This is handy if you intend to add other providers to Studio and wish to keep them on
different network devices. When you specify YouTube's network, you can click Hide Advanced Settings

to collapse the menu.
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Event Name

Stream now

Specify Network

When you are ready to start streaming, click Go Live in the lower right corner.

Straam GFX 3 Media 1 Madia 2 Transitions
Game Praview
¥ YouTube

Event Nams

Stream now

When your event is over, click the red Streaming button to end the stream. If you need to log out of
YouTube, click your name below the stream title, then click Log Out.

327



328

Game Preview

" YouTube

Log Out

Event Namea

Stream now
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Stream via RTMP. RTMPS, Zixi, and UDP
from Livestream Studio

You can stream directly from the Livestream Studio software to other services (e.g. Wowza,
Akamai, etc.) using other common protocols such as RTMP/RTMPS, Zixi, and UDP. All these options
have very similar interfaces.

Under the Stream tab, click the streaming protocol you plan to use (RTMP, Zixi, or UDP; select RTMP if
streaming via RTMPS).

TRANSITIONS

Set Up Your 5tream

Select a provider below fo configure stream settings

.l t

o ¢

At the top of the module, configure a stream title and streaming quality.

Media 1

Click the gearwheel to adjust your aspect ratio or choose a default network for sending your stream.
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Game 1

Aspect Ratio

Select default network

The URL (and Stream Key, if using RTMP) comes from your streaming provider, which allows Studio to
know where to send the stream. Paste the appropriate URL into the URL field.

M RTMP

Stream URL

Some RTMP streaming providers only give a single Stream URL with the stream key included, while
others provide the stream URL and stream key separately. If your provider does the latter, click switch
your view to see two text fields: Stream URL and Stream Key

¥ RTMP

Stream URL

Stream Key
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If you've enabled multi-language events, you will see a Select Language dropdown menu in the RTMP

panel, allowing you to choose which language will output in this stream instance.

Clicking Advanced Settings will show additional options. For RTMP you will see the option to import the
configuration XML file (Import From FMLE), enable authorization, and choose which network to stream

over if you do not wish to use your default network.

IMPORT FROM FMLE

Authorization

Specify Network

Zixi users will see the option to enter a Zixi password, as well as the option to use a bonded connection
or specify a network under their Advanced Settings. Checking Use Bonding will automatically use all

available networks to which your Studio PC is connected.

Password

|lse Bonding

Specify Network

Both Zixi and UDP provide the Video packet identifier (PID) and Audio PID, which a _.stream or SMIL file
would need to recognize your stream. This is particularly helpful when streaming to a player that can

recognize multiple audio tracks for the same video.
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GFX 1

UDP URL

Video PID

Audio PID

When your settings are configured, click Go Live to start streaming to your destination.

Transitioms

Stream LIRL

Stream Key

Studio will start streaming your content to your destination and display information such as outgoing
frame rate and bitrate. Any potential issues will display in the log on the right side.

When your event is over, click the red Streaming button to end your stream.
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Ma=dia 1 Madia 7
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Streaming to IBM Video (Ustream)

In order to stream to IBM Video (formerly known as Ustream) via Livestream Studio, producers must use
the RTMP section of the Stream module.

Instructions on how to obtain the RTMP URL for your channel can be found here.
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Streaming to Twitch via Livestream Studio

Livestream Studio offers direct integration with Twitch for producers who wish to stream their
content there.

In the Stream module, click the Twitch logo to start configuring your stream settings.

Madia 1 I ransmions

Set Up Your Stream

Select a provider below to configure stream settimos

A 1| A\ f

Z O ¢

The pop-up window seen below will appear. Click Sign in to Twitch and navigate to your web browser if
it does not switch over automatically.

) Twitch

Log in to your Twitch account within the browser.
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twitch

Login  Sign Up

Username
Password

Trouble logging in?

Authorize Livestream Studio to access information from your Twitch account by clicking Authorize. After
doing so, navigate back to Studio if the browser does not close by default.

twitch

Authorize Livestream Studio to use your account?

2

not you?

o J o

Livestream Studio permissions:

Obtain your email address

View your channels emaidl address and
stream key

Update your channel's title, game
status. and olher maladala

Cut VODs
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Enter a title for your stream and set your streaming quality.

Media 1 Media 2

Click the gearwheel icon to set your desired output aspect ratio and the default network to use with
your stream. If you choose a 1:1 or 9:16 ratio, a Safe Area Display will appear in your output by default.
You can change this to show in all sources in your multiview or to not display at all.

Transmions

Set your game name, stream title on Twitch, ingestion location, and whether to save your VOD on
Twitch.
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Gamse Namea

Stream Title

Ice Hockey

Inpe & L

US Centrak Dallas, TX

& Don't archive broadcast

E|

If you have enabled multi-language events, you can choose which incoming language (or audio track)
will output to this particular stream by using the Select Language drop-down menu; if you are

simulcasting, this allows you to stream to the same provider but select a different language for each
stream instance. This menu does not appear if multi-language events are not enabled.

Share With

Anyong

Select Language

Spanish

Clicking Advanced Settings will allow you to specify a network to stream out at if you do not wish to use

your default network selected earlier.
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Specify Network

Click Go Live when you are ready to start broadcasting. Livestream Studio will indicate that the stream
has started and display your streaming status.

Media 1

When you are ready to finish streaming, click the red Streaming button.
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Media 1

Untitled Stream

Herbasnirk Dias hiboand

E.]

690.87 kbps 0\

Hover your mouse over the Twitch icon at the bottom of the module. You will find a link to your Twitch
channel.

& Twitch

L;_.J

20,99 FPS  670.54 kbps 0 Viewers

& Twitch
Network

Fa L‘ NNy

1D
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Stream to Multiple Providers Using
Livestream Studio

You have the option to stream to multiple providers at the same time using Livestream Studio.

Your video is only encoded once, so CPU demands for this feature are similar to those for streaming to
just one provider. However, bandwidth requirements will be higher. Multiple streams will use as much
bandwidth as the qualities selected for each provider.

Example: If 720p + 480p + 360p + 240p (4862Kbps) Stream Quiality is selected for Livestream and
‘Highest Quality’ is selected for Facebook (in this case, 720p), then the total outgoing bitrate will average
4862 + 2128 = 6990Kbps. We always recommend having twice the upload speed on your network as
the selected bitrate, which is about 14Mbps upload speed in this case.

¥ You can also utilize this feature to send multiple streams to the same provider with different
audio tracks (e.g. languages). Learn more.

Start by clicking one provider's logo to add it to Studio (this example will use Livestream).

Media 1 Transitions

Set Up Your Stream

Select a provider below to configure stream settings

\ | A1 t

r/4 >

Log in to the selected provider to configure your stream settings.
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livestream

Log in to Livestream

Configure your stream destination as you normally would (e.g. select your Livestream event).

& Livestream

Event Name

Now add a second provider by clicking the + button in the lower left corner of the Stream module.
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Event Name

Select a second provider (this example will show Facebook).

Media 1 Transitions

Set Up Your Stream

Select a provider below to configure stream settings

\ 1| A\ f

r/4 o

Log in to that provider; allow any permissions that the provider may request in order to use it with
Studio.
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f Facebook

Configure your stream’s destination for that provider, i.e. which profile is streaming, to which page or
group, and your desired audience.

Share With

Puldic

Lontinuous Inve

You can click Advanced Settings to configure further settings for that provider if you wish.
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Video Tags

Audience Tangeting

At the top of the overall Stream panel, your stream title, bitrate, and aspect ratio.

Media 1 Media 2

Aspect Rato

Sclect default metenork

If you need to change a setting for a particular provider, click the provider's icon at the bottom of the

panel. The selected provider will be a ligher shade of gray.
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& Livestream

Event Name

Click Go Live in the bottom right corner to start your stream.

Media 1 3 Transiticns
Game 1
B Livestream

vt Hamee

The Stream module in Studio will show the streaming status for each provider along the bottom of the
interface, as well as the overall outgoing bitrate in the middle of the panel.
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Wi 1 Meda 7 Transifions

Matwork Dasbboard

L 11 f

20000 FPS 278 Hbps 1 Vewe 30.01 APS  1.04 Mbps 0 Viewers

Open a web browser and go to your selected stream destinations. You will see the exact same live
content in each player.

livestrearm
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Game 1

7
T
U
11

Like Comment

You can deactivate a provider by hovering your mouse over its icon and unchecking the checkbox in the
upper left corner of the popup box. If this is done while you are streaming, that will stop the stream on
that provider only.

' Facebook

Perfect Streaming

4,27 Mbps 2 Viewers 29.98 FPS  2.07 Mbps 0 Viewers

You can reactivate that provider at any time (live or not live) by checking the checkbox.
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A\l

2 Viewers

When your event is over, click Streaming in the lower left corner to end the stream.

A

29.98 FPS .27 Mbps 2 Viewers F ] bps 0 Viewers

Studio will let you know that the stream has ended and display the maximum viewers your event had
and the stream duration.
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Stream Ended

Oh 11m

Actions:

Emily Knox

Certain providers may have actions for you to take after the broadcast. For example, Livestream will ask if
you want to post the video on demand, save it as a draft, or delete it (‘'Save draft’ is selected by default.)
Choose your desired option, then click Done.

Stream Ended

Oh 11m

Actions:

Emily Knoox

If you want to remove a provider from your workflow entirely, select its icon in the bottom of the
interface to open its settings, then click X delete in the upper right corner of the module. You can add it
back at any time.
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¥ Facebook

Contmucus Iree

A

It's important to note that Facebook will not stream alongside any other streaming provider besides
Livestream. Facebook will have to be disabled in Studio prior to streaming to YouTube, etc.

A Unable to Add YouTube

If you wish to stream to Livestream and Facebook but have limited bandwidth, you may want to look
into simulcasting via the Livestream platform or Vimeo.
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Studio Log and Streaming Information

Livestream Studio displays basic information about your stream as well as a log with various
warnings and notifications regarding your stream

When streaming is active, the stream module and streaming log on the right side provide live updates on

streaming status.

« FPS: Displays the current outgoing FPS.

» Mbps: Displays the current outgoing bitrate.

» Viewers: Displays the number of concurrent viewers watching the stream.

« Stream Status: Displays the current status of the stream (e.g. "Perfect Streaming’).
» Streaming Log: Displays live streaming updates.

Media 1 Madia 2 Transitions

MNetwork Dashboard

D000 2

5 1TT.55 kbps 1 Viewer

Common messages you may see in the streaming log are:

» Perfect Streaming: The stream is going out with no issues.

* Internet Too Slow for Quality: Upload bandwidth does not support selected quality. This is generally
an on-site IT issue and should be escalated to the IT department. Changing quality requires the
stream to be stopped and restarted.

» Lost Internet Connection: Internet connection has been lost. Again, check with onsite IT if this
happens.

« CPU Warning: CPU percentage is getting very high.
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» Problem publishing to primary server: Studio is unable to stream to the primary publishing point due
to local Internet connection issues or an issue with the publishing point.
« Antilag Feature Triggered: Antilag has been triggered based on the selected queue limit (see

Streaming Preferences above).
e Audio Peak Warning: Audio levels are peaking above normal levels.
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Advanced Streaming Settings in Livestream
Studio

Livestream Studio allows you to configure additional settings regarding your stream's output and
response to certain situations.

These settings can be found by clicking the gearwheel in the upper right corner of the Studio interface
and navigating to the Settings: Streaming menu.

Settings: Streaming cancer  [FEAVER

Antilag Duration

Key Frame Interval

Local MP4 Recording

Hardware encoding: This option only appears on PC's that have integrated graphics cards that support

video encoding. Learn more.

Antilag: Selecting ‘On’ for Antilag works to reduce latency on the viewing end. If a delay on the encoding
side builds up past the chosen Antilag Duration (below), the frame buffer will be cleared. Turning Antilag
off will continue to build a cache of frames without clearing the data, thus building latency to your
viewers. If low latency is a critical component of your stream, disabling Antilag is not recommended.
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Key Frame Interval: Places keyframes into the stream to track changes in movement. Two seconds is a
standard setting, but you may want to consider a more frequent interval if your event has a lot of

motion.

Encoder Queue: The number of frames that Livestream Studio will allow to build up prior to a stream
terminating due to bandwidth or CPU issues.

Bitrate: A 'Variable' bitrate will change the outgoing bitrate based on the movement in the video. Static
images will send at a lower bitrate; high movement will increase the bitrate. ‘Constant’ bitrate will
maintain the outgoing bitrate regardless of the amount of movement in the video.

Local MP4 Recording: Automatically records an .mp4 of your stream as a backup. It is strongly
recommended to keep this feature enabled. Selecting Highest Quality Only will record in only the
highest bitrate and resolution that you are outputting (e.qg. if your stream quality is 720p + 540p + 240p,
your backup file will record in 720p, whereas selecting All Qualities will produce three separate
recordings simultaneously, one for each quality).

MP4 Recording Location: Choose where the backup recording described above is saved. By default,
your recordings will save to the Videos folder on your system's C drive, but you may choose to save it
elsewhere, such as an external hard drive.

Streaming Mode: Allows you to choose the outgoing frame rate. The higher the rate you choose, the
more CPU usage will increase.

Closed Captioning: If you need to ingest closed captions over SDI, here is where you enable it. Learn
more about Studio’s closed captioning support.
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Can Livestream Studio Stream to Facebook
Workplace?

Facebook Workplace is not directly integrated with Livestream Studio. However, you can stream to your

Workplace community via RTMP.
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Graphic Overlays
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Adding Graphics Overlay Tracks

Livestream Studio gives you the option to use three graphics overlay channels, all of which can
include multiple layers of static or data-driven graphics.

By default, three graphics overlay tracks will be available and listed in the Inputs menu in the lower left
corner of the Studio interface. You will also see them in your multi-view.

STREAM OUT -

RECORD OUT " Studio Graphics Store

If you do not intend to use all three graphics overlay tracks, you can remove any of them by going to the
Inputs menu and selecting the trash icon to the right of each. This will remove that GFX input from the
multi-view and make it unavailable as an overlay.

MEDIA 1 MEDIA 2
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The first step in adding graphics overlays to the GFX channel is adding a layer. You can easily add a

Livestream pre-built graphics template such as a lower third by navigating the Studio Graphics Store seen
inside the graphics module.

To add your own custom graphic, select Create Custom Graphic in the bottom left corner of the
interface.

GFX1 1 Madia 1 Transitions

l Studio Graphics Store

Categories

Al &

Foatures

Full Scresn

Lower Third: Black | Red Gloss
Animated + ADD

$ CREATE CUSTOM GRAPHIC

Many options will pop up. To get started, select New Layer at the bottom of the list.
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Import Layer

Clock
Timer
CSV over HTTP

New Layer +

EREATED wUa 1YW SRAF N

The layer will appear on the left side of the module. Click either paintbrush button to enter the GFX
designer to build your graphic.

Tramsitions

No data fields in this layer

o= COLUMN [ # AUTO PUSHIPULL |

Simple Mode: To open the GFX Designer in Simple mode, double-click the graphics layer.

Clicking the +T button will add static text to your graphics layer.
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Click the attached gearwheel button for editing options (font, size, color, etc.)

your text her%..}

BORDER

301



The next button allows you to add either a static or dynamic image to your graphics layer.

A static image is any image file you can import, which will always be visible when that graphics layer is
also visible. The image will not change.

Supported image formats are .png, jpg, .jpeg, .bomp, xpm, tif, tiff

A dynamic image will change if the hosted file is also changed. In the designer, you choose the file
where it is located and its dimensions.
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The next option you can add is a video source. Clicking this will allow you to choose which video source

you want to include in your graphics channel, place it, size it, etc. Each layer can support up to five video

sources.

WVOLUKE
1E

& sHAaDOW

‘_:‘-n_-_;lgl'ue-l

W BORDER

"
= - Inside -
-

HD1920x1080 29.97(

0:00:05.305

CROP
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Next, you can add a webpage as a source in your graphics layer. This includes the ability to navigate the

page and change its appearance within Studio. Please note there is currently no option to bring in audio
from your browser source.

LR GFX 1 Designer

All your video needs

The highest quality, more control, unlimited inspiration, and everything else for your video.

The following button allows you to add text or image data fields. Here is where you set where assets will
be, their sizes, font colors, etc. The content of those fields is added in a later step.
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Farther to the right, the two arrow buttons are for Undo and Redo.

The next button will provide you with a box identifying the title safe (inner box) and action safe (outer
box) areas. This lets you know that your graphics will not be cut off the screen.
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The next three buttons allow you to change how the GFX Designer displays transparency. This has no
impact on the appearance of your graphics overlays.
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Right clicking on your content in the designer allows you to undo and redo actions, move content
between layers, copy, paste, etc.

Close out of the GFX Designer when you have finished building your graphics layer. If you hover your
mouse over your GFX layer, you will notice a name appear at the top-left of the image. Double-click the
text to rename this GFX layer.
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Stream

<+ CoLumMs

You can adjust other settings for that graphics layer by clicking the gear wheel button. The settings
shown will change based on the type of graphics overlay being used.

Most GFX layer settings will be related to your data fields. If you added a text or image field, a column for
each should have been created to the right, which you can rename.

368



vimeo - livestream

GFR1 GFX 2 Medua 1

Lower Third : Yello...

Aaio-Loop

START AU

Auto-Loop Settings

L

Auto-Loop Direction

You can also add a column by clicking + COLUMN underneath where the data populates and add that
asset in the GFX Designer.

<+ COLUMN

In the one row that appears, you can add content to those fields by clicking in the cell. You can then

type any desired content into a text field.
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Hame Title

Tom lannaco Product Specialist

4 Auto PUSHIPULL

+ ROwW + COoLUMN

Double-clicking an image field will allow you to browse your computer for an image to put in that image

field.
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Click the adjacent radio button to highlight it blue. This will make that row of data visible when that layer

is shown in Preview or Program.
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Name

Tom lannaco

To use the same graphics overlay template for different information or data, click + ROW on the bottom.

Hame

Fill in the data cells with the information you want to use for those text or image fields.

Name Title

Tom lannaco Product Specialist

Emily Knox Product Specialist
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Click the corresponding radio button to make that row of data visible in your graphics layer.

Name Title

Product Specialist

Tom lannaco

Emily Ko Product Specialist

You can add as many rows and columns as necessary for any given graphics overlay layer.

Name Title

Tom lannaco Product Specialist

Emily Ko Product Specialist

4 Auto PUSH/PULL

+ rROW <+ COLUMN

The settings allow you to loop your data content automatically. You can change the interval between
switches, whether the loop re-starts, if rows are kept, and what direction the loop moves.
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START AUTO-LOOP

Auto-Loop Settings
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Mixing Graphics Overlays into Program

@ Themixing panel shown in this section is only visible when Studio is in Advanced Interface
Mode. Mixing graphics in Simple Mode is covered here.

Once your graphic is designed and configured, you can start adding it to your production. First, make
sure your layer is visible by clicking the eyeball icon. It should be highlighted blue.

If you have multiple layers in your graphics overlay channel, highlight the eye icon of any layer that you
want to be visible; more than one layer can be visible at a time.

fomi omale < |

i p
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Please note that if you have multiple layers in one module, you can click the display buttons on the

bottom to show your layers in list mode to manage them more easily.

Lower Third : Yellow Boxes

Lower Third : Yellow Boxi |

Clock

If you want to put a graphics overlay channel in Preview before pushing it to Program, click the
corresponding PRV button in the upper right corner of the interface.
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PULL PULL

< U
PUSH  PUSH

You should now see the visible layers of your graphics overlay channel in Preview.

© PREVIEW

You should also notice the yellow PUSH button flashing. Click it to bring your graphics overlays into
Program.
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Your visible layers are now seen in both Preview and Program.

This is also indicated by PUSH no longer flashing and the PULL button turning red.
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PULL

Now try making a change to your graphics overlay channel, such as changing a layer’s visibility or
selecting a different row of data in a currently visible layer.

MHaimn

Amanda Vican
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The PUSH button has also started flashing again. This means that Livestream Studio has detected a
change in that GFX channel and is ready to change it in Program. Click it when you are ready to show
the change to viewers.

PULL PULL

&
PUSH

PRV

You should now see the change reflected in both Preview and Program.

For each layer, you have the option to have every change automatically pushed to Program immediately
by selecting the AUTO PUSH/PULL button on the bottom right.
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+ ROW + COLUMN 4 AUTO PUSHIPULL

Please note that if the graphics overlay is not yet in Program, you will need to push it manually by
clicking PUSH in the upper right corner.

To remove a visible graphics overlay quickly while AUTO PUSH/PULL is enabled, simply click on the
highlighted radio button of the visible row.

4 AUTO PUSHIPULL |

Now the graphic has been removed from Program and the radio button has faded in the graphics
module to indicate this.
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Eveni Co-Foundar

4+ AUTO PUSHIFULL |

Click the red PULL button that corresponds to that channel to remove everything from that graphics
overlay channel from Program.
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Doing so will remove that graphics overlay from Program, but you will still see it in Preview if the PRV
button is still selected.

To remove a graphics overlay from Preview, click the corresponding green PRV button.
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You should no longer see your graphics overlay in either Preview or Program.
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Using the Tie Controls

You may need to switch a video source and a graphics overlay simultaneously. This is where the TIE
BG and TIE buttons in Livestream Studio (Advanced Interface only) come in.

At least one of these TIE buttons must be selected at all times. This tells the transition controls what to
reference when switching.

ADVERT

If only TIE BG is highlighted yellow, then only the video source in Preview will switch to Program when
transitioning.
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After using a transition control, notice how the video source switched, but GFX 1 remained in Preview
because only TIE BG was selected.

To switch the video source and bring in a graphics overlay at the same time, select TIE BG and the
corresponding TIE button for your graphic. Be sure to select the PRV button for the graphics overlay
channel that is tied to your video source.
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PULL

ADVERT

Your Preview and Program monitors should look similar to this, with a GFX channel in Preview. Use a
transition control to switch the sources.

Now your video sources have switched and your graphics overlay has been pushed to Program.
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If only the GFX 1 and GFX 2 TIE buttons are lit and both sources are in Preview, then both overlays will
switch into Program when transitioning. The video will not change.

ADVERT

In this example, GFX 1 has a lower-third graphic, and GFX 2 is a clock. Use a transition control to bring
both into Program.

After the transition, both graphics overlays are now in Program, but the video source is the same since
TIE BG was not selected.
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To pull a graphics overlay out of Program simultaneously with a video source, tie the background and
the graphics overlay together.

ADVERT

Next, you will need to remove the graphics overlay from Preview. This will tell the transition controls that
the graphic should not be shown in Program on the next switch.

PULL PULL

PUSH PUSH
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Your monitors should look similar to this now, with Preview showing a different video source and no

graphic. Use a transition control to switch the sources.
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Importing Livestream Graphics Files

Livestream’s Graphics Store has numerous free templates that can be downloaded and imported
into Livestream Studio. You can also export any template you build in Studio and import it into

another Studio project later using this feature.

Studio has the Livestream Graphics Store built into its interface. Navigate to any GFX module. Open the
Categories menu or select Features you would like your graphic to have on the left side and browse
through template options on the right side. If you find a design you like you can simply click +Add below

the corresponding template.

Stream GFX1 Media 1 Maodia 2 Transitions

B studio Graphics Store

Categories

Al Graphics

Features

Full Scrasmn
Lower Third: Black / Red Gloss

+ ADD

Animatad

: & CREATE CUSTOM GRAPHIC [ty

Alternatively, if you downloaded a template from the Store website or exported an .Isgfx file previously,
you can import that file from your local hard drive by selecting Create Custom Graphic > Import Layer >

Livestream Graphics.
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.CSV File

. Studio Graphics St

Excel Spreadsheet
Import Layer »  Livestream Graphics
RSS

Google

Social

Clock

Timer

LSV over HTTP

New Layer +

LREATIS WUa l WiN SAF N

Browse your computer for the .lsgfx file you just downloaded (this is typically found in the Downloads
folder). When you find the file, click Open.

A 1| A 1 A 11

T e

—_—— A Snumm . -
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The layer will appear in your graphics overlay channel. For lower third graphics downloaded from the
Graphics Store, there are two text type columns and two rows included by default.

Media 2 Transdtions

If you open the GFX Designer by clicking the paintbrush icon, you will see clearly which text fields the
two columns correspond to and can adjust them as necessary.

Just as with any manually built graphic, you can add as many columns for data fields or rows of content

as necessary.
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P image

our name

P Settings
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Importing Excel Spreadsheets and .CSV
Files

Rather than manually inputting your data in Livestream Studio, you can import all your data from an
Excel (.xlsx) spreadsheet or .CSV file.

Q For the best experience, we recommend that your document have no more than 250 rows.
You can use other Excel or .CSV files in as many graphics layers as needed if you need to
show more data.

LB - cabamoen -1z |ﬂ|A-,A.' (= = sber SownpTear Genenal

Cpae PO (B L U] | [ ) BRI S S [ miJ_I_I_J' % 2 I_._;,""'“’ omer=q
Al OG-Y-RE
B |
Name Title
~ 2 |Tom lannaco Producer Support
~ 3 |Penalty Shot New York, N.Y.
~ 4 | Amanda Vicari Event Co-Founder
5 |EdYealu Event Co-Founder
6  Kristin McCue Co-Host
7

If you want to include images, make a column with the URLs where the images are hosted.

Lo “"‘“‘" Wb
Farmn
B LlFI v |Cabbei Bodyh  +[12 |+ |As | A- - * CawnpTear Grewa e . [Moma | E;Ih
¥
m@mwn:um_..&..aamg@ v - [ %] 3|5 &3 Gt .
cir |8 & (= &
A [ B

1 |Mame Title [Img|Fhm

2 Tom lannaco Producer Support h‘l‘t: . Gt
3 Penalty Shot Mew York, NY, Eﬂmmwllustmm mmfmnt;fmmaﬂl?fmmi ]
4 Amanda Vicari Event Co-Founder http: g.new.livestream.com,fevents,/D000000000390171/8 1d29ef3
5 |Ed Yealu Event Co-Founder E,{,{mmwllustmm mmfm_tsfmml?fMMI )
6 | Kristin McCue Co-Host g.new. livestream.com/fevents/0000000000390171/81d29ef]
Fi

8
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To get started, click Create Custom Graphic, then hover the cursor over Import Layer. Choose either
Excel Spreadsheet or .CSV File.

LSV File

. Studio Graphics St

Excel Spreadsheet
Import Layer » | Livestream Graphics
RSS

Google

Social

Clock

Timer

CSV over HTTP

Mew Layer

LRECAIES WD WM S il

The browse window will appear, allowing you to select your file and import it.

< ¢ Libraries » Documnents »

Organize - Mew folder

4 4r Favorites Documents library

Bl Deskiop es: 2 locations

8 Downloads

Recent Places
® GFXdemno

4 Libraries

| Documents
Music

= Pictures

B videos

The data from your file will appear on the right side of the module. Click the gear wheel to enter its

settings.
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Hame Title imag] Priots

| 4 AUTO PUSHIPULL |

Checking Watch file for update will prompt Livestream Studio to make any changes to the data that are
made in the original .xlsx file on your hard drive.

File

BROWVSE

v

Checking Use first row as column titles will change row A in your spreadsheet to be titles of the
corresponding columns in the GFX layer.

[amig] Photo

Excel Lattings

L

Click on the name of any column to change the data type that is in the column (text or image).
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Image

Change to Image Column

If you want to be able to edit the information within Livestream Studio, uncheck Read Only. Otherwise,
changes can only be made in the original file.

Any edits made to in Livestream Studio will not change content in the original document.

.CSV File Only - Further down in the settings, you can adjust the separators in the document as well as
the character encoding (which is typically detected automatically).
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Separators

Characier Encoding

Scroll down to find your Auto-Loop settings, including interval between rows, direction, and starting
point.

Aulo-Loop

START AUTO-LOOP

Auto-Loop Settings

Auto-Loop Direction

Auto-Loop Starting Rem

Next, click on the paintbrush icon at the bottom of the graphics module to enter the GFX Designer.
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Select Excel or .CSV in the dropdown menu and click the list icon to insert your text and image fields
into the designer.

From here, you can drag and drop each field to wherever you want it to be displayed.
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BORDER
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Feel free to add any additional elements to your graphics overlay using the other icons at the bottom of
the designer.

Close out of the GFX Designer when you have finished. To use the graphic, click Back to view the layer
module.

You can then click the associated PRV, PUSH, and PULL buttons to utilize that graphics overlay.
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Using RSS Feeds

If you want to include an RSS feed in your Livestream Studio production, go to a GFX module, open the

Create Custom Graphic menu and select RSS from the graphics menu.

Stream GFX 1

. Studio Graphics Store

Import Layer

Clock
Timer
CSV over HTTP

New Layer

EREAI S wUa YN SRAFN

The RSS layer will appear in the graphics overlay channel. Click the gear wheel to enter its settings.

If access to your RSS feed requires authentication, check Basic Authentication and enter your

credentials.
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When you enter the RSS URL, the data should populate on the right and give you access to further
settings.

Tithe BTN

Pichire
COITapi B T Ay a3
S5 Feed URL Wi complenment

Auto sdvance dats mberval

Records number imitation

+ ARTOD PUSH/PULL

Set the time interval in seconds that you want Livestream Studio to look for new information from your
RSS feed under Auto advance data interval.
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Auto advance data interval

Records number imitation

To control the number of posts from your RSS feed, you can choose to only include posts within a
recent time frame.

AUTD advance data mterval
NIH complementary a hitp-iinccam. nih. gowine

Pomegranate
Records number imitation

o

4

Auto-Loop

You can also limit Livestream Studio to pull only a certain number of most recent posts.
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MIH complementary a MCCAmnih.govn

Aecords number Bmitation

Auto-Loop

If you wish to edit any data within Livestream Studio, uncheck Read only.

Any edits made to data sources in Livestream Studio will not change content in the original
source.

NI complementarny a

Frequently Asked Cues

Auto-Loop

At the bottom of the settings are the Auto-Loop options for this graphics layer.
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Amio-Loop Seltngs

dwrto-Loop Nrection

Amio-Loop Staring Hem

Next, enter the GFX Designer, and select RSS from the dropdown. Click the list icon to select your data
fields.

{Title}}

Close out of the GFX Designer and return to the layers module to make the layer visible. You can now
include content from the RSS feed into your production via the graphics overlay controls.

407



408



Integrating Google Spreadsheets

An easy way to integrate and manage data in a graphics overlay from an external source is to use
Google Sheets. Livestream Studio can integrate up to 15 Google Sheets graphics layers; this is an

authorization limitation determined by Google.

Navigate to a graphics overlay track, open the Create Custom Graphic menu and select Google.

Stream GFX 1

. Studio Graphics Store

Import Layer
RSS

Google

Social

Clock

Timer

.CSV over HTTP

Mew Layer

LROCAID W Ua il VWM SArFnie

You do not need to log in if you select Enter a public Google spreadsheet. Selecting this will allow you to

enter the document’'s URL.
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GFX 1 GFX 2

Google Spreadsheet

Select from my Google spreadsheets

Enter a public Google spreadshesat

Public Spreadsheat URL

If you want to use your own private Google document, you will need to sign in to a Google account to
allow access to your Google Drive. When you click Sign in with Google, a new browser window will
open allowing you to sign in and allow this permission.

GFX 1 GFX 2 Stream Transitlons

Google Spreads heat

Log in to your Google account

L Signin with Google
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Google

Hi Emily
[}

livestream.com wants to

o View and manage your spreadsheets in @
Google Drive

Allow livestream.com to do this?

By clicking Allow, you allow this app to use your information in
accordance to their terms of service and privac n
remove this or any other app with access to yo

My Account
CANCEL ALLOW

Once you see the Authorization Successful message, navigate back to Studio and select the document
with the information you want to include in your graphic. The selected document's data will populate on
the right.

Q For the best experience, we recommend that your document not have more than 250 rows.
You can use Google in multiple graphics layers if you need to show more data.
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Googhe Spreads haet 1l Column 1 Column 2

Hrmas Position

Tom lannaco Cafanse

Adam Schwarz Ledt Wing

Jon Robarts Coenter

Marty Brown Ender
Tourmamiasnt irds CHANGE

lan Bleu Right Wing

Lisa Tiegd rony 86 column iifies.

4 Auto PUSH/PULL |

You can always use a different spreadsheet in your Google Drive by clicking the Change button.
Spreadsheets will be ordered by most recently modified.

GFX 1 GFX 2

Google Spreadsheet

8 Select from my Google spreadshesets

Enter a public Google spreadsheet

LOG OUT

Spreadsheat

Tourmament Lower Thirds CHANGE

Usa first row as column titles

& Read only

+ s

Scroll down to adjust additional settings for this layer. To turn your first row into column titles, check Use
first row as column titles.
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Spreadsheat

Tovrmament Lower Thirds CHAMNGE

W Lsa first now o min Sthes

| Raadonly

Auto-loop

START AUTO-LOOP

Meadia 1

Nama

Tom lannaco

Adam Schwartz

Jon Roberts

Marty Brown

lan Blau

Stream

Position

Defense

Left Wing

Center

Goalttender

Right Wing

Click on any column title to change the type of data included in that field (text or image).

Change to Image Column
Tom lann

Hide in Surface
Adam Schwaw
Jon Roberts

Marty Brown

lan Blau

Position

Defense

Left Wing

Center

Goaltender

Right Wing

Uncheck Read only if you want to be able to edit the information within Livestream Studio. Otherwise,

changes can only be made in Google Docs.
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Google Spreadsheet Name

om lannaco

Adam Schwartz

Jon Roberts

Read only Marty Brown

il lan Blau

Scroll down in the settings to configure your Auto-Loop preferences, including how often Studio
switches to the next row, the direction the loop should go, and where the loop should start from.
Google Spreadsheet

Auto-Loop

START AUTO-LOOP

Auto-Loop Settings

30 second interval between new items

Start from beginning once end is n

Auto-Loop Direction

& Top-to-bottom

Bottom-to-top

Arrknd Amn Rtartinn Ham

+ | 7

The next step is to start designing your graphic. Click on the paintbrush button to enter the GFX

Designer.
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In the Google Spreadsheet layer, click on the list icon to see your columns. Click on one to insert it into
the GFX Designer.

Mame

Position

BORDER

Close out of the GFX Designer when you have finished. In the graphics overlay channel, click Back in the
upper right corner to return to the layer module.
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GFX 1

Google Spreadsheet

% Select from my Google spreadsheets

Enter a public Google spreadsheat

LOG OUT

Spreadsheet

Tourmament Lower Thirds CHANGE

Make sure the Google spreadsheet layer is visible by selecting the eye icon. This will allow you to this
graphics overlay to be visible in Livestream Studio.
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Importing a Twitter Feed into Livestream
Studio

You can include a graphics layer of a Twitter feed from a username or hashtag as a graphics overlay

in Livestream Studio

To get started, you may want to consider adding a Twitter graphic template from our Graphics Store. In
the GFX module, select Twitter from the Categories menu, then click +ADD under one of the design

options.

GFX1 Transitions

' Studio Graphics Store

CATEGORIES

FEATURES

When the graphic is imported, you will see the design preview on the left side and a prompt to sign in on
the right. Click Sign in with Twitter to open a browser window and sign in to Twitter. This is required in
order to allow Studio and Twitter to communicate with each other, however you are not restricted to

displaying tweets from your own Twitter account.
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Log in to your Twitter account

W Sign in with Twitter

Authorize Livestream Studio HD to |
use your account? w

L ivestream Studio HD
wthorize af Cancel

lication will be a to:
= Read Tweets from your timeline.
« See who you follow.

Will not be able to:

+ Follow new people.

+ Llpdate your profile.

+ Post Tweets for you.

« ACCEss your direct messages.
+ See your email address.

« See your Twitter password.

Once you authorize the app, navigate back to Studio. The layer module will open with a default account.
Click the gearwheel to enter the graphic’s settings.
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B2 [ De o Do e [e

crnbek

bk

cnnbrk

cnnbrk

crnbiek

crnbek

cnnbrk

CHH Braaking ..

CHMN Braaking ..

NN Breaking ..

NN Braaking

GHN Breaking ..

CNN Bragking ..

Twomt

Austing Teues, p...

Britiah Prime Mi...

Pom star Stom..

French fa.

Wone..

Transitions

TimoStamp

e

AM218 1:39 PM

F1218 1237 PM

A 11206 AM

1218 1011 AM

RT @CHNMong. ..

Update: Toll fisa...

Select a username or hashtag to poll. Keep in mind that you must include '#" in the front of hashtags and

‘@’ in front of usernames. When you have typed in the desired asset, press the Enter or Return key.

Enter a Twitter usemame or hashtag

#imeo

Remember fo use th

rmbol before

Poll Twitter for new Twaats every

60

second

I
=

On the right, tweets from that username or hashtag will load on the right side, including each tweet's

avatar, name, username, and time stamp.
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stylingthefit Kirmber Wabch “OMNE LD,

Entar & Twittar usamame of haakiag
rhodesmessiah Messlah Rhodes | just upioaded =,
thrunetm Tonl Brunet Var “Los Noevo...

Emma Cathedin. . gander ¢ Pub..
rareg emi Jacqualing A, D ‘Watch "Fael The...

Pall Twitter for new Twests svery

joelatierty Joa Laffarty | just upioaded *...

Records number limitation Laurie Raracey

Scroll down on the left side of the module to find more settings. You can select how often Livestream
Studio should look for new tweets. Newer tweets appear at the top of the module. You can also tell
Livestream Studio how many tweets to look for within a certain time frame. Select Read Only if you do
not want to be able to edit the tweets.

Twitter Bird

Poll Twitter for new Tweets every

60 seconds
Records number limitation
Last 10 records

&) No Time Limitation

Last 120 minutes

% Read only

Scroll down in the settings to configure any desired Auto-Loop options.
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Auto-Loop

START AUTO-LOOP

Auto-Loop Saitings

sacond interval between new items

" Start from beginning once end is reached

Auto-Loop Direction

& Top-to-bottom

Bottom-to-top

Auto-Loop Starting Ham

If you wish to adjust the appearance of the graphic or change what information is shown, click the
paintbrush icon to open the GFX Designer. You can adjust the placement, size, font, and color of any of
the text fields by selecting it and clicking the gearwheel icon.

If you do not wish to use a Livestream Graphics template, you can also create your own by opening the
Create Custom Graphic menu, hovering your mouse over Social, and selecting Twitter post.
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Stream GFX 1

. Studio Graphics Store

Import Layer

RSS Twitter post

Google & Facebook Comment
Social > | Youtube Comment
Clock

Timer

CSV over HTTP

New Layer

LRCATR bWda Wi aiArnilie

Follow the login steps as described above, then open the GFX Designer. Click on the list button in the
Twitter layer, and you can add any data field from Twitter such as the tweet, username, avatar, etc. as

well as any other design element.
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Display Facebook Comments via
Livestream Studio

Studio lets you include comments from your Facebook broadcast or your other videos on

Facebook and show them in a graphics overlay.

@ Please note that Facebook does not include the names or photos of commenters from a

Page or Group post, regardless of the audience setting. Only the comments will be viewable.

In a GFX module, select Create Custom Graphic in the bottom left corner.

GFX 1

. Studio Graphics Store

Categories

All Graphacs

Features Apeil ONell
E AT

Lower Third: Black / Red Gloss
Animated -+ ADD

Full Screen

+ CREATE CUSTOM GRAPHIC

Hover your mouse over Social, then select Facebook Comment.
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Import Layer

Twitter post
Facebook Comment

Youtube Comment

Timer

LSV over HTTP

MNew Layer

LREAT S wida WM S ni

Once you add the Facebook Comment layer, be sure to open the GFX Designer to design your graphic
and add the desired fields from Facebook (profile picture, name, comment, number of likes on that
comment).
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GFX 1 Designer

Picturs

Mamme

Commant

Likas

There are two ways this feature can be used.

See Comments on Current Live Broadcast

By default, this option is set to get comments from Facebook stream provider. This means when you set

up Studio to broadcast to Facebook, the comments that populate will be from the stream that appears
on Facebook once you go live from Studio.
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Facebook Comments

Get comments from

& Facebook stream provider

Use separate login

& Filter comments

Facebook profile name or hashtag

You can also filter the comments that come in by a keyword or hashtag. This will pre-populate a default
comment you can display in your graphic that will prompt your viewers to use the desired phrase. If you
want to see all the comments that come in, uncheck Filter comments.

Facebook Comments

& Filter comments
Facabook profile name or hashtag

#ishotbymewvo

Retrieve new comments every

seconds

Next, you can configure how often Studio polls for new comments and how many of the most recent
comments will it show. By default, it will poll new comments every 60 seconds and display the most

recent 100.

Below this setting are the auto-loop settings, where you can set Studio to loop through each comment

at a defined interval.
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Stream GFX 1

Facebook Comments

Retrieve new comments avery

Show most recent

100 comments

Auto-Loop

START AUTO-LOOP

Auto-Loop Settings

30 second interval between new items

Start from beginning once end is re

Stream GFX 1

Facebook Comments
Auto-Loop Settings

30

Start from beginning once enc
Remove item from list after shown

ip to newest

Auto-Loop Direction

ottom

Auto-Loop Starting ltem

Start from top/bottom

Start from selected list itern
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Once you go live and some viewers have commented, Studio will poll Facebook for comments as
configured, and you can display them one at a time in a graphics overlay.

See Comments from Another Facebook Post

If you wish to display comments from another Facebook video, you must have login credentials to the
account that owns the video, whether it's from your profile or a Page of which you are an admin.

Click Log In to open a browser window and log into Facebook.

Stream GFX 1

Facebook Comments

Get comments from

Fac stream provider

% LUse separate login

LOG IN

Once you are logged in, paste the URL of your Facebook video into the field.

You can filter the comments that come in by a keyword or hashtag. This will pre-populate a default
comment you can display in your graphic that will prompt your viewers to use the desired phrase. If you
want to see all the comments that come in, uncheck Filter comments.
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Stream GFX 1

Facebook Comments

LOG OUT

Entar a Facabook post url

book.com/eekno eosM0212661103187 747/

& Filter comments

Facebook profile name or hashtag

Next, you can configure how often Studio polls for new comments and how many of the most recent
comments will it show. By default, it will poll new comments every 60 seconds and display the most

recent 100.

Below this setting are the auto-loop settings, where you can set Studio to loop through each comment

at a defined interval.
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Facebook Comments

Raetrieve new comments avery
60
Show most recent

100 comments

Auto-Loop

START AUTO-LOOP

Auto-Loop Sattings

30 nd interval between new items

Start from beginning once end isr

Remove item from list after shown

Stream GFX 1

Facebook Comments
Auto-Loop Settings

30 second interval bebween new items

Start from beginning once end is rea
Remove item from list after sh

o newest

Auto-Loop Direction

bottom

om-to-top

Auto-Loop Starting Item

& Start from top/bottom
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Display Youlube Comments via Livestream
Studio

Studio lets you include comments from your YouTube broadcast or other videos on YouTube and

show them in a graphics overlay.

In a GFX module, select Create Custom Graphic in the bottom left corner. Hover your mouse over

Social, then select YouTube Comment.

Stream GFX 1

. Studio Graphics Store

Import Layer

RSS Twitter post

Google & Facebook Comment
Social > Youtube Comment
Clock

Timer

CSV over HTTP

New Layer

LREAIS o W SiArmiie

Once you add the YouTube Comment layer, be sure to open the GFX Designer to design your graphic
and add the desired fields from YouTube (profile picture, name, comment; "likes” will appear but will

appear as "N/A" in the data field).
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GFX 1 Designer

Picture

Marne

Cammant

Likes

There are two ways this feature can be used.

See Comments on Current Live Broadcast

By default, this option is set to get comments from YouTube stream provider. This means when you set

up Studio to broadcast to YouTube, the comments that populate will be from the stream that appears on
YouTube once you go live from Studio.
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Madia 1 Media 2 Transitions

Stream

W Filler comments

Youtube profile name or hashtag
Setup Youtube as a streaming des

When you're live i will start appearing hara.

You can also filter the comments that come in by a keyword or hashtag. This will pre-populate a default
comment you can display in your graphic that will prompt your viewers to use the desired phrase. If you

want to see all the comments that come in, uncheck Filter comments.

Stream GFX 1

£ Youtube
Select login type
® ‘Youtube stream provider

Uise separate login

& Filter comments

Youtube profile name or hashtag

#ShotByMevo

Next, you can configure how often Studio polls for new comments and how many of the most recent
comments will it show. By default, it will poll new comments every 60 seconds and display the most

recent 100.

Below this setting are the auto-loop settings, where you can set Studio to loop through each comment

at a defined interval.

433



434

Stream GFX 1

Youtube

Ratrieve new comments avery
60 seconds
Show most racent

100 comments

Auto-Loop

START AUTO-LOOP

Auto-Loop Seattings

30 second interval between new items

Start from beginning once end is

Remove item from list after shown

Stream GFX 1

Youtube

Auto-Loop Settings

30 second interval between new items

Start from beginning once end is reached
Remove itern from list after shown

o newest

Auto-Loop Diraction

ottom

Bottom-to-top

Auto-Loop Starting ltem

Start from

Start from selected list item
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See Comments from Another Youlube Video

If you wish to display comments from another YouTube video, select Use separate login. Paste the URL
of the video whose comments you wish to display in the graphics overlay, then press the Enter key on

your keyboard.

You can filter comments based on a keyword or hashtag. This will pre-populate a default comment you
can display in your graphic that will prompt your viewers to use the desired phrase. If you want to see all
the comments that come in, uncheckFilter comments.

Stream GFX 1

Youtube
ct login type

Youtube stream provider

% LUse separate login

Enter a YouTube post url

Shwww.youtube.comfwatch’ BkIMERXDE4

% Filter comments

Youtube profile name or hashtag

#ShotByMevo

Next, you can configure how often Studio polls for new comments and how many of the most recent
comments will it show. By default, it will poll new comments every 60 seconds and display the most

recent 100.

Below this setting are the auto-loop settings, where you can set Studio to loop through each comment

at a defined interval.
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Youtube
Retrieve new comments every
G0
Show most racent

100 comments

Auto-Loop

START AUTO-LOOP

Auto-Loop Settings

30 second interval between new items

Start from beginning once end is reached

Remove item from list after shown

Stream GFX 1

Youtube

Auto-Loop Settings

Start from beginning once end is reached
Remove item from list after shown

Skip to newest

Auto-Loop Direction

ottom

Bottom-to-top

Aute-Loop Starting ltem

Start from to

Start from selected list item
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Using a .CSV Over HTTP

If you are hosting a .CSV file on a web server, you can use graphics overlays in Livestream Studio to

display data from it.

In a GFX module, open the Create Custom Graphic menu and select .CSV over HTTP.

Stream GFX 1

. Studio Graphics Store

Import Layer
RSS

Google

Social

Clock

Timer

LSV over HTTP

New Layer

LRCATD o Wi AR N

If your file requires authentication in order access it, check Basic Authentication and enter your

credentials.
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% Basic Authentication

User name

Remember ma

In the settings, input the URL where the .CSV file is located, then the press Enter or Return key on your
keyboard. Your data will populate on the right with further settings becoming available on the left.

@ Make sure there are no spaces between either field; only commas should separate each
value.

CORRECT: Data 1,Name,http://cdn.livestream.com/resources/branding/livestream-logo.png

INCORRECT: Data 1, Name, http://cdn.livestream.com/resources/branding/livestream-
logo.png
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Stream Transitions

Column 1 Column 2 Column 3 Column 4

Starl Date Start Time End Date End Time

852011 3:00:00 PM 52011

anz2on 6:00:00 FM a%20m 80000 P

Scroll down on the left side of the module to configure additional settings. Set the amount of time in
seconds that Livestream Studio should refresh and look for new data in your .CSV under Auto advance

data interval.

csv

Auto advance data interval

30

CSY Settings

Use first row a= column titles

» Read only

If the first row actually contains the titles of each field, you can check Use first row as column titles to
move them up to the title field.

If you want to make changes to your .CSV content via Livestream Studio, uncheck Read only. Otherwise,
leave it checked.

439



Media 1 Stream Trangitions

Start Date Start Time End Date End Tima

A0 3:00:00 FM 20N

G:00:00 FM 0 B:00:00 PM

Scroll down to tell Livestream Studio what your column separators are and the types of characters being
used (typically auto-detected).

CsvY
» Usa first row as column tithes
% Read only

Separators

Comma

Character Encoding

Auto

Auto-Loop

+ s

At the bottom are your Auto-Loop settings if you want Livestream Studio to rotate through your .CSV
data; these settings include how often the displayed row changes, what direction it loops in, and its
starting point.
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csv

START AUTO-LOOP

Auto-Loop Settings

30 second interval between new items

Start from beginning once end is reached

Auto-Loop Direction

% Top-to-bottom

Bottom-to-top

Auto-Loop Starting lHem

- T M TR T ST

To design the graphic, click the paint brush icon to enter the GFX Designer.
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csv

o rea e mmamar e s ewss gy

30 sacond interval betweean new items

Start from beginning once end is reached

Auto-Loop Direction

® Top-to-bottom

Bottom-to-top

Auto-Loop Starting lHem

& Start from top/bottom

Start from selected list item

Select the CSV layer from the dropdown in the lower left corner and design your graphic as desired.

Start Date
Start Time
End Date
End Time
Evant Title

All Day Event

You can now control the graphics overlay by using PRV, PUSH, and PULL as desired.
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Livestream Studio Certified Data Sources

A Livestream Studio Certified Data Source (LSCDS) is a spreadsheet document formatted according
to the Livestream Studio specification. An Excel (.xlsx), CSV or Google Spreadsheet document can
be used to define LSCDS. Below, you'll find information on the benefits and instructions on how to
create/utilize a LSCDS formatted file.

Why do | need Livestream Studio™ Certified Data
Sources?

The main advantage of LSCDS in Livestream Studio™ graphics layer compared to any standard custom
excel, Google spreadsheet or CSV file is the ability to remotely control data selection "eyeball” in
Livestream Studio™. This feature is primarily designed for distributed production workflows, meaning
when a dedicated person operates graphics data during a live video production.

This feature can also be used for automation, for example, in combination with custom web services
that generate CSV files on the fly to control graphics data in production, such as sports scoring.

In the examples below, you'll find small scripts for data ON/OFF program validation, as well as
illustrations on how to bring dynamic image objects into Livestream Studio using external files.

How to define Livestream Studio™ Certified Data
Sources

You can copy one of the examples below and add columns, rows and data to the example as needed
(make sure the PROGRAM column remains in the Alposition).You may also use an existing file as a
Livestream Certified spreadsheet, just add an additional first column and name the first cell (Cell Al) -
PROGRAM. Once you have load the file to Livestream Studioas a graphics data layer, you will see a small
Livestream logo over the layer thumbnail.
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Once the file is identified as a certified data source, Livestream Studio will look for "ON" and "OFF" values
within the first column (A2:Ax). "ON" value will activate that row in the Livestream Studio™ GFX layer,
while "OFF" deactivates that row. The "ON" or "OFF" status will be represented by the "eyeball” logo within

Livestream Studio.

If there are multiple ON values in the column, Livestream Studio will use the first from the top. You can
add validation scripts to your spreadsheet by following instructions below to maintain single row
selection. More information on using validation scripts below.

Note: All the values that are not equal to ON and OFF will be ignored.

Livestream certified CSV files can be used in Studio via file path on local disk/network or over HTTP

protocol.

Sample LSCDS Files

» Excel

» Google Spreadsheet Template - You can add this template to your own Google Drive by clicking the
"Use This Template” button.

o« CSV

Installing Validation Scripts

Google Spreadsheet:

The Google Spreadsheet templates linked above already include validation scripts. Below is a link to the
source code of the validation script we used for the sample. You can use the text to install the script on
your own custom Google Spreadsheets. To install the script, do the following:

- Click Tools' > 'Script Editor..." (or 'Script Manager...):
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http://cdn.livestream.com/LivestreamStudio/LSCDS/LS_Excel_Template.xlsm
https://drive.google.com/previewtemplate?id=0AhzC_ogB_MZmdDNHMGVDd0ZiczBKVWZNZmI1WENZRkE&mode=public
https://drive.google.com/a/livestream.com/previewtemplate?id=0Am9OQx37_UE7dFFOaEU0TzV0Tm1PUlY5VFpHaGZXc2c&mode=domain
http://cdn.livestream.com/LivestreamStudio/LSCDS/LS_CSV_Sample.csv
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Penalty Shot Lower Thirds ]
File Edit View Insert Format Data ] Tools | Add-ons Help  All changes saved in Drive

8 e~ P 5 % 0 00123 Create a form B 7 5 A. & H-

-

% Tom lannaco

Script gallery...
'y B I—LH- " E F
Name Title | Script editor...

1
2 |'I'nrn lannaco .Pmdu::ar Support hittps:/ Spelling ats/00000000003801 718 1d29al2-8
3 Penalty Shot  New York, N.Y, hitps:/ nts/00000000003501 71/81d29et2-6
4  Amanda Vicari Event Co-Founder https:/ - Enable autocomplete nts/0000000000380171/81d209af2-C
5 Ed Yealu Event Co-Founder hittps: ats/00000000003901 718 1d20af2-2
o Motification rules...

6  HKristin McCue  Co-Host hittps:/ nis/0000000000390171/81d29ef2-8
7 Protect sheat....

- Copy the Google Spreadsheet Validation Script found here and paste it into the editor
- Click the Save icon and name it.

Excel:

The sample file provided above has the validation script built in. If you already have a file you would like
to use, you can use the validation script linked here.

Dynamic images and LSCDS

External data files may contain columns with HTTP URLs or local/network addresses referencing images
you would like to use in your GFX template. To define a column as an Image type column, add [img] at
the beginning of the column name. Livestream Studio™ will recognize the path as an image and display
itin your graphics template.
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http://cdn.livestream.com/LivestreamStudio/LSCDS/GS_Validation_Script.txt
http://cdn.livestream.com/LivestreamStudio/LSCDS/XLS_Validation_Script.txt

Penalty Shot Lower Thirds ]
File Edit View Insert Formal Data Tools Addons Help Script Center Menu AN changes saved in

& o W P O§ % o0 o 13- Ana - - B SA. %H-

fu Tom lannaco

A o € 1 ] F t
1 PROGRAM  MName Tose
Z ON |Tnmm | Producer Suppan s g N rvestream, comieventa 0000000000301 THE:
2 OFF Penaity Shot  New York, N.Y. ity fimg new ivestream.comievents 0000000003801 TS
4 OFF Amanda Vicari Event Co-Founder hittps:ifimgumew. ivestream.comievents/00000000003801 T8
& OFF Ed Yealu Event Co-Founder hittps: g new ivesirgam. comigventaDONO0MD000AS0 1 THE"
& OFF Kristin McCue  Co-Host hittps: g nenvw ivestream.comigventaDD0000000IS0 1 THE"
T OFF
B OFF
8 OFF

3

€@ Note: When an image can not be found at the provided URL or path, Studio will display an
empty (transparent) image field.

Spreadsheet Formatting Best Practices

Google Spreadsheet:
- Freeze row 1 and column 1 (View - Freeze Row / Freeze Column)

- Add data validation using the shown parameters:
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x
Data validation
Cell range: Shoet1!A2:4| Itz
Critaria: List of items = ON,OFF p
On invalid data: Show waming ® Reject input
Appearance: +" Digplay in-cell button to show list
Show help: Click and enter a value from the list of items Raset
n Ramaove validation Cancal
- Add conditional formatting to the A2:A (all the values in A row except Al)
X
Conditional formatting
Text it sxsetly = ON Format:  Text Color: Range: x
+ Background Color: i Aa
Taxt s smsetly = OFF Format:  Text Color: Range: .
¥ Background Color: AA
+ Add another rule

B o
Excel file formatting:

We recommend using the template available HERE when using Excel files for LSCDS.
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Display a Webpage in Livestream Studio

Beginning with version 5.2, Livestream Studio allows you to display and interact with a webpage

within the graphics overlay module.
In a GFX tab, select Create Custom Graphic, then select New Layer.

Stream GFX 1

. Studio Graphics Store

Import Layer
RSS

Google

Social

Clock

Timer

CSV over HTTP

New Layer

DA S eUa W SR M

Open the GFX Designer for the blank layer you just created.
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Stream

At the bottom of the window, select the webpage icon.
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[ ] & GFX 1 Designer

A webpage graphic will appear and fill the entirety of the GFX canvas. By default, it will show vimeo.com.

@ Atthistime, any audio from the webpage will not be heard in Studio.
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https://vimeo.com/
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[ oy GFX 1 Designer

All your video needs

The highest quality, more control, uniimited inspiration, and everything eise for your video.

With the webpage selected, click the gearwheel icon in the corner to change the URL. You can also
adjust the size of the webpage graphic.
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hitps.fvimeo.com/

WIDTH HEIGHT

1280 720

OPACITY

SHADOW

BEORDER

Video fro
Sojim Kamals

Selecting the Interact option will open a new window in Studio and allow you to navigate the site just as
you would in a normal browser, including scrolling, clicking on links to other pages, and typing into text

fields.
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R ] Wimma | The high-quakity home dor viden kosting and waiching

Search videcs, peopls, and mom 9,

All your video needs

The highest quality, more control, unlimited inspiration, and everything else for your video.

-

Widad: e
Sojim Kamsten

Note the upper right corner of this window includes a </> button. Selecting this button will open a CSS
editor that will allow you to change the appearance of the webpage in Studio. Be sure to click Save
when you're done.
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Cancel w

You can now mix your webpage into your production as you would with any other graphic.
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Building a Picture-in-Picture Graphic

When doing a multi-camera production, many producers sometimes like to show two or more
camera shots at the same time. Livestream Studio gives you the ability to show up to five cameras

within one picture-in-picture graphics layer.

Navigate to a graphics tab, open the +Add Custom Layers menu and select New Layer.

'- SHdin Rranhine E'I:ore

Import Layer
RSS

Google

Twitter

Clock

Timer

.CSV over HTTP

Mew Layer

Click the corresponding paint brush button to enter the GFX Designer.
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o= COLUMN

I GFX1 Designer 5 = |

Click the camera icon at the bottom of the window. A video source will appear in the designer.
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I 6Pl Desigeer = el

Click the attached gearwheel icon to change which source appears in there. You can choose any
camera input, media source, remote camera, graphics track, or color source.
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nput 12 |

Add another source.
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I GFi1 Designer Sl =%

You can drag and drop either of these anywhere within the designer. Clicking the gearwheel will also
allow you to resize and crop your sources.
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A sample double-box (or two-box) might look something like this:
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| GFX1 Designer O ==

If you want to give a background to your picture-in-picture, add a third source to the GFX designer. In
this example, we're using a looping video background in Media 1.

GFX 1 X 2

Copy of LIVE_bg_koop....
D0 003300

oo:oo:o0zo0 [ ] oocoo:3ocoo B

Right-click the third source and click To Bottom Layer. This will force it to be behind your other two
Sources.
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Scale it so it fills the designer. Now your picture-in-picture looks like this.
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Close out of the designer and make sure your layer is visible (the eye icon is blue). Then click the
corresponding flashing Push button to bring it into Program.
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AUTOD

-|r 11-

PULL

PUSH

PRV

ADVERT

Now both sources are seen in Program at the same time with your background. Click Pull whenever you
are ready to show your previous Program source.

PROGRAM
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Building a Clock or Timer

Adding a time-of-day clock or a countdown timer are very similar processes.

Clock

You may want to overlay a time-of-day clock into your production. This can be done by opening the
Create Custom Graphic and menu selecting the Clock option in the graphics overlay channel.

Stream GFX1

. Studio Graphics Store

Import Layer
RSS

Google

Social

Clock

Timer

.CSV over HTTP

New Layer

LREAITD WUa 1Y GRAFNI.

This will add a clock layer to the graphics channel. Click on the paintbrush icon to open the GFX

Designer for that layer.
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Media 1 ransitons

15:34:38

Click on the list icon for options of time fields to add. Consider checking the presets first to save the
time needed to add individual fields.

{HHj}f{mem}

Aprt, S0 pm FLE

21:08 FLE

Mhadia 1

Once you have added the time fields you need, click the arrow button to change each one’s font, size,
color, etc.
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{{hh}}:{{mm}}{ap}
x| x

SHADOW

BORDER

Drag and drop the clock to where you want to have it appear. When you are done designing the clock,
close out of the GFX Designer.
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There are no additional settings for the clock layer other than deleting it. Click Back to return to the layer
module. Then click the eye icon to ensure the clock layer is visible when you want to include it in your
production.

Mixdia 1

15:37:58

Timer

To integrate a countdown or timer overlay into your production, open the Create Custom Graphic menu
and select Timer in the graphics overlay channel.
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Stream el |

. Studio Graphics Store

Import Layer

Social
Clock
Timer
.CSV over HTTP

New Layer

LRCATE o WM SArniie

Click the gear wheel icon to enter that layer's settings.

The settings for that layer will appear on the left side, with the reflected timer displaying on the right.
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Media 1 Stream

23:58:54

Action on Finizh
Hide Layer + Push

Pull from PG

Countdown to allows you to set a specific time and date for when the countdown should end. The
countdown will update on the right side.

¥ For a quick configuration, you can check Use start time of streaming event to automatically
set the countdown to end at the start time of an event you have selected in the Stream tab.

Below the time/date setting are options for what the graphics overlay should do when the countdown
completes.
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¢ Back

Timer

Countdown To

Use start time of streaming event

2018

Action on Finish
Hide Layer + Push
Pull from PGM

Transition

Hide Layer + Push will keep GFX 1 in Program, but remove the timer GFX layer from being visible. Other
layers in GFX 1 will remain in Program.

Medea 1

00:00:00

Pull from PGM will pull all layers under that GFX channel from Program when the countdown ends.
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Transition can be used when the GFX channel is cued as a video source from the multiview instead of an
overlay. It will take the Preview source once the countdown ends.

The transition type can be selected in the settings for that GFX layer.
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Action on Finish

Leaving all options unchecked will keep the completed countdown graphic in Program.

00:00

The next setting is Countdown from, where you set the time that the countdown will start. The format

PROGRAM

of this countdown can either be hours:minutes:seconds, or minutes:seconds.
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GFX1

< Back

Countdown From

Format

®) hh:mm:ss

MIm:ss

00:00:10

Start on First Push

Start on Push

Resat on Hide

Pause on Hide

Type in the time you want to count down from. Clicking Start will begin the countdown manually.

When the countdown has started, a Pause button will replace it. Click Pause if you want the countdown
to stop but stay at the current time, allowing you to resume from that point.

Format
® hh:mm:ss

MIM:S&

Clicking Stop will both stop the countdown and reset it to the beginning.
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Below the Start and Stop options, there are options for what the clock should do when pushed, pulled,
or finished.

Start on First Push

Start on Push

Reset on Hide

Pauze on Hide

Action on Finish

Hide Layer + Push

Pull from PGM

Transition

Scroll down further in the layer settings to find the hotkey option. Click the checkbox to enable it.

Click on the box that reads None. This will highlight it blue.
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Once it is blue, use the buttons on your keyboard to create a hotkey (e.g., Shift+P).

It cannot be a hotkey command that already has an action in Livestream Studio assigned to it.

Hotkey

&' Enable Start’Pause Hotkey

Shift+P

Now you can push your countdown graphic to Program like normal. Instead of pressing the buttons in
the GFX module, you can use your keyboard to quickly and easily pause and continue your clock.

The last option for this layer is Timer, which gives you a clock that counts up from zero. As with the

Countdown from option, you can set the format and start and stop the timer.
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Timer Controls

START aTOP

Below these controls are the actions the graphic will take when first pushed to and pulled from Program.

The Timer also includes the ability to add a hotkey command for pausing and resuming.

With any of the three options, be sure to click the paintbrush icon to enter the GFX Designer.
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In the Timer layer, click on the list icon to add time fields. Check the presets first, as this may save time in
designing the graphic.

Agpril, 508 pm FLE

rl, 21:08 FLE

Mhadia 1

Use the dropdown menu to customize how the clock looks.
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0%

Standard Casing

W SHADOW

BORDER

When finished, close out of the GFX Designer, then click Back in the graphics layer settings. Your timer
graphic can now be made visible and pushed to Program when desired.

00:00:00
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Importing Animated Graphics

Livestream Studio can accept either an .mov file or a folder of images that it will loop through to
create an animated graphics overlay.

This feature is best for lower-third graphics and corner bugs. Larger animated graphics, such as
backdrops, should be exported as videos and come in through a media bin. To keep your images’
backgrounds transparent, .PNG files are recommended if you are using an image sequence.

Your .PNG files must be less than 8.3 million pixels. To determine a .PNG file's pixels, view that file's
properties and multiply the height by the width. For this graphic, which has subtle animations, 1614 x
390 = 629,460 pixels.

If you use an .mov file instead, be sure your video matches the same project format as your Studio
project to ensure no upscaling or downscaling occurs.

General | Secuty | Detais | Previous Versions
Propesty Value =
Low
Origin 5
Diate taken
Image
Dwnensions 1614 x 390
Width 1614 poosls
Height 390 ponels
Bt depth (7] = Low
File 12
Hame Livestraam Lowsr 3rd 1_D0000 png
e type PHG mage
Folder path C\Users'Livestream' Desidop Live
] Date created  10/5/2014 10:33 AM

To add an animated graphic, go to a graphics overlay channel. There are a number of templates
available for free in the Livestream Graphics Store. To quickly access one, select the Animated option
under Features. Scroll through the template options on the right side and click +ADD below the
corresponding design.
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Siream GFX1 GFX 2 Media 1 Media 2 Transitions

' Studio Graphics Store

Categori

Faaturas

Fulll Soraan
Lower Third Animated: Blue Globs -
¥ Animated 4 apD

) CREATE CUSTOM GRAPHIC BizaRRART RITERIFTAN 110

Livestream Studio will prompt you to select where you want to save the file on your computer’s hard
drive. Choose your destination and then click Select.

Select Folder for Animated Image Sequence

This GFX file contains an animated image sequence. Livestream Studio requires its
permanent copy on the disk. Please, specify the destination folder to extract the files

BROWSE CAUsers\Lvestream HDS0V

cancee  PUSEECTY

The graphics file will load in Livestream Studio and you can edit it in the same fashion as with any other
graphic.
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Media 1

MamnTithe

LOWER 3RD AN TITLE LINE

+ COLUME 4 AUTD PUSHIPULL

You can also add your own .png sequence or .mov file by selecting Create Custom Graphic > New

Layer.

Stream GFX 1

. Studio Graphics Store

Import Layer

55

Clock
Timer

LGSV over HTTP

Mew Layer

If you are adding a custom layer, open the designer by clicking the paintbrush icon, then click the
seguence icon. Select your .mov file, or open the folder that has your .PNG file sequence and select the
first file in that folder. The graphic will take a moment to render and then appear in the GFX Designer.
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From there, designing the overlay follows the same procedure as designing still graphics (adding data
fields, etc.).
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All other functions of the graphics overlay, including adding data, changing settings, and pushing and
pulling the layer are the same as other graphics.

Text Text 1

T Lannacs Produced Suppart

4 AUTD PUSHPULL
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Media Playback

485



Configuring Media Playback Settings

In Studio settings, go to the Media Player tag to configure settings for your media bins.

Settings: Media Player cance.  [JEAVEN

Project Format
Media Autoplay

Media Player

Streaming

Audio Bitrate per Channel

H.264 Encoder Profile Main

Media Autoplay allows you to choose if a video will either pause or continue playing when a media
source is transitioned out of Program. It also determines whether the video will continuing playing from

its current location (Pause) or start from the beginning of the IN point (Continue).

Pause Playback: The video will pause when manually transitioned out of Program. It will also pause
when it reaches the OUT point and not transition out of Program.

Continue Playback: Video will continue playing when manually transitioned out of Program. It will also

transition out of Program at the OUT point automatically.
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Settings: Media Player cance  [JERVED

Hedia Auloplay

Transcoding Files Localtion

Basnile
Recording

Media Player

Transcoding Files Location is where any transcoded videos (i.e., videos you bring into your media bin)
will be saved. You can bring those videos into a media bin again without transcoding.

Media Aistaplay

Transcoding

Media Player

Streaming Bitrate

Transcoding Cache lets you control the amount of data stored in the transcoding folder before files are
deleted. You can also manually clear the cache here.

Transcoding Files Locatson
BROWSE
Cache

tecording

CLEAR CACHE

Media Player

Streaming Bitrate

Web Contro

487



Transcoding Bitrate determines the bitrate to which the videos are transcoded. Higher bitrates will have
higher resolution but also create larger files.

Transcoding Filles Localiodn

Cache

Bitrate

Basic Replay i sec. before current timestamp

Basic Replay lets you tell Livestream Studio how far back from the current timestamp to set an In point.
The Out point will be set to the current timestamp.

Media Player

Streaming

Basic Replay 0 seC. before current imestamp

Export Location

You can export videos or portions of videos from your media bin. You can choose their export location
and video settings here.
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Media Player
Streaming

Basic Replay

Export Location

Video Settings

Ad Insertion
Audio Setti
Hot udie >etnngs

Mouse | Touch

H.264 Encoder Profile

Support

Scanning Method

About

Bitrate

75 (Mbps)

10 sec. before current timestamp

Resolution

Bitrate 5000

Key Frame Interval

Samplerate

Audio Bitrate per Channel

Main

Interlaced

When your media bin settings are configured to your liking, click Save.
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Media Playback Supported Video Formats

Livestream Studio can accept most common video format files.

The codecs listed below are from "Supported media formats in Media Foundation (Windows)
Supported media formats in Media Foundation (Windows). Microsoft, 28 Nov. 2012. Web. 7 Feb.
2013: http://msdn.microsoft.com/en-us/library/windows/desktop/dd7/57927%28v=vs.85%29.aspx.

Please note that Studio does not support Apple-only based formats (e.g. ProRes).

File Containers:
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Format File Media Media Requires
Extensions  Source Sink
3GP 392, .3gp, MPEG-4  3GPFile Windows 7
.3gp2, File Sink
.3gpp Source
Advanced Streaming Format (ASF) asf, wma,  ASF ASF Windows
wmv Media Media Vista
Source Sink
Audio Data Transport Stream (ADTS). aac, .adts  ADTS None Windows 7
File
Source
AVI avi AVI File None Windows 7
Source
MP3 .mp3 MP3 File ~ MP3 File File source:
Source Sink Windows Vista

File sink: Windows 7

MPEG-4 .m4a, MPEG-4  MPEG-4 Windows 7
.m4v, File File
.mov, Source Sink
.mp4
Synchronized Accessible Media .sami, .smi SAMI None Windows
Interchange (SAMI) Media Vista
Source
WAVE wav AVI File None Windows 7
Source

Audio Codecs
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Format

p-law
Caoding

Advanced
Audio
Coding
(AAC)

MP3

GSM 6.10

Windows
Media
Audio
(WMA)

Decoder

Audio Compression Manager (ACM)
u-law Codec

AAC Decoder

Windows Media
MP3 Decoder

ACM GSM 6.10
Codec

Windows Media Audio Decoder
Windows Media Audio Voice
Decoder

Encoder

None

AAC Encoder

None

None

Windows Media Audio Decoder
Windows Media Audio Voice

Decoder

Requires

Windows
Vista

Windows
7

Windows
Vista

Windows
Vista

Windows
Vista

Media Foundation provides wrappers for several ACM codecs listed in the previous table.

However, Media Foundation does not support arbitrary ACM codecs.

Video Codecs
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Format

DV
Video

H.264

MJPEG

MPEG-4
Part 2

MPEG-4
v1/v2/v3

Windows
Media
Video
(WMV)

Decoder

DV Video Decoder

H.264 Video
Decoder

MJIPEG Decoder

MPEG-4 Part 2
Video Decoder

Windows Media

MPEG-4 V3

Decoder Windows Media
MPEG4 V1/V2

Decoder

Windows Media Video 9
Decoder Windows Media
Video 9 Screen Decoder

Encoder

None

H.264 Video

Encoder

None

None

None

Windows Media Video 9 Encoder Windows
Media Video 9 Screen Encoder Windows
Media Video 7/8 En- coder

Requires

Windows
7

Windows
7

Windows
7

Windows
7

Windows
Vista

Windows
Vista
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Importing Videos into the Media Playback
Module

Livestream Studio has a video transcoder built into its Media bins.

In your media bin, press the + button in the bottom left corner.

INPUTS AUDID MEDIA 2

e,
00:00:00:00

| Austoplay = 3 OoD: 0000100

Browse your computer for your video, then select it from the file explorer. Livestream Studio will begin
transcoding your video immediately.

¥ If your video file is a Motion JPEG AVI and matches your project format, the media bin will
not need to transcode the file. Systems that have hardware encoding can also directly import
H.264 MP4 files of the same project format
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INPUTS MEDIA 2

How to Go Live.mov

L Transcoding...

¥ Autoplay = 00:00:00;00

Transcoding time depends on the clip length.

If you are having trouble transcoding your video, check that it can successfully playback in Windows
Media Player. Videos that cannot be played in Window Media Player will likely not be able to be
transcoded in Livestream Studio's media bins.
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Use Dropbox to Import Video Files

Videos saved in a Dropbox account can be imported into the Media bins in Livestream Studio
through a simple integration.

¥ For the best experience, we recommend simplifying your Dropbox folder structure to no
more than 1 or 2 subfolders. Multiple subfolders can cause extended sync times with
Dropbox

Connect Dropbox to Livestream Studio

Start by clicking the gear wheel in the upper right corner to enter Settings.

&% CPU 1:15:09 AM

PULL PULL PULL

Navigate to the Dropbox tab.
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Settings: Project Format CANCEL

Project Format
Broadcast Standard Ultra HD

Inputs ) e
High Definition mode

Outputs ow CPU Performance

Definition mode
Audio In

Project Video Format

Project Audio Format

Multi-View Deinterlacing

Method Blend Field

Ad Insertion

Click Connect Dropbox.

Settings: Dropbox CANCEL [ 'SAVE"

Project Format Please Connect Dropbox Account

Outputs

Audio In

tecording

Your browser will open. Sign in to your Dropbox account in order to connect it to Livestream Studio.
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' .
Sign in to Dropbox to link with Livestream Studio

G Sign in with Google

or

Forgot your password? m

When authorization is successful, return to Livestream Studio.

' | Livestream Studio

o

Authorization Successful

Open your Livestream Studio. You may close this window.
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The settings will indicate that you are logged in. Click Select Folders.

Settings: Dropbox CANCEL

Project Format

Inputs A

Outputs
SELECT FOLDERS
Audio In

Recording

Media Player

Choose a Local Folder from your computer's hard drive. This will allow any files you save to your
Dropbox, such as transcoded videos, to also be saved locally.

Select Folders

Local Folder

Remote Folder

CAMNCEL
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Then choose the folder within your Dropbox where the videos you want to use are stored. This can be
either your general Dropbox or a folder within your Dropbox (in this example, "Videos"). Click Save when
you are done.

Select Folders

Lecal Folder

Remote Folder

Dropbox
Lower Thirds
Videos
Projects

CANCEL

Your Dropbox account will sync to Livestream Studio.

Make sure that Use Files from Dropbox is checked. Then click Save.
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Settings: Dropbox canceL [TSAVE"

‘roject Format

nputs Local Folder
Dutputs

Audio In

Remote Folder

tecording

ledia Player CHAMNGE FOLDERS
Streaming %" lse Files from Dropbox

Neb Control

\TMP Server

Import Videos from Dropbox

Navigate to one of your Media bins. Click the + button in the lower left corner of the module.
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GEX 1 GFX 3 Media 1

00:00:00;00

B Autoplay = @ 13 00:00:00;00

Your Dropbox folder will open. Click on the video you wish to import, then click Select.

Select File

Highlightz.mp4

CANCEL
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Gelect File

hilary caze.mp4

Hockey Highlights.mp4

canceL  [POSEECT

The video will start transcoding in the media bin. When it is finished, you will be able to play it back as
normal.

GEX 2 GEX 3 Media 1

hockey highlights.mpd

00:00:00;00

B Autoplay = | 00:00:00:;00
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heckey highights.mpd

o519

D0:00:00;:00 [
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Controls & Options in Livestream Studio
Media Bin

Each Media Bin comes with a variety of controls and options for playing back your clips.

Select the desired clip you want to play to highlight it. It will appear in the player to the right.

INPUTS ALDID MEDIA 2

gt ighlights
“ 0000 20: 24 [,.

W Autoplay = t 00:00:00;00

The bottom left of the module includes general playback options. If you want to your video to start

playing as soon as you transition it into Program, make sure Autoplay is checked. Otherwise, your video
will start on a freeze frame.

To the right of Autoplay is Playlist, which will play all video files in your bin chronologically with no break
or black frames in between. When the last clip plays, Studio will automatically transition from the Media
Bin to the source in Preview.

Next is the Loop Playback button, which will play the selected video on repeat rather than play the next
clip or transition to the Preview source.
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Selecting both Play as List and Loop Playback will play all of your clips in order, then restart from the top
when the last clip ends.

INPUTS

highlights
“ 00:00:20;24

& Autoplay

At the bottom of the player are player controls and a blue time bar. Use your mouse to drag the red
scrubber to any point within the clip.

00:00:00;00

00:00:00;00

7 00:00:20:25

With your mouse, you can drag and drop both ends and set In and Out points if you want to playback
only a portion of your clip. You can also set In and Out points by dragging the scrubber to the desired
point and pressing the corresponding In or Out bracket button above the timeline.
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00:00:14:18

The main playback controls primarily control where the scrubber moves to. They are:

Jump to beginning of the entire clip

Jump in In point

Frame back

Play from In point to Out point

Play from scrubber's current location to the end of the clip
Frame forward

Jump to Out point

® N O s NN

Jump to end of the entire clip

00:00:03;14 ! I | J oo0:00:14;19

00:00:02;26

There are default hotkeys set for various media playback options, which you can find and custom
configure by navigating to Settings: Hotkeys.
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Settings: Hotkeys cancer [FERVER

Project Format

RESET TO DEFAULTS

Inputs

QOutputs Goto Startof Clip G

Audio In Go Back One Frame

Reverse Selected DDR |

Stop/Play DDR

Forward DDR

Go Forward One Frame

Go to End of Clip

Dropbox
Play In to Out i

Multi-Screen
GotoIn U

Ad Insertion

Set In (Use Current Position)
Hotkeys
Set Out (Use Current Position) 0O
e | Touch

Goto Out P

Toggle AutoPlay On/OffDDR [

Plaw Plavlict [Sinale NN 1

Q When Loop Playback is turned off, Studio will countdown your video from 20 seconds
(yellow) and then 10 seconds (red), allowing you to prepare your next source in Preview.
When the clip reaches zero, Studio will seamlessly transition from the Media Bin to the source
in Preview.
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00:00:0

0001124
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Basic Video Replay While Recording

Livestream Studio allows you to play back media while you are recording it for easy, basic replay
options during a live event.

To start, make sure that one of your Media Bins is selected in the Recording section of the Livestream
Studio settings.

Settings: Recording CANCEL | SAVE

Record to Media Bin (@ Wedia 1

Media 2

Your media will automatically populate within the selected Bin once the recording has started.
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CAM 3 - FS01AT 1.

€@ Thereddotto the left of the clip duration indicates that this clip is currently being recorded.

When recording, the clip in your Media Bin will behave much like any other media. You can set an IN
and an OUT point for playback and scrub along the timeline as well. The main difference is that the
timeline is growing as long as the recording process is active which does not occur when using pre-
recorded media.

By default, pressing R on your keyboard will set IN and OUT points on your clip for the most recent 10
seconds. Transitioning that media bin into Program will automatically playback that section of your
recording. You can adjust this setting under the Media Player tab in settings.

Q Make sure Continue playback (in Settings: Media Player) is turned on and Loop playback and
Play as list (buttons in the Media Bin) are turned off. This will cause your clip to playback and
then switch back to the source in Preview automatically. The Media Bin will display a
countdown until the clip ends, and then switch with Preview with no black frames or freeze
frames.
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Settings: Media Player CANCEL | SAVE

Basic Replay 10 sec. before current timestamp
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Exporting Clips from Livestream Studio

The media bins have an export tool that allows you to save your recordings or clips of recordings in
them as .mp4 files on your hard drive.

First, select a video you want to export.

CAM Y - 20150097 1...
m 0000 0855

16:07:51:45 [ ] 16:08:0148

Set In and Out points for your clip. If you want to export the full video, make sure the brackets enclose
the entire timeline.

W i

16:06:12;55 [ ) 16:10:27:08

When you are ready to export your clip, click on the arrow icon next to the video's name.
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CAM 3 -2015.01.17 1... »

I

The double arrow button at the top of the interface turn blue and show a small progression bar as your
clip is exporting.

Click on the button to view your transcoding queue. This will tell you how much time is left in your clip
and the status of any other transcoded or exported video.

PROGRAM Transcoding Queue

CAM 3 - 20150717 16.04.5/.mp4
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Remote Cameras
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Activating Bonjour Service for Remote
Camera Sources

In order to use remote cameras in Livestream Studio, you must make sure you have Bonjour
service installed and activated on your Windows computer. Remote cameras will not work without
Bonjour running.

Bonjour is pre-installed on Studio hardware units (e.g. HD31, HD51, HD550, etc.) and is always
running on Mac systems. Customers who only purchased the software should have gotten a
prompt to install it.

To install Bonjour manually, click here and click Download.

Once the software has finished downloading, open the installation wizard.

W  BonjourPSietup.exe

Follow the on-screen prompts to complete the installation.
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[ e—

' i ‘Welcome to the Bonjour Print Services Installer

/7 You wil be guided through the steps necessary to install
Bonjour Print Services. To get started, dids Next.

2.0.2.0 x64

<pack | Next> || Cancel |

To ensure Bonjour is running, first make sure Studio is closed. Then open the start menu and type
Services. Click the Services icon that appears at the top of the menu.
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— B h & More
Best match
1]
Services
- Apps
-
®. Component Services
Settings
Web
O
services{

Look for Bonjour Service in the menu and select it.
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Senvices - ] X
Fike Action ‘iew Help
i = r H |
Services (Local] | Services [Lecall
Bonjeur Service HName Descnphon Statug Startup Type L ™
St |rataller (Ecing] 5] Fronndil Uger Feldray il Les
_-:hlll_i::::tu LAy Rowter Service Seutel Allleyn ... Marual [Trgger .. Les
S App Readness Qe pps read.. Py il L
Applicateen idesbby Teteirmire s Marsal (Trgger . Les
Description Sl Applicaten Info Faciligatei the 1. Runsing Margal [Tigger . Ls
::_:‘I::::I:?!:;:L:::;illl Lpphcaten Laver Gabemy Senice R g SUSE. Blar L
condigure Eherselies on the — Applhciten Manigimest Froceases initi..  Runfang P al L
nd advertise their presence Lpp Daployerssn Service (Appicivd) g g, [P AF L
Lute Time 2o Update Auomabically - Disabled L
Eachkground Imieligent Trarder Servace Transfersfiles .. Rurming  Astoewatic Dela. Lo
Eachground Tasks Infrctruciun Senice Windoasinfre.  Runming  Asbomatic Lo
Eaue Fitenng Engne That Base Fikeri. Rumming  Asbeematic L
BitLocier Dbt Encryption Service EOESNTC hosts .. Marwal [Trigger . Lo
Block Level Bachoup Engine Serice Thae WEEMIGIL. [P L
Eluetcoth Handsfree Service Enabbes wirees_. Marwal [Trigger . Lo
Bluetcoth Support Sendce The Blugtooth .. Marwsal (Trigger . Lo
=3 Eonjour Senice Enables haedw.. Running  Autoenatic
EranchCache This service Ca. Barusa He
S Certificate Propagation {opies user cer.. Maria L
G Chient Liverse Senice (OSpSWC) Prowides infoas_. Marwal {Tigger .. Lo
55 CHE Key lsolation The (MG keyis.. Rurming  Marwal (Trigger-. Lo ¥
3 ¥

Edtended / Slendeed

Right-click it and click Restart.

s Bluetooth Handsfree Service
2 Bluetooth Support Service

£ BranchCache
&) Certificate Propagation
£ Client License Service (C

£: CNG Key Isolation
<

All Tasks >

Refresh

Properties

Help

Close out the menu and relaunch Studio. Remote cameras on your network should now be detected by

Studio.
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Overview of Studio Remote Camera
Options

Livestream Studio includes a variety of ways to bring in a source over your local network or by
other remote means. Below is an overview of what remote sources Studio supports.

Remote Desktop Client (Windows & macOS)

With the Livestream Remote Desktop Client for Windows and Mac, you can bring another computer's
desktop screen or camera source(s) and audio into Studio over your local network. Install and run the
small application onto the system you want to use as a source and make sure that it's connected to the
same network as the computer running Studio. Then you can add it as a remote input.

Livestream Mobile App (iOS & Android)

If you want to bring in your mobile device's camera, you can do so via the Livestream mobile app for
iOS and Android. This will require you to log into a Livestream account; if you don't have one you can

join via the app for free. Also, be sure your mobile device is connected over Wi-Fi to the same network
to which your Studio system is connected.

Mevo Cameras

Through our partnership with Mevo Inc., any Mevo camera can be a remote camera input in Studio over
your local network. Connect Mevo to your network and it will be available as a remote camera option in
Studio (provided it is not already streaming or recording on its own). You can then control a handful of
Mevo's options and settings directly in Studio.
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NewTlek NDI Inputs

Studio can accept any input outputting a signal via NewTek's NDI protocol, such as PTZ cameras, Adobe
Premiere Pro, and much more. Provided both products are on the same network, Studio can
communicate with the NDI source and bring it in as an input at very low latency.

Livestream Broadcaster Devices

If you own any Livestream Broadcaster product, you can set it to Studio mode and use it to bring in any
HDMI source over your local network.

In addition to local network remote cameras, there are a few other ways to bring in sources outside of

your network.

Live Interview

Send a URL to anyone regardless of their location to bring in their webcam and microphone via their

desktop browser.

RTMP Input

Send a stream from another encoder to Studio directly via an RTMP URL and Stream key provided by
Studio.
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Stream Playback

Playback streams from Livestream or other providers (latency varies).
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Using the Remote Desktop Client for
Windows

In Livestream Studio, you have the option of using a Windows desktop system as a remote camera
source by connecting it to Studio over your local network connection. This is great for adding a
slideshow presentation into your production.

Installing & Configuring the Remote Client

First, be sure to connect your remote Windows computer to the same network access point to which
the computer running Livestream Studio is connected.

o Download the Remote Desktop Client onto your Windows computer here.

Open the downloaded file and follow the on-screen steps to run the installation wizard, then click Finish.
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23 Livestream Studio Remote Camera Setup *

N =Si=: 110 Welcome to the Livestream
Studio Remote Camera Setup

Wizard

The Setup Wizard will nstall Livesiream Studio Remote
Camera on your computer. Click ™ext™ to continue or
“Cancel” to exit the Setup Wizard.

Remote Camera will launch in the background of your PC. Right-click on the icon in the bottom toolbar

and select Settings.

Laundh on Windows startup

Ched: for Uipdates...

setbngs...

034 AMA
] ﬁ

53207

Here you can adjust your remote camera’s name as well as set which video and audio signals are visible
from that PC. In this example, only the Desktop screen is visible, but other video sources that are later

added to this computer can also be detected (e.g. webcams).
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Livestream Studio Remote Camera Settings

My PC

J Deaskiop = Color LCD

& Doskiop - DELL 2505FFPW

Web Cam - FaceTime HD Camera (Bullt-In)

Encoder Framerate

Computer Name: The name that will appear in the remote camera module for your remote camera

source.

Checked sources will be available to use from this system as a remote camera source. This includes any
connected cameras and screens. Uncheck any sources you do not want to Studio to access.

Encoder Quality: The resolution you want the video to stream over your network to Livestream Studio.
Slower CPU's should use a lower resolution.

Encoder Framerate: The frame rate you want the video to stream over your network to Livestream
Studio. Slower CPU's should use 'half-speed FPS (30p).'

Add the Remote Desktop to Studio

Back in Livestream Studio, go to the Inputs tab. You can add your remote PC to Studio by selecting Add
Input > Remote, then select the name of your PC.
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INPUTS J  Mate Gelman's Mac

£ Webcam 1 My PC

Local Camera > B Mevo-11PD13

Remote > | Add Remote Input
Live Interview

Stream

Media

GFX

Audio Only

ADD INPUT

The Remote source will be added to your list of inputs. You can rename it if you wish or change it to a
different remote source from the drop-down menu that appears. You will also see a status (e.g. "Perfect
streaming”) indicating its connection strength.

To configure settings for the remote input in Studio, select the gearwheel to the right of the input.

e Remota 1

Under the General tab, you'll see additional options:

Video Source: The remote client has the ability to use either the system's desktop, an attached webcam,
or an installed Blackmagic capture device as a video source. Use the drop-down menu to select which
one you want to use.
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Monitor: If you select 'Desktop’ as the video source and the remote system has multiple displays, you
can configure which display you would like to use as a source by selecting it from the drop-down menu.

Capture Device: If you select a Blackmagic Capture Device as your video source and have more than
one installed on your system, choose which one you want to use.

Audio Source: You also have the option of selecting from any of your available audio devices. The
default is the standard system audio output.

Capture Mouse Cursor: Unselect this option if you would not like to see the mouse cursor on the
remote system.

INFUTS ALUDIO MEDIA 2

Remote 1

{3} General Video source

Daskiop

JTE Audio

Conwvert e w - lI‘u’E‘St ream

RELL S5

‘O Crop

Delay gt siins Mew Praduct Announcemert
¥

Livestnaam
Color

& Capbure mou

Learn more about configuring additional input settings.

Troubleshooting

If you are not seeing any options on the list within the Remote Cam tabs, please check the following:
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» Make sure the remote system is on the same network, connected to the same Router or Access
Point as your Studio system.
» If the system is on the same network but using a different access point, the Remote Camera will

not properly connect.

« Check that the following ports are open if you use a firewall:
« UDP: 5353, 60936 - 61036
TCP: 60936 - 61036

» Check that Bonjour Service has started.
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Using the Remote Desktop Client for
mMacOS

In Livestream Studio, you have the option of using a macOS desktop system as a remote camera
source by connecting it to Studio over your local network connection. This is great for adding a
slideshow presentation into your production.

Installing the Remote Client

First, be sure to connect your remote macOS computer to the same network access point to which the
computer running Livestream Studio is connected. You will then need to install the Studio Remote
Desktop client.

o Download the small program here.

Double-click the Livestream Studio Remote Camera.dmg file in your Finder to start the installer.

ano L Downloads

Enn B3 B - Q

|
FAVOIRITES

&3 Dropbox

e All My Files
= AirDrog

o Applications
| Desktop

ﬂ Downloads

% Documents

1 Mowies
_.'.' Music
L2) Pictures

% Creative Cho..

DEVEICES

-

Livestrea... &

SHARED

E5 supportnocd
2 AL Mars . e hlodiBed . Kinad

TAGE & Livestrearm Studic Remate Camera Beta.dmg
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Drag the Livestream Studio Remote Camera into the Applications folder.

Nlivestream
e
- . | |
A
Livestream Studio Remote Applications
Camera

<)

Download Audio
Redirector

Go to the applications folder and double click on Livestream Studio Remote Camera to open the

application.
| FAVORITES
L All My Files ci
@ AirDrop iTerm iTunes Keynote

-A Applications

[ Desktop
©) Downloads E {i
@ Documents st
§ Livestream Livestream Studio Mail
EE Movies Producer Remote Camera
Kdiicir

You will see this window pop up indicating that the remote camera icon will appear in your menu bar at
the top of your screen. You can choose to prevent the message from appearing again.
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-

Welcome to Livestream Studio Remote Camera

1. Launch Remote Camera by selecting its icon from the menu bar
at the top of your screen.

2. Use Livestream Studio to pull your desktop, or any camera from this
computer into your live production.

Make sure the remote system is on the same network as your Livestream Studio system. It will run in the
background until you close it. You can close it by clicking on the icon in the menu bar and clicking

Close.

When the Remote Client is running, you can click the icon and click Settings to make further

adjustments to your remote camera source.

BN @009 @

v Launch on startup
Check for Updates...

Download Audio Redirector
About

Close
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Livestream Studio Remote Camera Settings

Emily’s MacBook Pro

| Deskiop - Color LCD

W Desktop - DELL 2405FPW

W Wab Cam - FaceTime HD Camera (Built-in)

HD 1080p
HD T20p

SD 480p

Hal-spaad FPS (30p

-spead FPS

Computer Name: The name that will appear in the remote camera module for your remote camera
source.

Checked sources will be available to use from this system as a remote camera source. This will include
any connected cameras and screens. Uncheck any sources you do not want to use.

Encoder Quality: The resolution you want the video to stream over your network to Livestream Studio.
Slower CPU's should use a lower resolution.

Encoder Framerate: The frame rate you want the video to stream over your network to Livestream
Studio. Slower CPU's should use 'half-speed FPS (30p).'

Adding and Configuring a Remote Source in Livestream
Studio:
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Once the client is installed on the remote system and is running, you can use it as a source in Livestream
Studio.

In Studio, navigate to the Inputs tab then select Add Input > Remote. If Studio can find the remote
system over your local network connection, you should see it come up as an option.

MNate Gelman's Mac

=

Emily's Macbook Pro

Local Camera > B Mevo-11PD13

Remote > | Add Remote Input
Live Interview

Stream

Media

GFX

Audio Only

ADD INPUT

Select your Mac computer to activate it in Studio. It will appear in the bottom of the Inputs list.

You can hover your cursor over the name (e.g. "Remote 1") and click the pencil icon that appears to
rename it. If you need a different remote source, click the drop-down menu to select one. Next to this
will be an indicator informing you of the connection status (e.g. "Perfect Streaming”).

Click the gear wheel next to the far right of the remote camera source in the list to access further
settings.
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Video Source: The remote client has the ability to use either the system's desktop, an attached webcam,

or an installed Blackmagic capture device as a video source. Use the drop-down menu to select which
one you want to use.

Monitor: If you select 'Desktop’ as the video source and the remote system has multiple displays, you
can configure which display you would like to use as a source by selecting it from the drop-down menu.

Capture Device: If you select a webcam or other connected camera as your video source and have
more than one installed on your system, choose which one you want to use.

Audio Source: You also have the option of selecting from any of your available audio devices. The
default is the standard system audio output.

Capture Mouse Cursor: Unselect this option if you would not like to see the mouse cursor on the
remote system.

INPUTS ALDIO MEDIA 1 MEDIA 2

Remote1 ~

{} General Video source

lj} Audlo

Maonitor

Comvert W . livestrEam

DELL 2405FPW
Il Crop
Audio source

Delay Mew Product Announcement

LisesireambDesiiop. .
) Color

NG MOUSe cursor

Status

Learn about additional input settings.
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Troubleshooting

If you are not seeing any options on the list within the Remote Cam tabs, please check the following:

« Make sure the remote system is on the same network, connected to the same Router or Access
Point as your Studio system.

« If the system is on the same network but using a different access point, the Remote Camera will not
properly connect.

« Check that the following ports are open if you use a Firewall:
« UDP: 5353, 60936 - 61036
« TCP: 60936 - 61036

» Check that Bonjour Service service is enabled on the Studio system.
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Adding a Remote Live Interview

Livestream Studio customers can add a live webcam source from another location into their Studio
production. This is called Live Interview.

Interview guest(s) will need an Internet connection, Google Chrome, a webcam, and a microphone
connected to their computer.

Q It is strongly recommended that audio is provided to any local hosts or interviewer directly via
the headphone out jack on your Studio unit using headphones, IFB's, etc. Otherwise, there
will be a distinct echo in your stream during the interaction.

@ Liventerview currently only works on desktop Chrome; there is currently no support for Live
Interview via mobile devices.

Navigate to the Inputs tab. Select Add Input > Live Interview > Live Interview.
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Local Camera

Remote

Live Interview > a Live Interview

Stream
Media
GFX

Audio Only

ADD INPUT

While you can send an invite to as many people as you like, only one Interview can occur in
Livestream Studio at a time.

The Live Interview will appear at the bottom of the inputs list. Select the corresponding gearwheel on

the right side to configure it.

2 Liva Interview Waiting far gue

In the General settings, there are two tabs: Invite and Chat. The Invite menu is open by default.

You will be provided two unique URLs: Guest invite and Moderator invite. Press the Copy button to copy
the corresponding URL to your clipboard and provide the URL to your guest(s) via email or other means).

537



INPUTS MEDIA 1 MEDIA 2

Live Interview ~

Ganearal INVITE i

: Audio
Guest invite

Convert = — Waiting for guests to join...

Crop Moderator invite

-47dT-aefT-5ead2e1044Td COPY
Delay

Moderators can manage and prap guesis.

When someone opens on the provided Guest Interview URL in Google Chrome, they will be prompted
to allow the camera and microphone to be accessed (This is required in order for the interview to work).
They can then type in their name, then click Join Interview.

B https:ffinterview.livestream.com/interview/?}

. . . Ic
interview.livestream.com wants to

& Use your microphane

B Use your camera

Block Allow
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Are you ready to join the Live Interview?

Enter your name and click "Join Interview" to start.

The optional Moderator Invite URL can be given to a third person who can select between each guest
camera to show in Studio via their Chrome browser. The moderator's camera and microphone will not

be used but they will be able to see and hear all connected guests. The moderator is also connected to
the chat to help communicate with all interview guests and the producer.

When a guest has joined the Interview, they will see their camera feed, a Connected notification, and
have access to the internal chat with you (the Producer), the Moderator, and all connected guests.
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LR TR

In Livestream Studio you can see this chat as well by selecting the Chat tab.

INPUTS

Live Interview ~

L} General INVITE

1ii Audio

Convert

o crop

Delay

You can bring in the guest's camera by clicking the Select guest drop-down and clicking their name. You
can have as many guests as you wish in that list, but you can only select one guest at a time.
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INFUTS MEDIA 1 MEDILA 2

Live Interview

{} General INVITE fguest (1)

il Audic

Guest Invite
Caimvadt - - Select a guest to join the interview.

Crop Moderator invite
Dalay 47d7-aefT-Sonddel 0447d COPY

b eilgl b ighle 4 and prap 49

After clicking a name, the guest's camera will appear in the input source, which you can switch to
whenever you are ready.

The guest's view will change to seeing their camera in the lower left corner and overlay a larger view of

what is currently in Program. They will also hear Program audio and a Preview notification in the upper
right-hand corner of the screen.
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When the guest's camera is switched into Program, they will see a red On Air notification in the upper
right-hand corner.

By default, the guest will hear Program audio but not hear their own audio, even when they are in

Program.

CHAT i

Producer
Connected to chat

Producer
Hello

Some other controls the Guest will have include:

» Leave Interview: They can exit the interview.

» Hold: Will pause the stream from sending to Studio. They can then click Resume to start sending
their feed to Studio again.

» Mute: Will Mute their microphone

» Stop Video: Will stop sending their video (but will still send audio)

» Settings: Allows users to select a different webcam, audio source, and show or hide the Program
feed from Studio.

Learn about additional input settings.
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Newlek NDI Integration in Livestream
Studio

Livestream Studio includes NewTek NDI Integration, allowing you to input or output video sources
over your local network with other NDI enabled software and devices.

What is NewTlek NDI?

NDI, which stands for Network Device Interface, is an open protocol developed by NewTek that allows
for high-quality video & audio signals to be transferred between devices over a local area network (LAN).
In other words, different video software products with the NDI tools and applications installed--such as
Livestream Studio, TriCaster, Adobe Premiere Pro, and more--can now communicate their video signals
to each other over your local network with very low latency.

IS NDI|HX Supported?

Yes, provided that you are using Studio 5.0 or higher and you have the NDI|HX driver installed on the
computer running Studio. You can find the driver download here.

How Do | Set Up NDI Integration with Livestream Studio?

All you need to to do is make sure you are running version 4.5 (or later) of Livestream Studio and make
sure it is connected to the same local IP (i.e. same network) as any other NDI enabled devices you wish
to use with Livestream Studio. The integration is built into the software.
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How Do | Bring In Another Source via NDI?

First, you need to have another NDI enabled source connected to the same network as your Livestream
Studio system. This example will show a looping graphics sequence in Adobe Premiere Pro running on

an iMac. Learn more about Newtek's NDI tools and downloads.

4, D0;00:20:00

In Livestream Studio, navigate to the Inputs tab in the lower left corner. Select Add Input > Remote. Any

available NDI source will appear in the menu for you to select.
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Local Camera > | S\ NDI: MATTHEWS-IMAC.LAN (Adobe Premiere Pro)

Remote » | Add Remote Input
Live Interview

Stream

Media

GFX

Audio Only

ADD INPUT

Your NDI source will appear in the bottom of your Inputs list and in your multi-view along with all other

inputs. You can switch it into Preview and Program as you would any other source.

-

A key feature with NDI is alpha channel support. This means a source like the one shown above, which
is a looping graphic with no background, can also be brought into Livestream Studio with a transparent
background.

To enable this in Studio, navigate to one of the GFX menus, select Create Custom Graphic and click
New Layer.
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STREAM GFX 1

. Studio Graphics Store

Import Layer

Clock
Timer
CSV aver HTTP

New Layer -

LREAIE LUa il Win GRAFTIL

Click the paintbrush icon to open the GFX Designer.

To bring in your NDI source as a graphic, click the camera icon.
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§7 GFX 1 Designer Jm | x

Your first input source will appear. Click the corresponding gearwheel to select your NDI source. Notice
that the graphic has a transparent background, rather than a black one.
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Make any appearance adjustments as necessary (in this example, we cropped the empty space and
dragged the graphic to the bottom to make it a true lower-third graphic).
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When you are satisfied with your NDI source's appearance, close the GFX Designer.
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I7 GFX 1 Designer (m|

Now you can use your graphics overlay controls in the upper right corner of Livestream Studio to bring
in your NDI source as a graphics overlay with alpha channel support.

PROGRAIM
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How Do | Output via NDI?

Setting up an NDI output is similar to setting up a normal live video output. The difference is that instead

of using a video card and video cables to output your Program or another Studio source, you are

outputting over your local network.

Click the gearwheel in the upper right corner to access settings.

I TR

PULL PULL PULL

Navigate to the Outputs menu.

Settings: Project Format

Project Format
Quality and Format

Definition

Streaming Optimized

Ultra HD
HD

Media F'l:E:..'Ffr Low Definition

The lower half of the menu is the NDI Outputs section. Click the + button to add an NDI output.
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@ Studio supports a maximum of five (5) NDI outputs.

Settings: Outputs cance. [NSAVEY

Outputs

Humber of AUX Mixes

NDI Outputs

By default, your Program will appear as the output. Click the drop-down menu under Camera to select a

different source.

You can rename the field under Device if you wish; this name is what your NDI output will be shown as

in other NDI recognizing devices.
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NDI Qutputs.

After selecting your output(s), be sure to save your settings.

Settings: Outputs CANCEL

Outputs

Number of AUX Mixes

Now other NDI enabled devices and software on your network will be able to bring in your selected
output(s) as a source or input (e.g. other Studio systems, vMix, TriCasters, etc.)

My NDI Sources are Buffering, How do | Prevent This?

If you notice buffering or lag in your NDI sources, you can reduce the bandwidth required to bring them
in
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Find your NDI source from the Inputs list and select the corresponding gearwheel to enter its settings.
Navigate to the Convert tab on the left side.

INPUTS MEDIA 1

NDI3 ~

{3} General

pudio Converter -

Convert NDI 3 Format
Crop Auto (HighRes)

Auto (HighRes)
PTZ HighRes (1080p 59.84)
LowRes

Delay HD 1080p 29.97

{ Color i

By default, the converter is receiving the signal in HighRes mode. Open the drop-down menu to switch

to LowRes. This will convert the NDI to a lower resolution, which will soften its appearance but deliver
the video signal more steadily.
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Using Mevo as a Remote Camera

Livestream Studio can accept Mevo as a remote camera source when connected to the same

network.

Make sure that your Mevo is turned on and connected to the same local network as your Livestream
Studio machine. If it is not connected to the same network (i.e. to the same access point), Studio cannot

recognize Mevo.

When Mevo is on your network, Studio will automatically detect it. There is no need to open the Mevo

app to enable it as a remote camera.

@ You must be on Studio version 6 and Mevo version 1.13 with the latest firmware. These are
not compatible with older versions and do not support this workflow. When you launch the
Mevo app and are connected to your camera's hotspot, you will see a prompt to Update
Firmware if your camera is not updated.
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AUDIO MEDIA 1
MNate Gelman's Mac

B Mevo-11PD13

Local Camera > [ Mevo-124RA

Remote > | Add Remote Input
Live Interview

Stream

Media

GFX

Audio Only

ADD INPUT

You cannot start a separate stream or recording from Mevo while Studio Remote Camera
Mode is enabled.

Your Mevo will appear on the bottom of your Inputs list. You can rename it by hovering your cursor over
its name and selecting the pencil icon that appears. You can select a different remote source by opening
the drop-down menu. When your Mevo is connected, a status message will appear here as well (e.g.
"Perfect streaming’).

To further configure and control your Mevo, select the corresponding gearwheel icon to the right.

B mevo1 Mevo-124RA

Many of Mevo's basic settings in the Mevo app are configurable directly in Studio in the General tab. This
includes the camera's name, resolution, frame rate, password protection, the Mevo button's setting, auto
turn off, auto-wide on app disconnect, and speaker and LED ring settings.
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Any of these settings that you change in Studio will also be reflected inside the Mevo app. Keep in mind
each setting will need a few seconds in order to take effect.

MEDIA 1 MEDIA 2

General

Adjustmants e

Mevo-124 /8

Convert
Resolution

| : Crop T30p ! 7.5 Mbpa

Deday Frame Rate

2097 FPS

Require Password

. O

In addition to these general settings, the Adjustments tab will allow you to customize the Mevo's image,
including exposure, shutter speed, I1SO, white balance, brightness, contrast, saturation, sharpness, view
angle, exposure metering, image flip, electronic image stabilization (EIS), and anti flicker settings.

These are the same settings found in the Mevo app's Adjustments menu and any changes made to these

in Studio will be reflected in the Mevo app.
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INPUTS AUDID MEDIA 1 MEDIA 2

Mevo 1

{':} General Adjustmentﬁ

17 Audio .
resels

‘ Adjustments Mormal

Canvert Camara Mode
o Aubo Shuifte Manual
|l Crop
Expasiing

Delay

Use the Crop functionality in Studio to adjust your Mevo's shot. This allows you to configure up to four

preset shots with motion and transition control.

Studio does not include some Mevo features such as face detection, live follow, and auto-pilot; these
features are only controllable via the Mevo app. If you do use these features in the Mevo app, you will
not be able to control your Mevo shot inside Studio until you switch to a generic shot or wide shot in
the Mevo app.

Control Mevo Remote Camera in the Mevo App

You can still use the Mevo app to control your camera instead of Studio if you prefer.

After adding Mevo as an input in Studio as described above, connect your Mevo app to your camera via
Wi-Fi. You will notice the bottom left corner now shows a dark gray button indicating it is linked to
Studio but is not currently in Preview or Program. If you tap this button, the option to push it to the
Preview (PRV) or Program (PGM) monitors in Studio will appear.
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== STUDIO

Use your finger to slide the gray button to either PRV or PGM to put your Mevo into either Preview or
Program in Studio, respectively.

. & STUDIO

Once Mevo is in the Preview or Program monitor, tap the button again and slide it to switch it between
the monitors in Studio.

slide to cut | PGM

== STUDIO
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While Mevo is being used as a Remote Camera in Studio, you may still live edit your Mevo shot in your
Mevo app. This would include features such as face detection and live follow, but please note that while
these features are in use, you will not be able to change Mevo's shot via Studio until you cut to a generic
crop or a wide shot.

Your Mevo will output all crops and edits to Studio. Additionally, whichever crop preset in Studio is
activated will adjust to reflect the edit made in the Mevo App. Notice below, the cursor is not touching
the Take / Edit buttons, but the orange box (Preset 1) crops anyway; this was an edit made inside the
Mevo app.

Transition Duration Motion Damping Intensity

cut

Selecting 1080p / 15.0Mbps will disable all Camera Assistant features (Face Detection, Live
Follow, Auto Pilot, Static Shots). Panning and zooming via the Mevo app are also disabled, but

you can cut/crop your shot or use the crop features inside Studio.

¥ Once your Mevo is connected, check here for best practices and recommendations for using
Mevo as a remote camera source
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Troubleshooting

If you are not seeing any options on the list within the Remote Cam tabs, please check the following:

« Make sure the remote system is on the same network, connected to the same Router or Access
Point as your Studio system.
» If the system is on the same network but using a different access point, the Remote Camera will
not properly connect.

» Check that the following ports are open if you use a firewall:
» UDP: 5353, 60936 - 61036
TCP: 60936 - 61036

o Check that Bonjour Service is started.
» |f you've checked all the above steps and you are connecting over Ethernet, there could be a rare IP

configuration issue.
« |f Mevo is still not appearing, try connecting via [P_address.
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Connect Mevo to Studio via IP

If your local network has firewall or anti-virus restrictions in place and causes your Mevo to not
appear automatically as a standard Remote Input, you can connect a Mevo to Studio by finding its
IP address and entering it into Studio

To find your Mevo camera’s IP address, launch the Mevo app on your mobile device, tap Configure
Mevo and connect Mevo to the the same network to which your Studio system is connected.

ol Verzon = 11:28 AM & < 9 100% (-

\Vievo-23003

F332896 100%

Once Mevo is connected, tap the Info (i) icon to the right of the network name.
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Mevo Network Settings

~ F33896 e q ()

Known Metworks

AG LTE VIA IPHOME

Mevo Hotspot @

EGHz WI-FI NETWORKS

F33896-guest &8s ()
0116D4D0 &7 (1)
D415D6 a=s @

Select the Manual IPv4 tab; below this is the IP address, which will be four numbers separated by
periods.

{ Back F33896

Forget This Network

IP ADDRESS

Auto Manual IPv4 Manual IPvE ]

IP Address 192 I

Q You can also get Mevo's IP address from other network admins tools such as your Wi-Fi
router or DHCP server.

In Studio, open the Inputs tab, navigate to Add Input > Remote, then select Add Mevo by IP.
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AUDIO MEDIA 1 MEDIA 2

D Wakroarm A FaraTima HD Camera

Local Camera » | Add Mevo by IP

Remote » || Add Remote Input
Live Interview

Stream

Media

GFX

Audio Only

ADD INPUT

The below window will open prompting you to enter Mevo's IP address. Enter the IP address from Mevo,

then click Submit.

Connect a Mevo with |P address

Mevo's |IP address is available from your WiFi router, DHCP server
or other network admin tool.

IP address

CANCEL

After a moment, Mevo will connect to Studio, after which you can configure its settings and switch into
your production as you would if you connected through the standard remote camera process.
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Best Practices for Mevo as a Remote
Camera Source

If you intend to use Mevo as a remote camera source in Livestream Studio, our team has some
configuration recommendations for optimal performance

Project Format

First, under Settings: Project Format, you should select Streaming Optimized.

Settings: Project Format CANCEL | SAVE

Project Format
Quality and Format

Inputs

Definition

Outputs ® Streaming Optimized

Ultra HD
Audio In

HD

Recording Low Definition

Media Player Project Video Format

720p 30

Streaming

Choose a Project Format that matches your Mevo's Frame Rate. Doing this will increase the quality while
also reducing CPU usage that would otherwise be used to resize the Mevo's video feed.
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Project Format

Quality and Format

Inputs
Definition

Outputs L] Streaming Optimized
Ultra HD

Audio In

HD

Recording Low Definition

Media Player Project Video Format

720p 30

Streaming T20p 30

ontrol

If you need to output from Studio via HDMI or SDI, then you will need to select an HD format. In
Settings: Project Format, change the Definition to HD. This in case, we recommend using either
720p59.94, 720p60, or 1080p30. These will produce the best image quality but will increase CPU usage.
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Settings: Project Format

Project Format
Quality and Format

Inputs
Definition
Outputs

Ultra HD

Audio In

Low Definition
Media Plaver Project Video Format
Streaming

Zontrol

RTMP Server

Multi-Screen

Ad Insertion
PAL 16:9

When you select your Project Format, click Save.

Camera Synchronization

To avoid sync issues, it's best that you set your direct input sources to be delayed by one second. Studio
has an easy setting to do this.

Click the gearwheel in the upper right corner of Studio, then click the Advanced tab.

Navigate to the Remote Inputs Synchronization setting and select Delay All Inputs by 1 Second and
Synchronize. This will allow your wired inputs to compensate for the latency experienced by wireless
sources (in this case, Mevo) and sync them together.
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Settings: Advanced

Inputs

Outputs

Ad Insertion

Be sure to save your settings.
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Bringing a Broadcaster Signal into
Livestream Studio

Livestream Studio allows you to use your Livestream Broadcaster device as a remote camera

source.

Connect your Broadcaster to the same network as the Livestream Studio computer.

Livestream Broadcaster Pro

Power on the device and use the bottom Menu joystick to connect it to the same network that your
Livestream Studio system is connected to.

Please connect me
to the internet

Please wait...

After connecting it, push in the joystick to enter the menu and select Stream Mode.
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Toggle the joystick to Studio.

Livestream
rYStudio

) <5 =

Studiot! Ready
Bual: Fix.HD

In Livestream Studio, navigate to the Inputs tab in the lower left section. Select Add Input > Remote. You
can select your Broadcaster Pro from here, which will add it the bottom of your inputs list and your

multi-view.
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Livestream Broadcaster mini

You can also connect a Broadcaster mini to Livestream Studio as a remote camera. When you
finish pairing it through the Livestream app, using the same network your Livestream Studio system is

connected to, select it from the Broadcaster list.

2:25 PM

Broadcasters

Broadcaster mini -

Broadcaster-mini-00015 />

Broadcaster Pro

.....

Broadcaster _

It will open the camera viewfinder. Click on the gearwheel in the top right corner to access settings.

571



seeel Voriron F Z3PM & 9 % 85%

Penalty Shot

A

(S

Scroll down and you will see Studio Mode. Toggle the switch on (green) to enable Studio Mode. Then
click Save in the upper right corner.
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anas

Cancel Advanced Settings

WiFi Network

Name >

Studio Mode

Reset Broadcaster mini

The mobile app will indicate that your Broadcaster mini is in Studio mode.

Broadcaster mini is in
Studio Mode

Turn Studio Mode OH
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In Livestream Studio, navigate to the Inputs tab in the lower left section. Select Add Input > Remote. You
can select your Broadcaster mini from here, which will add it the bottom of your inputs list and your

muilti-view.

Livestream Broadcaster (V1)

Bringing a Broadcaster into Livestream Studio as a remote camera is very similar to bringing the
Broadcaster Pro into Livestream Studio.

Select Stream Mode from the Broadcaster menu, and then select Studio.

This will activate your Broadcaster as a live remote camera source.

T
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In Livestream Studio, navigate to the Inputs tab in the lower left section. Select Add Input > Remote. You

can select your Broadcaster from here, which will add it the bottom of your inputs list and your multi-

view.

Troubleshooting

If you are not seeing any options on the list within the Remote Cam tabs, please check the following:

» Make sure the remote system is on the same network, connected to the same Router or Access

Point as your Studio system.
« If the system is on the same network but using a different access point, the Remote Camera will

not properly connect.

» Check that the following ports are open if you use a firewall:
« UDP: 5353, 60936 - 61036
TCP: 60936 - 61036

» Check that Bonjour Service is started.
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Bringing an iOS Camera Signal into
Livestream Studio

Livestream Studio allows you to use your iOS device as a remote camera source. You will need a
Livestream account in order to use this feature.

Download the Livestream iOS application. Connect your iOS device via Wi-Fi to the same network as

your Livestream Studio system.
Open the Livestream iOS application and log into your Livestream account.

Q Don't have a Livestream account? Tap Continue with Email, then Sign up. This will create a
free account on Livestream and grant you access to the mobile app's features, including
Studio Remote Camera. Keep in mind a free Livestream account does not allow you to go
live to the Livestream platform unless you pay for a Livestream plan.

Tap the menu icon in the upper right, then tap the gear wheel. This will open the application settings.
Tap Studio Remote Camera and make sure Studio Remote Camera is enabled.

Then select the blue Livestream Studio Remote Camera bar.
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Optima Batteries

In Livestream Studio, go to the Inputs tab in the lower left corner. Select Add Input > Remote. If your

device is connected to the same access point as Studio, it will appear as an option for you to select.

Local Camera > @ Emily's iPhone
Remote 2 Add Remote Input
Live Interview

Stream

Media

GFX

Audio Only

ADD INPUT
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¥ If you click on the gear wheel next to your remote iOS source, you can change settings such

as which camera is being used and at what resolution

'ﬁl Remote 1 Emily's iPhone

Video source

Desktop

Monitor

Back 960x540

Front 9

& Capture mouse cursor

Troubleshooting

If you are not seeing any options on the list within the Remote Cam tabs, please check the following:

» Make sure the remote system is on the same network, connected to the same Router or Access
Point as your Studio system.
» If the system is on the same network but using a different access point, the Remote Camera will
not properly connect.
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» Check that the following ports are open if you use a firewall:
« UDP: 5353, 60936 - 61036
TCP: 60936 - 61036

» Check that Bonjour Service is started.
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Bringing an Android Camera Signal into
Livestream Studio

Livestream Studio allows you to use your Android device as a remote camera source. You will need
a Livestream account in order to use this feature.

Download the Livestream Android application.

Connect your Android device's Wi-Fi to the same network that your Livestream Studio system is

connected to.

Open the Livestream Android application. You will need a Livestream account to proceed with using the

app.

Q Don't have a Livestream account? Tap Continue with Email, then Sign up. This will create a
free account on Livestream and grant you access to the app's features, including remote
camera. Keep in mind this will not allow you to go live to Livestream unless you pay for a

plan.

Tap the menu icon in the upper left corner, then the gearwheel.
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This will open your settings menu. Tap Studio Remote Camera.

Studio Remote Camera

Tap Use as Remote Camera.
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USE AS REMOTE CAMERA

This will activate your Android device as a live Remote Camera source. The notification will read "Waiting
for Studio to connect...”

Q You can hold your camera at portrait or landscape mode; the picture will still hold a 16:9
aspect ratio.
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Waiting for Studio to connect...

In Livestream Studio, navigate to the Inputs tab in the lower left corner. Select Add Input > Remote. If
your Android device is connected to the same access point as Studio, it will appear in the list of remote
devices for you to select from.
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Local Camera > g Emily's Phone

Remote >  Add Remote Input
Live Interview

Stream

Media

GFX

Audio Only

ADD INPUT

The Android remote camera will be added to the bottom of your Inputs list, where you can choose a
different remote camera and see the connection status (e.g. "Perfect streaming”). Click the
corresponding gearwheel on the right to access additional settings.

i Remote 1 Emily's Phone

You can adjust which camera your device is using (front or back) by opening the Monitor drop-down
menu.
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Video source

Desktop

Monitor

Fron

& Capture mouse cursor

Troubleshooting

If you are not seeing any options on the list within the Remote Cam tabs, please check the following:

e Make sure the remote system is on the same network, connected to the same Router or Access
Point as your Studio system.
» If the system is on the same network but using a different access point, the Remote Camera will
not properly connect.

» Check that the following ports are open if you use a firewall:
« UDP: 5353, 60936 - 61036
TCP: 60936 - 61036

» Check that Bonjour Service is started.
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Bringing Other Streams into Livestream

Studio

If you have a video source streaming to another destination, you can pull that stream into your
Livestream Studio as a remote camera source.

Navigate to the Inputs tab in the lower left corner. Select Add Input > Stream. There will be a few options

here.

INPUTS

(=] GFX1

Local Camera

Remote

Live Interview

Stream

Media

GFX

Audio Only

ADD INPUT

RTMP Server is a different way to bring a stream into Livestream Studio and is covered here.

RTMP Server

RTMP URL

RTSP URL

Zixi URL

Livestream Event

Livestream Event allows you to pull in a stream from an event on Livestream.com as a remote camera

source. You must have the login credentials for the account hosting the event you wish to bring in.
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After adding a Livestream Event as an input, it will appear in the bottom of your inputs list and in your

multi-view. You can hover your cursor over the name (e.g. "Livestream evnet 1) and click the pencil icon
that appears to edit it.

Select the corresponding gearwheel to the right to configure the input.

Wi Livestream event 1 Sahup your

Log into the Livestream account that's hosting the stream you wish to bring in.

INPUTS MEDIA 1 MEDIA 2

Livestream event1 +~

General

3 Audio Log in to Livestrearm
Convert

1o crop

Dolay
- LOG IN & CONTINUE

) Color

By default, Studio can detect which of your events are live and bring it in automatically. Alternatively, you
can choose an event manually.
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INPUTS MEDLA 1 MEDIA 2

£ Livestream avent 1

{} Genaral

Status

lit Audlo

Convert Select Event
My Evant
10 Grop
Stream Cuality
Delay
& Highest
{) Color

Closest to

You can also bring in streams via RTMP, RTSP, and Zixi playback URLs, which can be provided by the

stream’s hosting platform. Select the protocol your stream is using from Inputs > Add Input > Stream.

Enter the appropriate playback URL for accessing the stream into the Stream URL text box, then press
the Enter key.

INPUTS AUDIKD MEDIA 1 MEDIA 2

RTMP 1

General
Stream URL
17 Audio
Convert

O Crop

Delay

{3 Color

Stalus

Please, enier a RTMP stream LIRL
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The stream will appear in the module. Expected latency will vary depending on connectivity strength,
but will likely hover around ten seconds.

Learn more about additional input settings.
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Setting Up Studio as an RTMP Server

With Livestream Studio, you can send a stream from a third-party encoder via RTMP directly to
Studio and bring that stream in as a source.

@ mportant: In order for this feature to work successfully, your network must have Port 1935
open to all communication, as it is a UDP connection. This port also needs to be forwarded
to the internal IP address of the machine using the server.

If your encoder is streaming to Studio from an external location (i.e. not from the same
network), you must ensure that both systems are on a public-facing IP address in order for
your encoder and Studio to communicate with each other.

Speak with your IT administrator if your network requires these changes to be made.

RTMP Input Basics

Go to Inputs and navigate to Add Input > Stream > RTMP Server.
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RTMP Server I

Local Camera > RTMP URL
Remote > RTSPURL

Live Interview > Zixi URL

Stream > | Livestream Event
Media

GFX

Audio Only

ADD INPUT

To configure the RTMP server, select the gearwheel icon to the right of the RTMP server input.

= RTMP sarver 1 Ma Incoming Straam

ADD INPUT

By default, authentication is turned off. If you would prefer to have a username and password affiliated
with your RTMP Server, click Change Settings.
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Change Settings

Mo Incoming Stream

live

OFF

% Enable RTMP Server

This will open the RTMP Server tab in Studio’s settings. Check Authentication and enter the desired
username and password; then click Save.

Settings: RTMP Server

-

Project Format

Inputs

Outputs

Media Player

Streaming

Server Name

live:

& Authentication

Username

Password

Reguired Field

Reguired Field

CANCEL

SAVE

Scroll down in the General tab; your RTMP URL and Stream Name are displayed in this menu.
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INPUTS

RTMP server 1

{3 General &' Enable RTMP Server

Audio RTMP Server URL

Convert
Crop Stream MName

PTZ serveri

Delay Transition to program

Start stream

DOWNLOAD FMLE SETTINGS

¥ o save time copying and pasting, Studio gives you the option to Download FMLE Settings,
which you can then import into your encoder
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RTMP server1 ~

{3 General

RTMP Server URL
Audio

T Stream Name
Crop server
PTZ

Transition to program

Delay
Start stream

When RTMP stream ends:

DOWNLOAD FMLE SETTINGS

In your third-party encoder (e.g., Wirecast, OBS, etc.), open your RTMP settings and enter the RTMP URL
and Stream Name from Studio into the corresponding fields.

Owtput Sattings.
ane il Name: RTMP Server
1 ATMP Server
Destination:  RTMP Server B Morg... B
Encoding:  H.264 720p 16:0 (1280x720) B =

Address: | romp:/24.103.40.83/live

Stream: serverl

User Agent:  WirecastiFM 1.0 B

Open FMLE XML File

Sat Credentials...

Bitrate: 2217 k

If you enabled authorization, enter your RTMP Input's username and password into your third-party
encoder.
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— W
RTMP Flash Server

v RTMP Server

U T

Enter your credentials:

Username:

Password:

Cancel 0K

Strearm: | serverl

User Agent Wirecast/Fi 1.0

Bitrate: 2217 k

Start streaming from your third-party encoder to your RTMP Input.

Stream

20 more.

43
)

Open FMLE XML File

Set Credentials...

In the Livestream Studio multi-view, the video output from your third-party encoder will appear in your

RTMP Input.
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- -

RTMP1 ®© _ RTMP2
¥ | |

No In
[

You can transition your RTMP Input into Program, just as you would with any other source. When you
end the stream from your third-party encoder, the source will no longer be visible in Livestream Studio.

Advanced Settings

In the RTMP input's General settings, scroll down to find additional settings.
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RTMP server 1

{} General
Audio
Convert
Crop
g r

Delay

L

Stream Name

serveri

Transition to program

Start stream

When RTMP stream ends:

Mo Action

DOWNLOAD FMLE SETTINGS

Checking Transition to Program will automatically switch the RTMP input into Program as soon as Studio

receives the stream. Select your Transition to program mode, which allows you to choose whether your
input will Cut or Auto-Transition into Program once the stream is received.
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RTMP server1 v

{3} General Stream Name

serveri

Audio
Convert & Transition to program

Crop Transition to program mode

Auto (@ Cut
PTZ

Start stream
Delay

When RTMP stream ends:

Mo Action

DOWNLOAD FMLE SETTINGS

Next is Start Stream, which can prompt Studio to automatically start streaming to your selected
provider(s) in Livestream Studio (e.g. Livestream) as soon as it receives the RTMP input.

When RTMP stream ends allows you to select what Livestream Studio should do when you stop
streaming from your third-party encoder. The options are:

» No Action: Studio will not react to the RTMP stream stopping
» Stop Streaming: Studio will end its stream. Check the Stream tab to a prompt on what to do with
your stream'’s archive on the selected streaming destination (e.g. save as draft, post, delete).

» Switch to Preview and Keep Streaming: Studio will continue streaming, but transition the Preview
source into Program.
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Transition to program mode

Auto & Cut

Start stream

When RTMP stream ends:

Switch to preview and b

Mo Action
Stop streaming
Switch to pre...eep streaming L.

With these settings enabled, your RTMP source will now automatically appear in Program and
Livestream Studio will start streaming to your chosen provider without any additional action needed.

Q You can also configure RTMP input settings via Livestream Studio Web Control

Troubleshooting

If you attempt to stream from your encoder and are unable to reach the RTMP server, it could be that
Studio is not displaying your machine'’s internal IP address. Follow the steps below to get the correct IP
address

Go to your Windows network settings and find your connection status; click Local Area Connection.

Connect or disconnect

Access type: Internet
HomeGroup: i
Connections: JH/ Local Area Connection

Select Details.
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'T”,' Local Area Connection Status

General

Connection
IPw4 Connectivity:
IPwE Connectivity:
Media State:
Duration:
Speed:

Internet

Mo Internet access
Enabled

Sdays 02:21:48
1.0 Gbps

Activity
Sent L., Received
Hi’i.:ﬁ’f"
Bytes: 408,349,691 721,209,658
[ '@'Properties ] [ '&'Disable ] [ Diagnose l

Close

The IPv4 Address is the IP address that you need. Replace this with the IP address displayed in RTMP URL

in your encoder (e.g. rtmp://10.20.30.40/live). The stream name remains the same.
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Metwork Connection Details @

MNetwor: Connection Details:

»

Property Value

Connection-specific DN...
Description

Physical Address

D] =T S <«
IPv4 Address

e LT e
Lease Obtained
Lease Expires
IPv4 Default Gateway
IPv4 DHCP Server
IPv4 DMNS Servers

—

m

IPvd WINS Server
MetBIOS aver Topip En... A

< | 1 | r

If you are using a Mac system, open System Preferences > Network. Use the IP Address listed here in the
RTMP URL.
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[ L4 i Network Q
Location: Automatic
Apple U...Adapter
Cfﬂmd B o > Status: Connected
. Apple USB Ethernet Adapter is currently active
Wi-Fi — and has the IP address 10.100.0.67.
Connected -
Bluetooth PAN 1 . } o
o | lusiooth P a Configure IPv4:  Using DHCP
@ Thunde..thernet - - IF Addrese:
Mot Connected o
Subnet Mask:
® PANTE..UML285 .
Mot Connected NS Router:
° Thunde...It Bridge ~ DNS Server:
Mot Connected NS
Search Domains:
v
+ = g~ Advanced... ?

You should now be able to go live to your Studio RTMP server.
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Uninstall Mac OS X Remote Camera and
Audio Redirector

To uninstall the Remote Camera Desktop Audio Redirector, navigate to your Applications folder and

locate the LSAudioRedirectorUninstaller application. Double-click it.

<

il

Livestream 5Studio LsAudioRedirector
Remote Camera Uninstaller

This message will pop up asking you to confirm that you want to uninstall the Audio Redirector. Click

Uninstall.

Livestream Studio Remote Camera Audio Redirector Uninstaller
This will completely remove Livestream Studio Remote Camera Audio Redirector.

CANCEL

When the script finishes running, this message will pop up, confirming the Audio Redirector has been

uninstalled successfully.

Livestream Studio Remote Camera Audio Redirector Uninstaller
was uninstalled successfully.

To uninstall the Remote Camera Desktop Client on a Mac system, first close the application by clicking

the icon in the top menu bar.
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EovovpE® M1 O

+ Launch on startup

Check for Updates...

Settings...
About

Install Desktop Audio Capture...

Stop

Close

Locate the Remote Camera application in your Applications folder.

800 [ Applications

FAVORITES
&3 Dropbox

1 All My Files

? AirDrop iTarm
2 Desktop

© Downloads

[3 Documents Livestream
B Maowvies Procaster
J3 Music

Pictures

) Creative Clo... ﬁ
DEVICES Mailsmith

Q Livestrea... =
TAGS

@ Red

) Orange

Drag the application to Trash.

Livestream
Producer

-

Kﬂnut!

¥

Livestream Studio
Remote Camera

—

Messages

N\

‘wierk banch

Launchpad

Yo

Mail

@

Microsoft
Messenger

—
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Empty the trash.

W Trash "

Bl=om (&) (& (5-](=][(=] o

Livestream Studio
Remote Camera

Are you sure you want to permanently
erase the items in the Trash?

You can’t undo this action.

| Cancel I[ Empty Trash ]I
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Web Control
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What is Studio Web Control?

Studio Web Control allows you to give yourself or others access to a Livestream Studio system
directly from a supported browser.

On your Studio system, go to settings, then click the Web Control tab. Click the checkbox next to
Enable Web Control to see more options.

Settings: Web Control canceL  [FERVED

%' Enable Web Control

Studio ID Web Control Link

Copy Link

608


https://help.livestream.com/hc/en-us/articles/360002054228

vimeo - livestream

You can use the default ID that populates, or create your own by clicking the pencil icon to edit it. Click
save when you are done, or cancel to keep the previous name.

Edit Studio ID

RZEFAzeTOrxGyald

CANCEL

Below is your list of allowed users that you have invited to your Studio Web Control. You can also adjust
how much access each user has to your Studio.

Users
E-mail
Administrator
Full,

Administrator

Administrator

Full,

Finally you can choose how your Studio Web Controlis laid out in the module below. Choose a layout
and drag and drop sources you wish to see into the position you want them in.
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PROGRAM PREVIEW REMOTE1 RTMP4

cami MEDIA1 REMOTEZ RTMF2

REMOTEZ COLOR2

PREVIEW PROGRAM

REMOTE1 RTMP1 MEDIAT RTMP2

When you log into Studio Web Control using your Livestream or Vimeo account credentials, any Studio
system you have been added to will be listed below as offline or online. Select your online Studio.

610


https://studio-webcontrol.livestream.com/

vimeo - livestream

I | Livestream Studio

Select Studio to control

KiE6UinGygd

see Studio you're looking for

A window such as the one below will open for users granted Full Access:
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Here is where those users will be able to the see and control the multiview, control the audio mixer,
operate the transition controls as well as insert mid-roll advertisements and fade to black. They can also
click the menu icon in the upper right corner to change their view and log out.

Read only users will see a similar window to those given Full Access, with the exception of a '‘Read Only’
ribbon in the upper right control. These users can see every part of the interface that Full Access users
can, but they cannot control it or make any changes.

Users granted access to the multiview will see something similar to below, depended on your layout
settings.

They can click on the sources to put into Preview and Program. They can also click Stream and Record
at the top of the module to go live and start recording, respectively.

Users granted access to controls only will see the audio mixer, stream module, GEX modules, all the
options seen under the transition controls. However, they do not have the ability to see or control the

multiview.
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All users can log out of web control by click the menu icon in the upper right corner and clicking Log
Out.

¥ f you're using Web Control on the same network (LAN) as Studio, the information between
the two will be exchanged peer-to-peer (P2P) over the LAN rather than over the internet
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Add a User to Studio Web Control

You can add additional users to control your Studio via Google Chrome and other supported
browsers.

In your Livestream Studio system, go to Settings > Web Control.

Settings: Web Control canceL [FSAVE"

Project Format

Enable Web Control Control?

Inputs

Outputs

Audio In

Recording

Media Player

Streaming

Web Control

RTMP Server

Enable Web Control by clicking the check box, then navigate to the Users box.
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Settings: Web Control CANCEL

roject Format
Project Format & Enable Web Control

Inputs | _
Studio ID Web Control Link

Qutputs F Copy Link

Audio In Users

Recording E-mail

Administrator
Media Player

Administrator
Streaming None
Web Control I

None
RTMP Server

Dropbox

To add a user, click the + button. The following window will appear.

Add User

CANCEL m

Enter the person’s email address and how much access you wish to grant them. The options are:

« Administrator - full access plus ability to change access for themselves and other users
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e Full access - full use of all Studio Web Control features (multi-view and controls); cannot change
other users access.

e Read only - can only view web control with no ability to control Studio

» Multiview - can see the multi-view as configured from Studio and use mouse controls to put sources
in Preview and Program

» Controls only - can control audio mixer, GFX, stream tab, RTMP inputs, and other transition controls
in web control but cannot see the multi-view.

Click Save and then save your Studio settings. The user you have invited to access your Studio via Web
Control will not be able to join it until you save your settings.

Q You can always adjust what kind of access each user has when you go back into the settings.
Doing so will kick them out of any current session and they will have to re-enter the Studio
Web Control interface again.

The email address you sent the invite to will receive the following email:

l . Livestream Studio

You have been invited to Livestream Studio Web Control!

Now you can control Livestream Studio ID PjDvq1g29BKa
remotely from your browser.

Use your Livestream account email and password to log in
to Livestream Studio Web Control at
studio-webcontrol.livestream.com.

OPEN WEB CONTROL

The user should click the blue Open Web Control button or the studio-webcontrol.livestream.com URL.
They will be prompted to log into a Livestream or Vimeo account if they are not already, and then
directed to the Studio Web Control interface that they have been given access to.
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€@ Theuser must have an account on Livestream or Vimeo in order to log into Studio Web
Control. If they do not have an account, they can click Join Livestream or Vimeo. The user
must use the email address that was invited to Studio Web Control.
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Supported Browsers and Devices for Studio
Web Control

In order to use Web Control with Livestream Studio, customers must use the most recent versions of
Google Chrome, Mozilla Firefox, or Safari on the following operating systems only:

« macOS

« Windows

e Chromebook
* Android

Web Control is not supported on Microsoft Edge and all iOS devices.
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Using Graphics Overlays in Studio Web
Control

Web Control, the Livestream Studio feature allowing the ability to control certain aspects of
Livestream Studio via a web browser that supports WebRTC (e.g., Google Chrome, Mozilla Firefox),
includes the ability to add .lsgfx files via Dropbox, insert data, and have full control over your
graphics overlays' settings.

A Dropbox account is required in order to use this feature. Log in to Dropbox and locate your folders (or

create a new one).

Save the .Isgfx files you wish to use in Livestream Studio in this folder. Only .Isgfx files are supported in
Studio Web Control.

c Dropbox > Lower Thirds

(U Recents Name -

i [Ty

E) Flles black-red-gloss.Isgfx
28 Team

[=] paper

[&) Photos
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Sample .Isgfx files can be found in the Studio Graphics Store or can be created when you export a

graphics overlay layer that you manually created in Livestream Studio.

wse Graphics

Lower Third: Black / Red Gloss Lower Third: Yellow Boxes Lower Third: Blue Angular

The first step is within the Livestream Studio software. Navigate to Settings, then select the Dropbox tab.

Settings: Dropbox CANCEL [TSAVE

Click Connect Dropbox.
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CANCEL SAVE

Log in to your Dropbox account by entering your account credentials and clicking Sign in.

ign in to Dropbox to link with Livestream
Studio

Studio will request permission to access your files in Dropbox. Click Allow.
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Livestream Studio would ke access
to the fles and folders in your

Dropbox. |

You will need to select a folder on your local drive to save your imported file to and a folder in your
Dropbox from which to select .Isgfx files. Once you made your choices, click Save.
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Gelect Folders

Local Folder

Remate Folder

Studio will indicate that your Dropbox account is synchronized with Studio.
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Settings: Dropbox CANCEL

Local Folder

Next, log in to Web Control and open your Studio (assuming you have already added yourself as a user).

BB | Lhastreem W Cornn - Emiy

You should notice the three graphics overlay tabs in the bottom portion of the screen; select one of

them to continue.
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You can either browse the free Graphics Store within the Web Control graphics overlay module or scroll
down and click Add Custom Layers.

Audio Mixer Stream RTMP Inputs

CATEGORIES

FEATURES

I T
Lower Third: Black / Red Gloss

Any Isgfx files saved in your selected Dropbox folder will be listed here. Click the name of the file you
wish to use.
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Audio Mixer Stream RTMP Inputs

CATEGORIES

FEATURES

black-red-gloss

17 22-twitler-bird

The graphics file will load with its design and settings on the left and its data on the right.

@ Itisnotpossible to open the GFX Designer in Web Control. The appearance of the graphic
can only be edited within the Studio software.

Audic Mixsr RTHMP bnputs
Titha
Mirw York, NY

B B,

+ + ADD GRAPHICS B = W + COLUMN

On the right side, you have the ability to add data rows and columns and enable the Auto Push/Pull
feature when selecting different rows.
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£ Mubo PUBHPULL

Clicking the gearwheel on the left side will open the settings available with that graphic, such as auto-
loop timing, direction, and starting point.
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Lower Third : Black/Red ...

START AUTO-LOOP

Auto-Loop Ssttings

10 sacond intarval batwaan new items

W Start from baginning once and is reached

Ramova ltam from list after shown

Auto-Loop Directlon

® Top-lo-boliom

Botiom-lo-top

Overlaying graphics in Web Control is the same as in Studio software. Click the corresponding PRV
button to show your graphics overlay in Preview.

Click PUSH to transition the graphic overlay into Program.

628



vimeo - livestream

TIE BG |

Now, you will see the graphics overlay in your Program monitor.

= PRV

45F 45F

TIE BG TE

ADVERT

To remove it from Program, click the corresponding PULL button.
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Media Playback in Web Control

You can import videos from Dropbox into your Media bins via a Web Control supported browser.

Open Web Control for your Studio system. If you have not already integrated a Dropbox account with
Studio, you can do so by opening the Settings menu in the upper right corner, then navigating to the
Dropbox tab. The steps to integrate Dropbox with Studio are the same with Web Control.

(ﬁl Emily Knox

Change View

Settings

Change Studio

Log Out

Once Dropbox is connected to Studio, select one of the Media tabs in Web Control and click the +

button in the bottom left corner.
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Audio Mixer

& Autoplay

Any video file that is stored in your selected Dropbox folder will appear in the pop-up menu. Select the
file you wish to import into Studio.

Audio Mixer

penalty shot
highlights

game archive

r % Autoplay IS t3

The file will begin transcoding. When transcoding completes, you will see a thumbnail of the clip on the
right side of the panel.
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Audio Mixer

penalty shot.mp4
In transcoding queue...

1.72%

W Autoplay

Audio Mixer

- penalty shot.mp4
B oo000s:10

»" Autoplay

All player controls and options function exactly the same way in Web Control as they do in the Studio
software.
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Studio Simulcasting via Web Control

Simulcasting via Livestream Studio can now be set up via Studio Web Control. It works similarly to
setting up simulcasting within the Livestream Studio software.

Log in to Web Control and navigate to the lower left corner. Select the Stream tab. Choose one provider
to start with; this example will use Livestream.

Media 1 Media 2

eam

gure

Set Up Your Str

Log in to your account.
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Log In to Livestream

unt? Sign Up

Configure your provider's settings. For example, choose your Livestream event and whether or not to
notify your Livestream followers when you go live.
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Event Name

lce Ho

Click Advanced Settings to reveal further options below; in Livestream's case, using bonding or using this
Studio as a backup stream. All providers will allow you to specify a network to stream through.
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Backup S

When you have finished configuring your settings for your first provider, select the + icon in the lower
left corner to add another provider.
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Event Name

& MNotify Followers

Media 1 Media 2

Set Up

Your Stream
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Sign in to your account. This may open a new browser window. Once you are signed in, navigate back
to Web Control.

Media 1 Media 2

Sign in to Facebook

The provider's icon will appear as a new bottom tab within the module. Clicking it will allow you to
configure settings for that streaming destinations (e.g. where on Facebook you are streaming, audience,
tag location, etc.)
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Now you can give your stream a title and choose a streaming quality. Keep in mind that not all quality
options are supported by all providers (e.g. Facebook does not currently support 1080p or higher).

Media 1 Media 2

Shara With

Public
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To start streaming, click Go Live in the lower right corner of the Stream module.

Media 1 Media 2

Sharo With

Your stream will begin immediately and the Stream module will turn into a dashboard explaining your

outgoing bitrates, frame rates, viewer counts, and any error messages or warnings regarding your
stream.

When you are down streaming, click the red Streaming button in the lower right corner.
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You stream will end immediately and a dialogue box will open with information regarding your stream
and any action items required (e.g. post the video on demand to your event page).

Stream Ended

Oh Om 23s

Actions:

042
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Using Chroma Key

Livestream Studio includes chroma key, giving users the ability to remove a color from the video
source, typically a background color to replace with an image such as a virtual set.

Chroma key is done through the graphics module. Start by adding a new layer to any graphics overlay

channel.
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Next, click on the camera icon to add an input source to your graphics layer.

Click the gearwheel to select which input source you want to use for chroma key.

You can adjust how your input source looks inside the GFX Designer as necessary, such as scaling it to fit
the whole screen.
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Livestream Studio will automatically detect the most prominent color (green in this example) and key it
out once chroma key is turned on.
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Next, close out of the GFX Designer and put either a camera, media source, or graphics source into
Program from your multi-view. The example above has a white background video from Media 2.

Now push your graphics overlay layer into Program by clicking the corresponding PUSH button.
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You should now see your chroma keyed input source overlaying your Program source.

I ]
T A '

To make further adjustments to your chroma key graphic, go back to the GFX Designer.
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When you select your input source in the graphics overlay while chroma key is turned on, you will see
other options in the upper right corner.

To erase all chroma keying on your input source, click the X icon. Note that the green background has
returned to the picture.
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To apply automatic chroma keying (i.e., key out the most prominent color), click the icon of the
eyedropper with an A.

=R

The eyedropper-circle icon will allow you to do rough keying by hand. Select this option, then hover
your mouse to the area you want to key (e.g. the back of the chair).

Click and drag your mouse to start real-time keying. You can increase or decrease the keying color
range, which will be indicated by a circle around the area.
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The end result should be similar to the image above, where the colors within the range that was
selected are now on the chroma key palette and thus not visible.
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The eyedropper with a plus sign either initializes the chroma key or adds color hues to the chroma key
palette. This is helpful if there are shadows in your background that did not key out fully.

|

The eyedropper with a minus sign will exclude colors from your chroma key palette. This is helpful if a
color on your set is similar to the color you keyed out and is faded. In this example, the orange chair is
keyed out and the red sweater is also largely keyed out.

1] Demigrae o

After using the eyedropper minus tool on the red sweater, you can now see the sweater; orange is still
on the chroma key palette.
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Please note that other graphics or images in the same graphics layer will be visible. Use caution with this
type of workflow, as itis likely to increase your CPU usage.

ll S0 ] D e
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Hardware Encoding and Decoding with
Livestream Studio

Studio includes hardware encoding and hardware decoding which moves the video processing to a
dedicated GPU, greatly reducing your CPU usage while running Studio.

These features are only available on computers with Intel processors that include Quick Sync Video
(which are listed here) or have an NVIDIA GeForce card that includes NVENC and NVDEC. We have
instructions on how to determine if your computer has an Intel Quick Sync processor or has an NVIDIA
card that supports NVENC and NVDEC.

The HD31, HD51 4K, and HD550 4K are the only Livestream-built units that have the required hardware
that includes these features. Many laptops include them as well.

Computers that do not have the proper hardware installed will not display these features in Studio.

To enable hardware encoding in Livestream Studio, click the Settings icon in the upper right corner of
the interface.
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Navigate to the Streaming menu.
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Settings: Streaming CANCEL

Streaming

At the top of the menu, check Hardware Encoding. Then click Save.

Settings: Streaming CANCEL

Hardware encoding & Enabled

As an example, here is the processor being used on a Windows 10 computer.
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iCh

=1

Motifications & actions

Power & sleep

Storage

Offline maps

Tablet mode

Multitasking

Projecting to this PC

Edition
Version
OS5 Build
Product ID

Processor

Installed RAM
System type

Pen and touch

Windows 10 Pro

1607

14393.447
00330-80000-00000-AA648

Intel(R) Core(TM) i7-4790K CPU @ 4.00GHz 4.00
GHz

16.0 GE (15.9 GB wsable)
64-bit operating system, x64-based processor

No pen or touch input is available for this display

The CPU usage when hardware encoding is turned off—streaming a single bitrate averaging 2128kbps,

with 2 media bins, and 1 animated graphics overlay—is nearly 100%. The stream timed out after about 1

minute due to lack of resources.

In comparison, the CPU usage with the same workflow while hardware encoding is turned on was cut in
half, down to 48%.
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% CPU

To enable hardware decoding, navigate to the Advanced menu in settings. Make sure Enable hardware
decoding is checked. This will reduce the CPU resources needed to bring in your camera sources.

Graphic Overlay Tracks 3 GFX Tracks

Startup Launch on startup

Other Tally Lights

" Send Diagnosiic and Usage Data
to Livestream

Hardware decoding Enable hardware decoding

Tabs Allow tabs to be opened as
separate windows

Video / Audio Delay RESET DELAY SETTINGS

658



vimeo - livestream

How Do | Know if My Intel Processor
Includes Quick Sync?

In order to be able to use the hardware encoding feature in Livestream Studio, you must have the
proper hardware installed on your computer. One of these options is having a processor that
include Intel Quick Sync. (The other is NVENC via NVIDIA GeForce GPUs))

Intel Quick Sync is Intel's version of dedicated video encoding and decoding hardware core. Rather
than using a general GPU, this core is located on the processor die and is dedicated just for video
processing.

Q Studio will automatically detect if you have the proper hardware or not. You can quickly
check this by going to the Settings: Streaming menu. If Hardware Encoding does not appear
at the top of the menu, then you do not have the GPU hardware.

To determine if your processor includes Quick Sync, first you need to determine your CPU model.

« Windows 7: Open the Start menu, right-click Computer, then click Properties.
« Windows 8 & 10: Right-click the Start menu, then click System.
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E Systermni = — =] *

4 B » Control Panel » Al Control Pane ems » System w Search Co.. 0@

Contral Panel Home . Y .
View basic information about your computer

¥ Device Manager Windows sdition

& Remote settings Windaws 10 Pra -- "
& System protection & 206 Microseft Corporation. All rghts resensed .- WI n d OWS 1 0

& Advanced system settings

System
Precesson IIMRJ Core{Th) i7-4790K CPU @ 4.00GHz 400 GHz |
Installed rmemary (RAM): 16,0 GB (15,9 GB usable)
System type: G4-bit Operating System, «bd-based pracessor
Pen and Touch: Mo Pen or Touch Imput is svailable for this Display

Computer narme. domain, and warkgroup settings
Compuler name: Win-Cpp-Dev-3 g:hange settings
Full computer name: Win-Cpp-Dev-5
Computer description:

Workogroup: WORKGROUP

‘Windows activation

Windows is activated FRead the Microsoft Software License Terms

Product I0: 00331-20020-00000-A4756 W Change product key

If you are running Studio on a Mac, to find the exact CPU model you will need to open the Terminal

application. Enter the following command, then press the Return key:
<p>sysctl -nmachdep.cpu.brand string</p>

Your CPU model will be displayed underneath.

e o ~ emily.knox — -bash — 80=24

Last login: Fri Mar 2 15:12:38 on console

VIMBK-KnoxE-LM:~ emily.knox% sysctl -n machdep.cpu.brand_string
Intel(R) Core(TM) i7-3615GM CPU @ 2.3BGHz

VIMBK-KnoxE-LM:~ emily.knox$ |}

In a web browser, navigate to this list and find your CPU model (Tip: Use the CTRL+F/CMD+F search

function in your browser and type in the model ID).
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Compare  + (el
T2130
Inted* Transoade™
T2120

Inted* Transcede™

Comparng *
m T2100

Inte® Aram™
Processor
Compare  + MEsPETr

[2M Cache, up to
2,76 GHz)

1 B
E

Intel® Atam™

Pracedsor
Compare  + MuEbklog

[2M Cache, up to

2,16 GHz)

Inted® Atom™
Processor 23830
(2M Cache, up to
1.33 GHz}

Q374

0314

Q314

Q24

214

Q214

/A,

H/A

£26.00

$20:00

$20.00

£18.00

CTRL+F

h Product

FETTIT
MHz

750,00
MHz

750.00
MHz

1.33 GHz

1.33 GHz

£ MB L2

Z2MBL2

2MB

Intel* HD
Graphics

Intel* HD
Graphics

Inted* Core™ [
@780K Processor
(BM Cache, up to
4,40 GHz)

gl
5

Q214

$339.00-
$350.00

4.00 GHz

440 GHz

aMB
SmartCache

Inel® HD
Grapghics
4500

Intel® Care™ i5-

Compare + A690K Processor
(6 Cache, up to
3.00 GHz)

If your CPU does not appear in the list, then you do not have Intel Quick Sync available with your

computer's processor.

0214

$242.00 -
$243,00

s

350 GHz

390 GH2

6 MB
SrartCache

Intel* HD
Graphics
4500
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How Do | Know if My GPU Supports
NVENC and NVDEC?

In order to be able to use the hardware encoding and hardware decoding features in Livestream
Studio, you must have the proper hardware installed on your computer. One of these options is via
NVENC (encoding) and NVDEC (decoding), which process the video via a supported NVIDIA
GefForce graphics card

The first sign of knowing whether your PC supports these features is to go into Studio and check
Settings: Streaming for Hardware Encoding, then check Settings: Advanced for Hardware Decoding. If
these options do not appear in these menus, then, unfortunately, you do not have the supported
hardware.

Settings: Streaming CANCEL

Project Format
Hardware encoding & Enabled

Inputs
Antilag @™ On

Outputs Off

Audilo In Antilag Duration 5000

Recording
Key Frame Interval 2 seconds

Medla Player - :
; Encoder Queue Stop streaming when queue is

300 frames

Streaming
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Media Player

Streaming

Web Control

RTMP Server

Dropbox

Ad Insertion

Hotkeys

Mousea / Touch

Advanced

Graphic Overlay Tracks

Startup

Other

Hardware decoding

Tabs

Video [ Audio Delay

Remote Inputs
Synchronization

Split Recordings by
Time Interval

1 GFX Track

Launch on startup

Send Diagnostic and Usage Data
to Livestream

Enable hardware decoding

Allow tabs to be opaned as
separate windows

RESET DELAY SETTINGS

Disable Synchronization

Dalay All inputs by 1 Second and
Synchronize

Delay Remote Camera inputs
by 1 Second and Synchronize

Disable File Splitting

Split Every 24 Hours

We have successfully tested the following NVIDIA GeForce models:

o GTX1050

e GTX950

o GT730 (GK208-400-Al - other versions of this model have been reported to not work)

o GTX650

To find out if a specific model supports these features, visit the NVIDIA GPU Support Matrix. The first

table on this page represents cards that support hardware encoding (NVENC); the second table (below)

is for cards that support hardware decoding (NVDEC). Below each of these tables are three green

buttons which are different NVIDIA product lines; clicking all of these will expand and complete each

respective list.
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Tesla P4 / P& Pascal GP104 1 2 2 Unre

Tesla P40 Pascal GP102 1 2 2 Unre
Tesla P100 Pascal GP100 1 3 3 Unre
Tesla V100 Volta GV100 1 3 3 Unre
Tesla T4 Turing TU104 1 1 1 Unre

For a complete list, click on the buttons below to open the complete tables

| GeForce /TITAN | QUADRO | GRID/TESLA |

Search for the the model name of the GPU on your system (e.g. GTX 1050). The quickest way to do this
is to hold CTRL+F (Windows) or CMD+F (Mac) and type the model name into the page search. The
browser will jump to the first matching result.

If your model name is on the first set of tables and lists "YES" under the H.264 (AVCHD) YUV 4:2:0
column, then your GPU supports hardware encoding in Livestream Studio.

NVENC Support Matrix

H.264
# OF Total # Max # of [AVCHD)

# 0OF MVYENC of concurrent YUy
BOARD FAMILY CHIP CHIPS fCHIP NVYENC sessions 4:2:0
GeFarce
GeFarce GT 1030 Pascal GP108 1 0 0 0 NO
GeForce GTX 1050 /1050 Ti Pascal GP107 1 1 1 2 YES
GeForce GTX 1050 F 1050 Ti Pascal GP10& 1 1 1 2 YES

If it appears in the second set of tables and lists "YES" under the H.264 (AVCHD) column, then it supports
hardware decoding.
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If your NVIDIA card falls outside of these parameters, then NVENC and/or NVDEC may not be supported
on that card
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Using a Bonded Network to Stream

Livestream Studio has the ability to stream via a bonded connection, allowing you to stream over
multiple Ethernet, Wi-Fi or 4G/LTE network connections, increasing your bandwidth while also
allowing you to create network redundancy.

@ 'mportant: Bonding is only available when streaming to Livestream. If choosing mulltiple
providers, be aware that other providers will use only the network you selected when
configuring each provider's stream settings.

While Windows should recognize and automatically install any necessary drivers for USB modems, the
drivers can also be manually downloaded from the modem vendor's site. Ensure that all networks can
access the Internet.

In order to successfully stream with a bonded connection, ports UDP 2088 and TCP/IP 80 need to be
open in addition to standard Firewall ports.

As a best practice, it's recommended that USB devices are spread across your PC's various USB ports

and hubs. This avoids taxing each USB hub and ensures that each modem's connection is used.

In Livestream Studio, navigate to the Stream tab and login to your Livestream account.
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Media 1 Transitions

Set Up Your Stream

Select a provider below to configure stream settings

Select your event, then click Advanced Settings.

Event Name

Ice Hockey

& MNotify Followers

Check Use Bonding, then click Done.
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Event HName

Ice Hockey

W Motify Followers

& Use Bonding

At the top-right corner of the Stream module is a gearwheel. Select this to configure default settings for
your stream, including your default network. Here you will see a Bonding column with each
corresponding network and a small dropdown menu with the following options:

« Use: Networks with this option selected will combine together and distribute the stream.

« Standby - use only when needed: This network will not be used unless all other active networks lose
connection. For example, if you have a 4G USB modem plugged in with data caps, you may want to
consider saving that as your backup connection to avoid data overage charges.

« Off: Will not be used at any point during your broadcast regardless of the status of other network

connections.

Aspect Ratio

N 169 4:3 1 = Custom

Select default network Bonding

When you go live, your network dashboard will show information for each network, such as the bitrates
each active one is distributing and if one disconnects.
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Natwork Dashboard

Your standby networks will not stream unless a problem occurs with all of your selected primary
networks (i.e. those with Use selected).

Metwork Dashboard Bonding

T
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Configuring Mid-Roll Advertisements

Owners of the Livestream Studio software who also have an Enterprise plan on Livestream can now
insert a mid-roll advertisement during a live broadcast with the press of a button. In order for this
feature to work, make sure you have set-up and configured a Google Ad Manager (formerly known
as Google DFP).

Once the Google DFP account is properly configured with Livestream, launch Livestream Studio.

Open the settings menu and navigate to the Ad Insertion menu.

Settings: Ad Insertion canceL  [FERVEN

Livestream Studie supports mid-roll video ad insertion using
Google DoubleClick for Publishers Ad Server. A Livestream
Platform Enterprisc Plan is required to use this feature. Leam
Hore

Ad Duration 30

Background  Fade io black

Transition

Automated Insertion

Within this menu tab, you'll find the following options:

Segment Duration: adjust the length of the mid-roll advertisement segment. This is how long an
advertising segment will last before it starts over. When you click Advert again, Livestream Studio will

6/0


http://livestream.com/platform/pricing
https://help.livestream.com/hc/en-us/articles/360002069227-How-Do-I-Add-Pre-Roll-Video-Advertisements-to-My-Livestream-Events-

vimeo - livestream

switch to the Preview source at the end of the segment.
Background: Adjust the image displayed behind the advert. Options include:

» Fade to Black
« Any of the available GFX/Color/Media inputs

Transition: Adjust the transition in and out of the advert. Options include Cut and Auto.
Automated Insertion: Checking this will bring up additional settings if you want your advertisement to

run at a set interval. This can be helpful if you have strict time limitations or have to meet certain
sponsorship requirements.

Livestream Studio supports mid-roll video ad insertion using
Google DoubleClick for Publishers Ad Server. A Livestream
Platform Enterprise Plan is required to use this feature. Learn
More

Ad Duration 30 seconds
Background Fade to black
Transition CUT
» Automated Insertion

Period between ads 600 seconds

Number of ads per break

Start with advert

Start ingertion with streaming

Period between ads: The time, in seconds, between your advertisements being triggered.

Number of segments per period: How many segments roll before advertisements are no longer
triggered.

Start with advert: Segment will begin by playing the advertisement, rather than starting with showing
what you selected to go in the background.

Start insertion with streaming: When you go live, the first content your viewers will see is your
advertising.
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After configuring the Ad Insertion Preferences, click Save. To activate a mid-roll manually, click the Advert

button below the transition controls.

ADVERT

When inserting an advertisement via the Livestream Studio Software, the following should occur:

» Depending on your choice of background, the Program window will change to reflect the selected
option.

« The Advert button will become red and include a Countdown timer.

« On the top Left of the Program window, it will read "OUTPUT Advertisement: [Transition] is locked

until End”. In the below example the option selected is "Fade to Black”.

After clicking Advert again, it will switch to a countdown to when your stream will return to content.

BACK IN 00:22
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Adding & Configuring Tally Lights

A tally light is a small signal-lamp typically seen on top of a camera. It is usually located above the
lens or on the electronic viewfinder and communicates that the camera is 'live' - i.e. its signal is
being seen in Program at that moment.

Tally light systems by MetaSETZ (http://www.metasetz.com) are currently the only systems supported by

Livestream Studio.

Once you have acquired your Tally Light system, connect it to your computer via an available USB port.
The system should recognize it and automatically install the drivers.

Open the Livestream Studio software and open Settings: Advanced.

Under Other, check the Tally Lights option. Save your settings.
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Settings: Advanced CANCEL | SAVE

Projects Location BROWSE

Crossfade Audio on Cut 5 Frames

Outputs

Project Audio Format

. Multi-View Deinterlacing
M = ay
Media Player Method

Streaming Startup Launch on startup

Other Tally Lights

Send Diagnosiic and Usage Data
to Livestream

Hardware decoding Enable hardware decoding

Tabs Allow tabs to be opened as
separate windows

Video / Audio Delay RESET DELAY SETTINGS

Go to the Inputs tab and select the local input to which you want to assign a tally port, then click the

corresponding gearwheel to the right to enter that input's settings.

Select Tally and assign one of the available tally ports to your camera as seen below. Do this for each of

your cameras.

Tally Light

B OTALLY

When the camera is set to Program, the selected Tally Light will turn on.
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Create a Backup Stream to Livestream

@ Unfortunately, this feature is currently not functioning properly. Our development team is
aware and working on a fix. We will update this article when a fix has been released.

You can create a backup stream to Livestream using Livestream Studio. This is helpful if you are
looking to add redundancy to your workflow in the event of a bandwidth drop or power failure. You

will need two systems running Livestream Studio. Determine which will be your primary encoder
and secondary encoder.

This feature only works when streaming to Livestream.com. Livestream Studio cannot create a backup
stream for other providers.

Start your stream to Livestream on your primary encoder as you normally would.

Open Livestream Studio on your secondary encoder. Navigate to the Stream module, log in to
Livestream. Make sure the following streaming settings match the settings on your primary encoder:

e Event
» Streaming Quality

Next, select Advanced Settings.
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»'| Livestream

Event Name

Ilce Hockey

| Motify Followers

Check Backup Stream.

" Livestream

Event Name

Ilce Hockey

% MNofify Followers

Use Bonding | & Backup Stream

When your settings are configured, select Go Live to start streaming your backup.
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Gama 1

» Livasiream

Everrl Hama

lcn Hockey

e Bondicg B8 Backup Stream

Epacily Hetweh

Nl

If the stream from the primary encoder fails due to bandwidth drop or power failure, the stream from
secondary encoder will continue without interrupting the viewing experience on Livestream.

Important: Backup Stream is not available when using Bonding as your delivery method.
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Enabling Closed Captioning Ingestion

Livestream Studio can ingest FCC compliant closed captioning data with their input sources and
stream it out to Livestream.

Livestream Studio supports ingesting CEA 708 closed captions via Blackmagic DeckLink devices. Most
closed captioning encoders support this type of captions, as they are FCC compliant. Studio can then
deliver CEA 608 captions to your streaming destination, provided the player also supports those closed
captioning standards.

@ 'mportant: The captions must be embedded into a Blackmagic Design SDI input in order to
be recognized. Closed captioning currently does not work when using Magewell capture
cards, including the cards installed on the Studio One.

To enable closed captions forwarding to Livestream, go to settings and enter the Streaming menu. At the
bottom, you will see Closed Captions. Check Closed Captions Enabled to allow for closed captioning

data to be received.

Bitrate

L ccal MP4 Recordemg

MP4 Recording Locatosn

Streaming I 1oide

Closed Captisns

Next, select whether the closed captions are available only with the source they are coming from
(Follow on switching), if the captions should show regardless of what source is in Program (From single
camera), or only when the source is in AUX program (From AUX).
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Streaming Mode

Closed Captions W® Closed Captions Enabled

[ ] Follow on switching

From single camera

Save your settings, then go to the Inputs tab. Select the camera source(s) that has the closed captioning
data embedded, then click the corresponding gearwheel to the right to configure its settings.

On the left side, select Closed Captions.

Check Enabled, and then select which channel your closed captions are coming through. This will
require that the selected input source be a 10-bit input signal, rather than 8-bit.

Closed Captions

f Erahs

. service 1 (English)
DTVCC service 2

B CL0SED CAPTIONS

When you go live, your captions will be available as an option in the destination’s player as well as your
Livestream VOD. Please note you will not see any captions in Livestream Studio or when you download
the video file from your event page.
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We cannot guarantee that captions will be available on Android due to the diverse nature of
its versioning and devices.

COURTESY: WHEBQ

FOX26

12:10 86°
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Changing Language in Livestream Studio to

Chinese

Livestream Studio includes the ability to change the language of the Studio interface between

English and Chinese.

Click the gearwheel button in the upper right corner of the Studio interface. Navigate to the Settings:

Advanced menu. Towards the bottom will be the Language dropdown menu where you can select your

preferred language.

Settings: Advanced

Projects Location

Crossfade Audio on Cut 5

Project Audio Format
Audio In

Multi-View Deinterlacing

Recording Method

Macia Player Graphic Overlay Tracks

Startup

Streaming

Other
Web Control

Hardware decoding

Tabs

Video / Audio Delay

Remote Inputs
Synchronization

split Recordings by
Time Interval

Language

Memory

Notifications

canceL [TSAVER

BROWSE

Frames

1 GFX Track

Launch on startup

® Send Diagnostic and Usage Data
to Livestream

# Enable hardware decoding

8 Aliow tabs to be opened as
separate windows

RESET DELAY SETTINGS

® Disable Synchronization

Delay All Inputs by 1 Second and
Synchronize

Delay Remote Camera Inputs
by 1 Second and Synchronize

Disable Fila Spiitting
® Split Every 24 Hours

Split on Date Change

English
ish

GEB reserved for other applications

& Show warning when exiting Studio

You will be notified that your language setting has changed. It will be applied when you
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If you ever do this accidentally, click the gearwheel in the Studio interface. The third tab down is the
Advanced menu. The third setting from the bottom of the menu is the language dropdown menu; select
English, press the blue Save button, and relaunch Studio. The interface will return to English.

MEME
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Import & Export Recorded Files Using
Adobe Premiere Pro

Unfortunately, Adobe Premiere 2018 for Mac no longer supports MIPEG AVI files. This issue
does not appear on Windows machines.

First, make sure you have Blackmagic Design Desktop Video installed on your system. Go
to https://www.blackmagicdesign.com/support, select ‘Capture and Playback,” and download Desktop
Video.

» Open Adobe Premiere Pro and choose a new project
» Select the capture format
» Select the sequence settings

Important: These should match the video format settings of the Livestream Studio Project

Import the video clip.

» Go to: File > Import
» Select the video file and select open.

The imported file should appear in the clip bin.
» Drag the clip into the timeline.

The user will be prompted to change or keep sequence settings. Choose "Keep sequence settings.”

Exporting video clips:

» Go to File > Export > Media

» Select "Match Sequence Settings”
« Enter an output name.

« Click "Export”
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Import & Export Recorded Files Using Final
Cut Pro /7

Follow the steps below in Final Cut Pro 7 to bring a clip into the editing software.

Note: If you are simply looking to export a recording as a compressed .mp4 file, you may want to
consider trying the export feature in Livestream Studio's media bin.

1. Open Final Cut Pro and choose a new project.
Drag the video clip into the file bin.

Drag the clip into the timeline.

. A prompt to "Change the Sequence Settings” will display.
b. Choose "Yes”

Go to Files > Export > Quicktime Movie

5. Choose “Sequence Settings”
Note: Settings must be exactly the same as the settings on the Livestream Studio™ project.

6. Save the clip.
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Troubleshooting Steps: Not Seeing Input
Source

If you are unable to receive a video signal in your Studio software please make sure you confirm the
following:

Are you using a Blackmagic or Magewell capture device?

Livestream Studio will best work with video signals from certified Blackmagic Design capture devices.
Magewell cards are also supported. If you are using a non-Blackmagic device there is a chance your
signal will not appear in the software.

Check here for our list of supported devices.

Do you have the recommended version of the
Blackmagic Design drivers?

We generally recommend using the most recent version of Desktop Video. However, if you are on
Windows 10 Pro version 1709, we recommend downloading Desktop Video 10.9.5.

Drivers found on the Blackmagic Design package discs are often out of date as Blackmagic frequently
releases updates. Please be sure you are using the proper version of the Blackmagic drivers, which you

can download at blackmagicdesign.com/support.

» Select Capture & Playback and download Desktop Video for your operating system.
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Are you getting a video signal in Blackmagic Media
Express?

Click the Start button and search for Media Express, then click Blackmagic Media Express to open the
program. Select the Log and Capture tab to display the video input. Click Edit on the menu bar at the top
of the program and select Preferences, then confirm that your Project Video Format matches the format
of your video source.

Project Video Format: [HD 1080159.94 2

PAL

NTSC Progressive
PAL Progressive
HD 1080p 23.98
HD 1080p 24

HD 1 25
When capturing 0P fles, use [EAR oYX T A

HD 1080p -
HD 1080i 50
Capture sudso and video to: HD 10801 59.94
HD 1080i 50
HD 720p 50
HD 720p 59.94
Capture still frames to: HD 720p 60

Browse For al stil frame captures only

If you receive a video signal in Media Express, you should check Studio’s video format settings. If you do
not receive a video signal in Media Express, confirm you are connected to the correct input and your
camera is configured properly (e.g. SDI or HDMI correctly selected).

688



vimeo - livestream

Inputs

kK ]

None

DeckLink Mini Recorder [6] SDI
DeckLink Mini Recorder [5] HDMI
DeckLink Mini Recorder [7] SDI
DeckLink Mini Recorder [7] HDMI
DeckLink Mini Recorder [8] SDI
DeckLink Mini Recorder [8] HDMI
DeckLink Mini Recorder [9] 5D
DeckLink Mini Recorder [9] HDMI
DeckLink Mini Recorder [10] SDI

Does Livestream Studio's video format match your input
source?

Open Studio’s Preferences by clicking the gearwheel icon at the top right-hand side of the program

window. In the Project Format tab at the left-hand side of the Preferences window, and choose the

video format that matches your input source's format. Please note that all your input sources should
match Studio’s video format setting.

Are you connected to the correct input of your
Blackmagic device?

Generally, Blackmagic Design doesn't specifically mark the input/outputs of the device on the actual
hardware. Please check your capture device's documentation to confirm the proper input.

689



|s your camera configured properly?

Many cameras with multiple output formats allow you to define your specific output method. Check
your camera's settings to confirm your are properly configured for HD-SDI, HDMI or analog, depending

on your input to the Blackmagic Design device.

Does your camera output to an external display?

Connect the camera’s output to an external display such as a monitor to verify the video signal. If you do
not receive a signal, try a new wire of the same type or double-check your camera’s settings.

If all of the above fail please contact Livestream Support by going to Livestream Studio settings and
navigating to the Support tab. You will find contact information and your Support PIN there.
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Incorrect Order of Inputs

Some producers using some Livestream Studio hardware products only (HD51/HD510/HD550)
have noticed their inputs not appearing in the multiview in the proper order. Livestream Studio
includes an input calibrator for these specific units that can resolve this issue.

In Livestream Studio, click on the gearwheel to open settings, then click Inputs. A link to the Livestream
Inputs Calibrator will be at the bottom of the window.

Settings: Inputs cancer [JERVER

Inputs

Note:
If your HDMI [ SDI inputs are not in the correct order, you can
configure them in the Livestream Inputs Calibrator,

Customers using the HD31 will need to open the tool manually by opening the File Explorer
and navigating to Program Files (x86) -- > Livestream Studio Launcher -—>
LSDeviceOrderCalibration. This tool is not compatible with other computers running
Livestream Studio software.

A window will pop up prompting that Livestream Studio will close. Click OK.
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A Livestream Studio Will Close

CANCEL

When Livestream Studio closes, a new window will pop up that will prompt you to unplug all of your
cameras from all of your Blackmagic Design devices. After you do this, click Start Calibrating.

Welcome to Livestream Inputs Calibrator!

Select your preferred input type, either HDMI or SDI. You will only need one camera for this process, so
if you are alternating input types, choose whichever one you are using more of. The calibration will still
work. Then click Next.

Select prefered input type and dick "Next"

If you haven't disconnected all of your cables yet, do so now. Then click Done.
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Lrsesiream Inputs Cahbrator

Disconnect all input cables, then dick "Done”.

Connect a camera to In 1 on your system. The calibrator will indicate when it has detected it and
completed calibrating it.

Lrvesiream Inputs Cahbrator

Connect a cable to Input #1

©

)

693



Connect a cable to Input #1

The calibrator will automatically prompt you to move to the next input. Unplug your camera from In 1
and plug it into In 2. Repeat this for all five Blackmagic Design cards.

Connect a cable to Input #2

©
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Lvestream Inputs Cahbrator X

Connect a cable to Input #2

vestream Inputs Cahbrator M

Connect a cable to Input #3

O

0

After you've gone through all inputs, the calibrator will inform you that calibration is complete. Click Save
and Livestream Studio will reopen with your inputs in the proper order.
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Please note that calibration is project-based. If you create a new project, you may need to calibrate your
input sources again.
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Livestream Studio Not Fitting Within Screen

When using Livestream Studio, it's ideal for your display resolution to be set to 1920x1080.
Otherwise, you may not be able to see the full software interface on your screen. If your display

does not support a resolution this high, there are workarounds detailed below.

If you are using Windows:

1. Launch Livestream Studio
2. Press ALT+Spacebar on your keyboard
3. Select Maximize on the menu that pops up

= Minimize

I o Maximize

Close

Customers using Studio on Mac can fix this by going to System Preferences > Displays. Under

Resolution, select Scaled.

Built-in Mac displays can be scaled based on appearance; select an option closer to More Space.

Secondary displays will allow you to choose a numerical resolution.
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& 4 i Built-in Retina Display 91

LB Arrangement  Color  Night Shift
Resolution: Default for display
© scaled
® e0d (enwe
Hara's Here's g ;‘:u:’acl:zlile
traublers PR g
Larger Text Default More Space

Using a scaled resolution may affect performance.

Brightness:

Automatically adjust brightness

AirPlay Display: = Off ]

Show mirroring options in the menu bar when available Gather Windows ?

Alternatively, you could also click the green fullscreen button in the upper left corner of the Studio
window.

livestream STREAM RECORD <

& PREVIEW
-

Livestream Studio should now fill out your display without any parts of the interface being cut off.
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Can't Access Studio From Login Window

Some customers who access Livestream Studio via a subscription (rather than a USB dongle or hardware
unit) have encountered a constant spinning wheel and cannot get past the first login window to access
the software interface.

What's ncluded

If you experience this, there are a few steps to take that can resolve this:

» Check that Windows is fully up to date. Some customers have resolved this issue by simply running
Windows updates.
» Clear your Internet Explorer SSL state. We have specifically seen clearing browser cache in Internet
Explorer help resolve this issue.
1. To access the Delete Browsing History dialog:
» |f you are using Internet Explorer 8, on the Tools menu, click Internet Options.
» If you are using Internet Explorer 9 or 10, click the gearwheel icon, and then click Internet
Options.

2. Click the Content tab.
3. Click Clear SSL state, and then click OK.

» Clearing your cache in Internet Explorer as instructed on this webpage has helped with this issue in
the past as well.

We have only encountered this behavior on Windows machines. If you experience this issue
while using Studio on macOS, please contact us to investigate.
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My Studio PIN Is Invalid. What Do | Do?

Your Studio PIN allows you to speak with our Customer Care team via phone seven days a week, 9:30
AM-8:30 PM EST. Studio PINs are valid for one (1) year from the date of purchase of the Studio software

or hardware unit.

If you believe that your Studio support PIN has expired less than a year after your hardware or dongle
purchase, contact us with your product's serial number and attach a receipt or invoice from your

purchase for our team to investigate.
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Studio Takes Longer than One Minute to
Launch

If you notice that launching Livestream Studio suddenly goes from taking about 20 seconds to
launch to over a minute, or the settings menu takes a long time to open, it may be due to a
Windows feature called Fault Tolerant Heap (FTH).

In summary, FTH monitors for software crashes and attempts to mitigate future crashes. Microsoft
provides a detailed explanation of FTH, including how to check what applications (e.g. Studio) are FTH
enabled.

If you have experienced Studio crashing in the past, this feature may be active and causing slowness
when launching Studio or opening the Settings menu. Our testing has shown that clearing the FTH
cache can resolve this.

@ norderto do this, you must be using Windows as an Administrator and Studio must be
closed.

Open Terminal as an administrator. Run the following command from an elevated command prompt:

Rundl132.exe fthsvc.dll,FthSysprepSpecialize

A Running this command will clear all FTH applications, so applications that are currently
functioning properly may begin to crash again after running this command.

After the command runs, restart Windows to apply the setting. After restarting, Studio should launch
within the normal timeframe (20 seconds to one minute).
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Studio Recording Does Not Play Back

If you used Livestream Studio to record and the AVI file does not play back in other software, Studio
may be able to recover the file via the built-in transcoder in the Media bin.

To repair your AVI file, navigate to either Media tab in Livestream Studio and import your AVI file. If the file

transcodes and plays back in the Media bin, then Studio was able to recover it. After doing so, export the
file to your hard drive.

We have seen this method work in cases where Studio crashed during the recording and the AVI file left
over was corrupt and unplayable.
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"Recorder Error” in Livestream Studio

If you attempt to start an H.264 ISO recording a see a "Recorder Error® message (shown below), it's
typically related to Studio’s project format and how your system'’s hardware encodes video.

Studio has the ability to create an H.264 1SO recording if your PC or Mac includes hardware encoding.
However, if your system includes hardware encoding only via NVIDIA NVENC, then you will not be able

to record if you are using an interlaced format (e.g. formats that include "i" such as 1080i59.94, 1080i60,
etc.) as this is a limitation of NVIDIA's encoding capabilities. Only systems that include hardware
encoding via Intel Quick Sync would support these formats.

As a workaround, go to Settings: Project Format and select a progressive project format (e.g. formats
that include "p" such as 1080p30, 720p30). Another alternative is to go to Settings: Recording and switch
the Default File Format to MJPEG, but this would create a larger, uncompressed file.
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Remote Cameras and Direct Inputs out of
Sync

It's common for hard-wired cameras and remote cameras to not be exactly synced up. This is due
to the nature of their individual workflows; wireless signals generally travel slower than directly

connected signals.

To resolve this, Studio has a simple setting to sync all your camera sources together.

Click the gearwheel in the upper right corner of Studio, then click the Advanced tab.
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CANCEL SAVE

Navigate to the Remote Inputs Synchronization setting and select Delay All Inputs by 1 Second and
Synchronize. This will allow your wired inputs to compensate for the latency experienced by wireless
sources (in this case, Mevo) and sync them together.

Remote Inputs Dizable Synchronization

Synchronization
Delay All Inputs by 1 Second and

Synchronize

Delay Remote Camera Inputs
by 1 Second and Synchronize

If you are only using remote camera sources, then select Delay Remote Camera Inputs by 1 Second and
Synchronize.
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Be sure to save your settings.
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Unable to Log In to Google Sheets

If you are unable to log in to Google via the GFX module and need to use a Google Spreadsheet
with your graphics overlays, we have a workaround option detailed below.

In your Google Spreadsheet, navigate to File > Publish to the web.

. some info |
& File Edit View Insert Format Data Toc

P Share_. % 0_ .00 12:
MNew - ¢
1 co
- Open Ctrl+0
2 ye
3 na Import_..
4 las Make a copy.
5 fur
8 Download as -

Email as attachment. .

B Version history -

b Rename.

1

= I Moveto... [
12 B Move to trash

14

15 Publish to the web

18

=

e Document details...

Spreadsheet settings

Print Ctri+P

N
[

Copy the URL of your sheet. In Studio, add a Google Spreadsheet and select Enter a public Google
spreadsheet. Paste your sheet's URL in the field below. Your data will then populate on the right side.
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Send Studio Logs to Livestream

If you continually experience issues streaming with Livestream Studio, the best way to troubleshoot
with our customer care team is to report a problem and send logs via Studio.

If you are accessing Studio on a hardware unit (HD31, HD51, HD550, etc.) or via a red USB dongle, then
navigate to Settings: Support and select Report Problem.

Settings: Support canceL  [FSRVEN

Project Format

Inputs

Outputs

Audio In
HELP CENTER
Recording
REPORT PROBLEM
Media Player
OPEN USER MANUAL

Streaming

VISIT LIVESTREAM.COM
Web Control
RTMP Server

Dropbox

Multi-Screen

If you are accessing Studio via your Livestream account login, go to Settings: My Account and select

Report Problem.
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Settings: My Account CANCEL

Proje: nat
Andrea Deluca

Inputs
Outputs

Enterprise UPDATE PLAN OPEN PROFILE

Audio In

Streaming
HELP CENTER
REPORT PROBLEM

RTMP

OPEN USER MANUAL
Dropbox

VISIT LIVESTREAM.COM
Multi- n
Ad Insertion
Ho

Mouse | Touch

Studio Surface

My Account

About

Fill in the required information and make sure Include logs and debug information is checked. Then click
Send. Our team will respond as soon as possible.
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Settings: Support

Inputs

Report Problem

Your support PN

E-mail address

Description of problem

CANCEL

CANCEL
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How to Use the Studio USB Recovery Drive

Included with all Livestream Studio hardware units are USB recovery drives, which you can use
whenever there is a Windows system failure or any situation in which you would like to restore your
system to Windows default settings. The full process takes about 20 minutes.

@ Please read and fully understand all of the instructions before starting the process. If you have
any questions or concerns, please contact customer care.

Before beginning this process, make sure you have your Windows License number available to you. It is
included in the 'Studio Bits and Bops' box that is shipped with your Studio hardware unit.

1. Back up any files you wish to preserve. This process is destructive and will return the system to factory

settings and result in the loss of all user files.
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2. Insert your USB Restore Drive into any of your Studio unit's USB ports.

3. Power the system on using the power button.

4. Once the Livestream logo appears for the first time, tap the "F8" key repeatedly to enter the Boot
Menu.

5. In the Boot Menu, select 'KingstonDataTraveler 3.0PMAP." then hit the Enter key.

Please select boot device:

T and | to move selection
ENTER to select boot device

P1-+ Samsung SSD 850 EVO 2TB (1907729MB)

2 NPMAP, Partition 1 (29605ME)

UEFI: Kingstonataiiay=:
Enter 5etup
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6. You will be presented with the main menu following a few seconds of load time. Your Studio unit's

Livestream restoration option will be selected. Hit the Enter key.

7.In the 'Choose language’ screen, press the 'Enter’ key to select the default option of English.

1 Choose language |
Wwhich language do you prefer:

ca_ES.UTF-8 Catalan | Catala
TF - ytsch

hu_HU.UTF-8 Hungarian | Maguyar

es_ES.UTF-8 sSpanish | Espanol

fr_FR.UTF-8 French | Francals

it _IT.UTF-8 Italian | Italiano

Ja_JF.UTF-8 Japanese | .13

pt_BR.UTF-8 Brazlilian Portuguese | Portugués do Brasil

ru_RU.UTF-8 Russian | PyccEwA

sk_SK.UTF-8 Slovak | Slovenskg

tr_TR.UTF-8 Turkish | Tirkce

zh_CN.UTF-8 Chinese (Simplified) | i'ijj}_[.hch

zh_TH.UTF-8 Chinese (Traditional) | -
S0k %

8. At the 'Configuring console-data’ screen, press the 'Enter’ key to select the default option of Don't
touch keymap.
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9. Wait for the system to complete its image verification. This process will take about 10 minutes. ETA
and the progress bar will be visible on the screen to indicate the process.

10. Once completed, you will be presented with the following screen. Type 'y, then press the 'Enter’ key.

A NOTE: If you have not backed up any files you wish to keep, press “CTRL+C" to exit and
secure your files. Progressing past step 10 will result in data loss.
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11. Confirm your selection by typing 'y key again and pressing the “Enter” key (NOTE: Data loss will occur
immediately once the 'Enter’ key is pressed).

12. Wait for the imaging process to complete. This should take roughly the same amount as time as the
process in Step 9.
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Partclone
Partclone v0.2.87 http://partclone.org
Starting to restore image (-) to device (/dev/sda2)
Calculating bitmap... Please wait... donel

Flle system: NTFS

Device size: 999.8 GB 2494100351 Blocks

Space in use: 235.0 GB 8537102 Blocks

Free Space: 964.9 GB 235563249 Blocks
Block size: 4096 Byte

ilii iiik Pr‘il:isi:

Elapsed: m:nﬂ:m!ﬂemlninl: ﬂmm:z‘fl Rate: 3.30GB/min
Current Block: 10 H 4100351

1.26%

0.04%

13. The machine will reboot on its own. Your system should be restored to its factory configuration. You

can now remove the USB drive from the USB port.
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Studio Software Crashes From Launch

If you attempt to launch Livestream Studio and it crashes before the opening splash screen finishes
loading, you may be missing important Windows components.

Please check the following:
- Ensure that Windows is fully-updated.
- Check that Livestream Studio has been installed under the Administrator account on your computer.

- Make sure you have installed Visual C++ 2013 Redistributable Package x64 on your computer.

Windows 10 Users

If you experience this behavior, it may be due to having Windows 10 N or Windows 10 KN editions
installed. These versions do not come with the Windows Media Feature Pack, which is required in order
for Livestream Studio to run. You can download the pack from Microsoft's website here.

€@ We have only encountered this behavior on Windows machines. If you experience this while
using Studio on macQOS, please contact us to investigate.
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Network Resource Unavailable When
Installing Studio

There is a known issue when attempting to install Livestream Studio on your Windows PC after
rolling back your Windows version. Below outlines what the issue looks like and how to resolve it.

We have specifically seen this behavior when customers have rolled back from Windows 10 version 1709
to Windows 10 version 1703, but it possible with other Windows rollbacks as well.

After rolling back Windows, if you attempt to install Livestream Studio on your PC again, you may see a
message indicating that a network resource is unavailable.

Installing Livestream Studio ‘l
== Livestream Studio X
= 2 The feature you are trying to use is on a network
SB=  resource thatis unavailable.
Cancel

' . .

Click OK to ry again. or enter an altemate path to a folder

containing the installation package 'LivestreamStudio.msi'

in the box below.

Use source:
AF Ci\Users\Livestream\AppData\RoaminglLivestreamil ~ Browse...

Advanced Installer

What happened is that Windows damaged some of Studio’s data in the registry during the rollback.
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To fix this, run the installer of the version of Studio you were running prior to the Windows rollback; if
you are seeing this error, it was likely not the most recent version. You can find downloads to all of our
previous installers in the Version History article.

Since technically this version of Studio already exists on your PC, the installation wizard will prompt you
with options to Remove or Repair it; select Remove. This will fix the registry damage and thus allow you
to install any version of Livestream Studio.
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What is Livestream Studio’'s Warranty?

Our full Livestream Studio warranty is available here. We recommend you review the terms in full.

Some major points include:

« Livestream Studio hardware products have a one (1) year warranty.

» If the Studio dongle is lost or stolen, it is the responsibility of the customer to report the loss to
Livestream; Livestream may charge a replacement fee.

« You have thirty (30) days to return an item from the date of purchase if you purchased directly from
the Livestream Store.

» Livestream products purchased through other retailers must be returned in accordance with their
respective returns and refunds policy.
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Uninstall Blackmagic Design Desktop Video
Drivers

If you need to update your Blackmagic Design Desktop Video drivers, you must first uninstall the
version that is currently installed on your computer before installing the current recommended

version.

Uninstalling drivers on Windows computers differs slightly from doing so on Mac computers.

Instructions for both are outlined below.

Uninstall Blackmagic Design Drivers - Windows

Go to your system’s Control Panel, then enter the Uninstall a program menu.

==
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Contral Panel

T+ B » ControlPanel »

Adjust your computer’s settings

System and Security
Review your computer's status

Save backup copies of your files with File
History
Find and fix problems

Network and Internet
Wiew network status and tasks

@ ¢ § &

- oI

|':-.-.‘.|- h Control Pane

v &

View by: Category =

User Accounts and Family Safety
#y Change account type
ﬂ' Set up Familly Safety for any user

Appearance and Personalization
Change the theme

Change desktop background

Adjust screen resclution

- Choose homegroup and sharing options )
' Clock, Language, and Region
. I-_!ardw._are and _Scrund Add a language
Gﬂ‘ View devices and printers Change input methads
Add a device Change date, time, or number formats
"‘-—-—_{ Programs Ease of Access
h !LP Uninstall a program | Let Windows suggest settings

Optimize visual display
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Find Blackmagic Design Desktop Video in the menu. Right-click it, then click Uninstall.

Uninstall or change a program

Teo uninstall a program, select it from the list and then click Uninstall, Change, or Repair.

Organize *  Uninstall = - W
Mame : Publisher Installed
O ActivePresenter Atorni Systems, Inc, 10/21/20
IEBIackmagic Design Desktop Vi--- Elackmagic Design 10/9/201
« Bonjour D Apple Inc. 7/9/2015
€ Google Chrome Google Inc. 10/14/20

Follow the on-screen prompts, which will notify you that you must restart your computer for the

uninstall to take effect.

Blackmagic Design Desktop Video

ﬂ You must reboot your computer for your changes to
Deskiop Video to take effect. It is essential that you
reboot BEFORE installing any other version of Desktop
Video software.

After you restart your computer, the uninstallation will be complete.

Uninstall Blackmagic Drivers - Mac

Find the DesktopVideo_.dmg file in your Finder. These are typically saved in your Downloads folder.
Open the .dmg file and double-click Uninstall Desktop Video.
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| @ e Desktop Video Installer

Desktop Video Installer
10.2.2
Test Clips Product Manuals

)

Uninstall Desktop Video

You will need to confirm that you want to uninstall Blackmagic Design drivers. Click Yes.

Uninstall Elackmagic Design drivers?

This utility will remove Blackmagic Design drivers from
your computer. Do you wish to continue?

No  Yes

Uninstallation is now complete.
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Uninstalling Livestream Studio

To uninstall Livestream Studio, first make sure that Studio is not running, regardless of which operating
system you are using.

Uninstall Studio from Windows

Go to Settings (Start menu > gearwheel) and select the Apps menu.

€ [fyou are running an older version of Windows (i.e. Windows /), go to Control Panel and
select Uninstall a Program.
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Settings

Windows Settings

Fand & setling
Devices Phone
erfica Blustooth, printers, mouse Link your Android, iPhone
Metwork & Internet Personalization Apps
Wi-Fi, sirplare mode, VPN Bachground, fock soreen, todors Uninstall, defsults, cptions
features
Accounts Time & Language Gaming
s aceeurs, amad, syne Soeach, region, dase Game bar, ¢
work, family broadcast b
Ease of Acoess Cortana Privacy
Marraitor, magnifie: Cortans language, pemissions, Location, came:
carrait aboni

Find and select Livestream Studio, then select Uninstall.
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Apps & features
Bl LogMeln, Inc. Tmy2017
!ﬂ Livestream Control Surface Driver 3.16 MB
myf20m7
Livestream Flugin for NewTek 46.5 MB
117/2017
l Livestream Procaster 1.5 MEB
8827
Livestream Producer 60.2 MB
614/2017
Livestream Studio 272 MB
3/25/2019

52n

Follow the on-screen prompts to run the uninstaller. Once Studio is uninstalled, you can download the

desired version from this page.

Uninstall from MacOS

To uninstall Studio from a Mac system, simply find Livestream Studio in your Applications folder and click

and drag it to the Trash. Alternatively, right-click Livestream Studio in your Applications folder and select

Move to Trash.
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Trash

vestream Studio

Once Livestream Studio is in the Trash, right-click the Trash icon and click Empty Trash.

Open

-,

w

Livestream Studio is now uninstalled.
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Uninstalling Livestream Studio Beta

To uninstall a Beta version of Livestream Studio, first make sure that Studio Beta is not running, regardless

of which operating system you are using.

Uninstall Studio from Windows

Go to the Settings menu in Windows (Start > gearwheel), and select the Apps menu.

€ [fyou are using an older version of Windows (i.e. Windows /), go to Control Panel > Uninstall

a Program.
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Find and select Livestream Studio Beta, then select Uninstall. Make sure you selected the Beta and not
the main "Livestream Studio” program.
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Apps & features
B LoghMein, Inc. T
li] Livestream Control Surface Driver 316 MB
1172017
A Livestream Plugin for NewTek 465 MB
LEE 172007
! Livestream Procaster 6.5 MB
882017
] Livestream Producer 60.2 MB
1335 B/14/2017
Livestream Studio 272 MB
3/25/2019
Livestream Studio Beta 311 MB
2112019

5.3.77

= Livestream Studio Remote Camera 347 MB
12/30/2016

Follow the on-screen prompts to run the uninstaller. Once Studio Beta is uninstalled, you can download

the desired version from this page.

Uninstall from MacOS

To uninstall Studio Beta from a Mac system, open the Finder and locate Livestream Studio Beta in your
Applications folder and click and drag it to the Trash. Alternatively, right-click Livestream Studio Beta in
your Applications folder and select Move to Trash. Make sure you selected the Beta and not the main

"Livestream Studio” application.

e+
7 Livestream Studio I
| M Livestream Studio Beta
BN Livestream...ote Camera

Open

B Mail Show Package Contents
55 Maps Move to Trash
© Messages

E Mission Control
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Once Livestream Studio Beta is in the Trash, right-click the Trash icon and click Empty Trash.

Open

Empty Trash

",

Livestream Studio Beta is now uninstalled. You can download the desired version from this page.
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